
Quantity One®

User Guide for Version 4.6.3
Windows and Macintosh
P/N 10002940 Rev C



Quantity One User Guide
Bio-Rad Technical Service Department

Phone: (800) 424-6723 
(510) 741-2612

Fax: (510) 741-5802

E-mail: LSG.TechServ.US@Bio-Rad.com 

Notice: 
No part of this publication may be reproduced or transmitted in any form or by any 
means, electronic or mechanical, including photocopy, recording, or any information 
storage or retrieval system, without permission in writing from Bio-Rad.

Quantity One is a registered trademark of Bio-Rad Laboratories. The Discovery 
Series is a trademark of Bio-Rad Laboratories. All other trademarks and registered 
trademarks are of their respective companies. 

WASTE text engine © 1993–1997 Marco Piovanelli

Limitations of Liability: 
Bio-Rad is not responsible for the misinterpretation of results obtained by following 
the instructions in this guide. Whenever possible, you should contact the Technical 
Services Department at Bio-Rad to discuss your results. As with all scientific studies, 
we recommend that you repeat your experiment at least once before making any 
significant conclusions for presentation or publication.

Copyright © 2006 by Bio-Rad Laboratories. All rights reserved.
ii



Table of Contents
1. Introduction ........................................................................  1-1
1.1.  Overview of Quantity One ..............................................................................  1-1

1.2.  Digital Data and Signal Intensity ....................................................................  1-2

1.3.  Gel Quality ......................................................................................................  1-3

1.4.  Quantity One Workflow .................................................................................  1-4

1.5.  Computer Requirements .................................................................................  1-5

1.6.  Installation ......................................................................................................  1-6

1.7.  Software License ............................................................................................  1-9

1.8.  Downloading from the Internet ....................................................................  1-13

1.9.  Quantity One Basic .......................................................................................  1-14

1.10.  Contacting Bio-Rad ....................................................................................  1-14

2. General Operation ..............................................................  2-1
2.1.  Menus and Toolbars .......................................................................................  2-1

2.2.  File Commands ...............................................................................................  2-6

2.3.  Imaging Device Acquisition Windows .........................................................  2-14

2.4.  Exit ................................................................................................................  2-15

2.5.  Preferences ....................................................................................................  2-15

2.6.  User Settings .................................................................................................  2-23

3. Viewing and Editing Images .............................................  3-1
3.1.  Magnifying and Positioning Tools .................................................................  3-1

3.2.  Density Tools ..................................................................................................  3-5

3.3.  Showing and Hiding Overlays ........................................................................  3-6

3.4.  Multi-Channel Viewer ....................................................................................  3-7

3.5.  3D Viewer .....................................................................................................  3-10

3.6.  Image Stack Tool ..........................................................................................  3-13
iii



Quantity One User Guide
3.7.  Colors ............................................................................................................  3-14

3.8.  Transform ......................................................................................................  3-17

3.9.  Resizing and Reorienting Images .................................................................  3-23

3.10.  Whole-Image Background Subtraction .......................................................  3-29

3.11.  Filtering Images ..........................................................................................  3-33

3.12.  Invert Data ...................................................................................................  3-39

3.13.  Text Overlays ..............................................................................................  3-39

3.14.  Erasing All Analysis from an Image ...........................................................  3-42

3.15.  Sort and Recalculate ....................................................................................  3-42

3.16.  Automation Manager ..................................................................................  3-42

4. Lanes ..................................................................................  4-1
4.1.  Defining Lanes ................................................................................................  4-1

4.2.  Lane-Based Background Subtraction ..............................................................  4-9

4.3.  Compare Lanes .............................................................................................  4-13

4.4.  Lane-based Arrays ........................................................................................  4-16

5. Bands ..................................................................................  5-1
5.1.  How Bands Are Identified and Quantified .....................................................  5-2

5.2.  Band Detection ................................................................................................  5-3

5.3.  Identifying and Editing Individual Bands .....................................................  5-10

5.4.  Plotting Traces of Bands ...............................................................................  5-12

5.5.  Band Attributes .............................................................................................  5-13

5.6.  Band Information ..........................................................................................  5-16

5.7.  Gauss-Modeling Bands .................................................................................  5-18

5.8.  Irregularly Shaped Bands in Lanes ...............................................................  5-21

6. Standards and Band Matching .........................................  6-1
6.1.  Standards .........................................................................................................  6-1

6.2.  Band Matching ..............................................................................................  6-13

6.3.  Quantity Standards ........................................................................................  6-24
iv



Contents
7. Volume Tools .....................................................................  7-1
7.1.  Creating a Volume ..........................................................................................  7-1

7.2.  Volume Labels ................................................................................................  7-5

7.3.  Volume Features .............................................................................................  7-7

7.4.  Moving, Copying, and Deleting Volumes ......................................................  7-8

7.5.  Volume Standards ...........................................................................................  7-8

7.6.  Volume Background Subtraction .................................................................  7-10

7.7.  Volume Arrays ..............................................................................................  7-12

8. Colony Counting ................................................................  8-1
8.1.  Defining the Counting Region ........................................................................  8-2

8.2.  Counting the Colonies ....................................................................................  8-3

8.3.  Displaying the Results ....................................................................................  8-4

8.4.  Making and Erasing Individual Colonies .......................................................  8-5

8.5.  Using the Histogram to Distinguish Colonies ................................................  8-6

8.6.  Ignoring a Region of the Dish ........................................................................  8-8

8.7.  Saving/Resetting the Count ............................................................................  8-9

8.8.  Saving to a Spreadsheet ................................................................................  8-10

9 ReadyAgarose™ 96 Plus ...................................................  9-1
9.1.  ReadyAgarose Wizard ....................................................................................  9-1

10. EXQuest Spot Cutter .......................................................  10-1
10.1.  Calibration and setup ..................................................................................  10-2

10.2.  Manual Excision .........................................................................................  10-6

10.3.  Lane/Volume Excision .............................................................................  10-18

11. Differential Display and VNTRs ......................................  11-1
11.1.  Differential Display ....................................................................................  11-1

11.2.  Variable Number Tandem Repeats .............................................................  11-3
v



Quantity One User Guide
12. Reports .............................................................................  12-1
12.1.  Report Window ...........................................................................................  12-1

12.2.  Lane and Match Reports .............................................................................  12-5

12.3.  Band Types Report ......................................................................................  12-6

12.4.  1-D Analysis Report ....................................................................................  12-8

12.5.  Similarity Comparison Reports ...................................................................  12-9

12.6.  Volume Analysis Report ...........................................................................  12-20

12.7.  Volume Regression Curve ........................................................................  12-23

12.8.  VNTR Report ............................................................................................  12-25

13. Printing and Exporting ....................................................  13-1
13.1.  Print Image ..................................................................................................  13-1

13.2.  Page Setup ...................................................................................................  13-1

13.3.  Print Settings ...............................................................................................  13-1

13.4.  Image Report ...............................................................................................  13-3

13.5.  Video Print ..................................................................................................  13-4

13.6.  Export to TIFF Image .................................................................................  13-5

13.7.  Exporting a JPEG Image .............................................................................  13-8

Appendix A.   
Gel Doc EQ ................................................................................  A-1

Appendix B.   
Gel Doc XR ................................................................................  B-1

Appendix C.   
ChemiDoc EQ ...........................................................................  C-1

Appendix D.   
ChemiDoc XRS .........................................................................  D-1
vi



Contents
Appendix E.   
GS-800 Imaging Densitometer ................................................  E-1

Appendix F.   
Personal Molecular Imager FX ................................................  F-1

Appendix G.   
Molecular Imager FX Family (FX Pro, FX Pro Plus and Molecular 
FX) .............................................................................................  G-1

Appendix H.   
PharosFX Family (PharosFX and PharosFX Plus) ................ H-1

Appendix I.   
VersaDoc ....................................................................................  I-1

Appendix J.   
Other Features ..........................................................................  J-1

Appendix K.   
21 CFR Part 11 .......................................................................... K-1
vii



Quantity One User Guide
viii



Preface

1. About This Document
This user guide is designed to be used as a reference in your everyday use of Quantity 
One® Software. It provides detailed information about the tools and commands of 
Quantity One for the Windows and Macintosh platforms. Any platform differences in 
procedures and commands are noted in the text.

This guide assumes that you have a working knowledge of your computer operating 
system and its conventions, including how to use a mouse and standard menus and 
commands, and how to open, save, and close files. For help with any of these 
techniques, see the documentation that came with your computer.

This guide uses certain text conventions to describe specific commands and 
functions.

Some of the illustrations of menus and dialog boxes found in this manual are taken 
from the Windows version of the software, and some are taken from the Macintosh 
version. Both versions of a menu or dialog box will be shown only when there is a 
significant difference between the two.

Example Indicates

File > Open Choosing the Open command under the File menu.

Dragging Positioning the cursor on an object and holding down 
the left mouse button while you move the mouse.

Ctrl+s Holding down the Control key while typing the letter s.

Right-click/ 
Left-click/ 
Double-click

Clicking the right mouse button/ 
Clicking the left mouse button/ 
Clicking the left mouse button twice.
ix
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2. Bio-Rad Listens
The staff at Bio-Rad are receptive to your suggestions. Many of the new features and 
enhancements in this version of Quantity One are a direct result of conversations with 
our customers. Please let us know what you would like to see in the next version of 
Quantity One by faxing, calling, or e-mailing our Technical Services staff. You can 
also use Solobug (installed with Quantity One) to make software feature requests.
x



1. Introduction

1.1 Overview of Quantity One
Quantity One is a powerful, flexible software package for imaging and analyzing 1-D 
electrophoresis gels, dot blots, arrays, and colonies.

The software is supported on Windows and Macintosh operating systems and has a 
graphical interface with standard pull-down menus, toolbars, and keyboard 
commands.

Quantity One can image and analyze a wide variety of biological data, including 
radioactive, chemiluminescent, fluorescent, and color-stained samples acquired from 
densitometers, phosphor imagers, fluorescent imagers, and gel documentation 
systems.

An image of a sample is captured using the controls in the imaging device window 
and displayed on your computer monitor. Image processing and analysis operations 
are performed using commands from the menus and toolbars.

Images can be magnified, annotated, rotated, and resized. They can be printed using 
standard and video printers.

All data in the image can be quickly and accurately quantitated using the Volume 
tools.

The lane-based functions can be used to determine molecular weights, isoelectric 
points, VNTRs, presence/absence and up/down regulation of bands, and other values. 
The software can measure total and average quantities, determine relative and actual 
amounts of protein, and count colonies in a Petri dish.

The software can cope with distortions in the shape of lanes and bands. Lanes can be 
adjusted along their lengths to compensate for any curvature or smiling of gels.

Image files can be shared among all The Discovery Series™ software. Images can 
also be easily converted into TIFF format for compatibility with other Macintosh and 
Windows applications.
1-1
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1.2 Digital Data and Signal Intensity
The Bio-Rad imaging devices supported by Quantity One are light and/or radiation 
detectors that convert signals from biological samples into digital data. Quantity One 
then displays the digital data on your computer screen, in the form of gray scale or 
color images.

A data object as displayed on the computer is composed of tiny individual screen 
pixels. Each pixel has an X and Y coordinate, and a value Z. The X and Y coordinates 
are the pixel’s horizontal and vertical positions on the image, and the Z value is the 
signal intensity of the pixel.

Fig. 1-1. Representation of the pixels in two digitally imaged bands in a gel.

For a data object to be visible and quantifiable, the intensity of its clustered pixels 
must be higher than the intensity of the pixels that make up the background of the 
image. The total intensity of a data object is the sum of the intensities of all the pixels 
that make up the object. The mean intensity of a data object is the total intensity 
divided by the number of pixels in the object.

The units of signal intensity are Optical Density (O.D.) in the case of the GS-700™ 
imaging densitometer, GS-710™ calibrated imaging densitometer, and GS-800™ 
calibrated densitometer, the Gel Doc EQ™ system, ChemiDoc EQ™ system, 
ChemiDoc XRS™ system with a white light source, or the Fluor-S™ MultiImager 
system, Fluor-S™ MAX MultiImager system, Fluor-S™ MAX2 MultiImager system 
and VersaDoc™ imaging systems with white light illumination. Signal intensity is 
expressed in counts when using the Personal Molecular Imager™ system or the 
Molecular Imager FX™ system, Molecular Imager FX Pro™ fluorescent imager, 

2-D View
3-D View

Signal intensity of a single pixel

In
te

ns
ity
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Molecular Imager FX Pro Plus™ multiimager system, or in the case of the Gel Doc 
EQ, ChemiDoc EQ, ChemiDoc XRS, Fluor-S, Fluor-S MAX, or VersaDoc when 
using the UV light source.

1.3 Gel Quality
Quantity One is very tolerant of an assortment of electrophoretic artifacts. Lanes do 
not have to be perfectly straight or parallel. Bands do not have to be perfectly 
resolved.

However, for accurate lane-based quantitation, bands should be reasonably flat and 
horizontal. Lane-based quantitation involves calculating the average intensity of 
pixels across the band width and integrating over the band height. For the automatic 
band finder to function optimally, bands should be well-resolved.

Dots that appear as halos, rings, or craters, or that are of unequal diameter, may be 
incorrectly quantified using the automatic functions.
1-3
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1.4 Quantity One Workflow
The following steps are involved in using Quantity One. 

Fig. 1-2. Quantity One workflow.

1.4.a Acquire Image

Before you can use Quantity One to analyze a biological image, you need to capture 
the image and save it as an image file. This may be done with one of the several Bio-
Rad imaging instruments supported by this software: the Molecular Imager FX and 
Personal Molecular Imager systems; the GS-800 Imaging Densitometer; the Gel Doc 
EQ, ChemiDoc EQ, and ChemiDoc XRS Gel documentation systems; and the 
VersaDoc.

The resulting images can be stored in files on a computer hard disk, network file 
server, or removable disks. 

1.4.b Optimize Image

Once you have acquired an image of your sample, you may need to reduce noise or 
background density in the image. Quantity One has a variety of functions to minimize 
image background while maintaining data integrity.

Acquire Image

Optimize Image

Lane and Band Analysis Volume Analysis Colony Counting

Report Results
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1.4.c Analyze Image

Once a “clean” image is available, you can use Quantity One to gather and analyze 
your biological data. In the case of 1-D gels, the software has tools for identifying 
lanes and defining, quantifying, and calculating the values of bands. Volume tools 
allow you to easily measure and compare the quantities of bands, spots, or arrays. The 
colony counting controls allow you to count the number of colonies in a Petri dish, as 
well as perform batch analysis.

Qualitative and quantitative data can be displayed in tabular and graphical formats.

1.4.d Report Results

When your analysis is complete, you can print your results in the form of simple 
images, images with overlays, reports, tables, and graphs. You can export your 
images and data to other applications for further analysis. 

1.5 Computer Requirements
This software is supported on Windows XP and Windows 2000, or on a Macintosh 
PowerPC running Mac OS 9.2.2 or Mac OS 10.2.6.

The computer memory requirements are mainly determined by the file size of the 
images you will scan and analyze. High-resolution image files can be very large. For 
this reason, we recommend that you archive images on a network file server or high-
capacity removable disk.

PC

The following is the recommended system configuration for installing and running 
on a PC:

Operating system: Windows 2000 
Windows XP

Processor: Pentium 333 MHz or faster 

RAM: ≥ 256 MB for all Bio-Rad imaging systems.
1-5
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Hard disk space: ≥ 3 GB 

Monitor: 17" monitor, 1024 x 768 resolution (required), True color.

USB port: Required for the Hardware Security Key (HSK). 

Printer: Optional.

Macintosh

The following is the recommended system configuration for installing and running 
on a Macintosh:

Operating system: MacOS 9.2, MacOS 10.2 and 10.3.

Processor/Model: PowerPC G3 processor or faster.

RAM: ≥ 256 MB for all Bio-Rad imaging systems.

Hard disk space: ≥ 3 GB

Monitor: 17" monitor, 1024 x 768 resolution (required), Millions of 
colors.

USB port: Required for the Hardware Security Key (HSK). 

Printer: Optional.

Note: The default amount of memory assigned to this program on the Macintosh is 128 
MB. If the total RAM in your Macintosh is 128 MB or less, you should reduce 
the amount of memory assigned to the program to 10 MB less than your total 
RAM. With the application icon selected, go to File > Get Info in your Finder to 
reduce the memory requirements for the application. See your Macintosh 
computer documentation for details.

1.6 Installation
Refer to the Installation Guide for detailed information regarding installation of The 
Discovery Series.
1-6
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1.6.a Hardware Security Key (HSK)

The Discovery Series software is password-protected using a Hardware Security Key 
(HSK), which is included in your software package. You must attach the Hardware 
Security Key to your computer before you can run the software.

Fig. 1-3. Hardware Security Key

Before proceeding with installation, plug the HSK into any available USB port on 
your computer. 

The code for the HSK is EYYCY, which is printed on the key itself. Use this code to 
identify the HSK that belongs to The Discovery Series software. 

Note: Initial installation of a network server requires the Hardware Security Key 
included in the software package. Installation of an additional Network Client 
User to a Network License Server System does not require an HSK. Please refer 
to the Network License Installation Guide that ships with Network License.

1.6.b Installing The Discovery Series for  Windows

Note: You must be a member of the Administrators group to install Discovery Series 
software. 

Insert The Discovery Series CD-ROM. The installation wizard will start 
automatically. (If the CD does not auto-start, click Start in your taskbar then click 
Run. In the Open field type d:\setup.exe where d is the letter of your CD-ROM drive.) 
Select the software application you want to install. On each panel, click Next when 
you are ready to proceed. You must accept the license agreement to continue with 
installation.
1-7
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The installer program guides you through the installation. The installer creates a 
default directory under Program Files on your computer called Bio-Rad\The 
Discovery Series (to select a different directory, click Browse). The application 
program will be placed in the Bin folder inside The Discovery Series folder. An 
additional folder for storing sample images is also located in The Discovery Series 
folder. User profiles will be created and stored in the Documents and Settings folder 
for each user.

The installer places a shortcut to the application and user guide on your desktop and 
creates a The Discovery Series folder in Programs on your Windows Start menu.

After installation, you must reboot your computer before using an imaging device.

Note: If you are installing in a Windows 2000 environment, you must start the 
application before allowing any other user access to the application.

Uninstalling The Discovery Series from Windows

If you need to uninstall The Discovery Series for any reason, go to Add/Remove 
Programs in the Control Panel. Highlight the application you want to remove and 
click Remove. 

Note: Uninstalling The Discovery Series software does not remove any system files in 
the Documents and Settings folder located in Application Data. If you want to 
remove these files as well, you must do so manually.

1.6.c Installing the Discovery Series on a Macintosh

The Mac install process involves installation of the application, dongle drivers, and 
Roper support. Insert the Discovery Series CD-ROM into your Macintosh. The TDS-
Mac folder opens on your desktop, displaying the installers for The Discovery Series 
applications. Double-click on the installer for your application.

Fig. 1-4. Installation program icon (Macintosh).
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Insert the Discovery Series CD-ROM. The TDS-Mac folder opens on your desktop, 
displaying the installers for The Discovery Series applications. Double-click the 
installer for your application. You must accept the license agreement to proceed with 
installation. The ReadMe contains important information about the HSK. Click 
Continue.

The installation wizard lists the types of installations in the pull down list. If you want 
to install the application and documentation only, select Easy Install from the list.

If you want to install drivers as well, select Custom from the pull down list. 
(Remember to also select the application in custom install.)

Note: If the computer is going to be used to acquire images from Gel Doc EQ, 
ChemiDoc EQ, ChemiDoc XRS, or the VersaDoc system, then select the driver 
for your particular imaging device now.

Install Location identifies where the application will be installed. If you want to 
specify a different location, click the pull-down button. 

Click Install to proceed. Once installation is complete, click Quit. To return to the 
installer, click Continue.

Uninstalling The Discovery Series from a Macintosh

Insert the Discovery Series CD-ROM. The TDS-Mac folder opens on your desktop, 
displaying the installers for The Discovery Series applications. Double-click the 
installer for your application. In the installer screen, select Uninstall from the pull 
down list.  

1.7 Software License
When the software opens for the first time, you will see a Software License screen that 
shows the current status of your software license.

With a new HSK or network license, you receive a 30-day temporary license (“Your 
license will expire on _______”). The temporary license is designed to give you time 
to purchase the software, if you have not already done so.
1-9



Quantity One User Guide
Fig. 1-5. Temporary license screen.

During the 30-day period, the Software License screen will appear every time you 
open the software. To use the software during this period, click on the Run button.

Network license holders can click on the Check License button at any time during the 
30-day period to activate their full network license. (If your network license is not 
activated when you click on Check License, notify your network administrator.)

HSK users have 30 days to purchase the software and obtain a purchase order number 
and software serial number from Bio-Rad. When you have this information, click on 
the Check License or Registration Form button in the Software License screen to 
register your software.
1-10
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Fig. 1-6. Software License Registration Form.

Fill out the information in the Software License Registration Form. Be sure to enter 
your purchase order number and software serial number under the Purchase 
Information tab when registering.

1.7.a Registering by Internet

If you have Internet access from your computer, click on the Submit via Internet 
button to send the Software Registration Form directly to Bio-Rad.

Your information will be submitted, and a temporary password will be generated 
automatically and sent back to your computer. Simply continue to run the application 
as before.

Bio-Rad will confirm your purchase information and generate a permanent license. 
After 2–3 days, click on Check License in the Software License screen again to 
update to a permanent password. (The Software License screen will not appear 
automatically after the temporary password has been generated; the software will 
1-11
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simply open normally. Go to the Help menu and select Register to open the Software 
License screen.)

1.7.b Registering by Fax or E-mail

If you do not have Internet access, click on the Print button in the Software License 
Registration Form and fax the form to Bio-Rad at the number listed on the form. 
Alternatively, you can enter the contents of the form into an e-mail and send it to Bio-
Rad at the address listed in the Registration Form.

Bio-Rad will contact you by fax or e-mail in 2–3 days with a full license.

1.7.c Entering a Password

If you fax or e-mail your registration information, you will receive a password from 
Bio-Rad. You must enter this password manually.

To enter your password, click on Enter Password in the Software License screen. If 
you are not currently in the Software License screen, select Register from the Help 
menu.

Fig. 1-7. Enter Password screen.

In the Enter Password screen, type in your password in the field.
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Once you have typed in the correct password, the OK light next to the password field 
will change to green and the Enter button will activate. Click on Enter to run the 
program.

1.8 Downloading from the Internet
You can download a trial version of the software from Bio-Rad’s Web site. Go to The 
Discovery Series download page at www.bio-rad.com/softwaredownloads and 
select from the list of applications. Follow the instructions to download the installer 
onto your computer, then run the installer.

After installation, double-click on the application icon to run the program. The 
software will open and the Software License screen will be displayed.

Note: If you attempt to start the downloaded program and receive an “Unable to obtain 
authorization” message, you will need a Hardware Security Key to run the 
program. Contact Bio-Rad to obtain a key.

Fig. 1-8. Free Trial screen.

In the Software License screen, click on the Free Trial button. This will open the 
Software License Registration Form. Enter the required information (you will not 
1-13
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have a purchase order number or software serial number, and can leave these fields 
blank) and click on Submit Via Internet.

A free trial password will be automatically downloaded to your computer. This 
password will allow you to use the software for 30 days.

If you decide to purchase the software during that period, contact Bio-Rad to receive 
a software package and a Hardware Security Key. You can then complete the 
registration process as described in the previous sections.

1.9 Quantity One Basic
Quantity One can be run in Basic mode. Quantity One Basic does not require a 
software license. The program can be installed and used simultaneously on unlimited 
numbers of computers. Quantity One Basic is a limited version of the flexible and 
powerful Quantity One.

The following functionality is active in Basic Mode: Image acquisition with Bio-Rad 
imaging devices, Transform, Crop, Flip, Rotate, Text Tool, Volume Rectangle Tool, 
Volume Circle Tool, Density Tools, ReadyAgarose 96 PLUS, Manual Excision, Print, 
Export to TIFF, and Save.

1.10 Contacting Bio-Rad
Bio-Rad technical service hours are from 8:00 a.m. to 4:00 p.m., Pacific Standard 
Time in the U.S.

Phone: 800-424-6723 
510-741-2612

Fax: 510-741-5802

E-mail: LSG.TechServ.US@Bio-Rad.com 

For software registration:

Phone: 800-424-6723 (in the U.S.)
1-14
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+1-510-741-6996 (outside the U.S.)
1-15



Quantity One User Guide
1-16



2. General Operation
This chapter describes the graphical interface of Quantity One, how to access the 
various commands, how to open and save images, how to set preferences, and how to 
perform other basic file commands.

2.1 Menus and Toolbars

2.1.a Menu Bar

Quantity One has a standard menu bar with pull-down menus that contain all the 
major features and functions available in the software.

• File—Opening and saving files, imaging device controls, printing, exporting.

• Edit—Preferences, other settings.

• View—Image magnification and viewing tools, tools for viewing image data.

• Image—Image transform, advanced crop, image processing and modification.

• Lane—Lane-finding tools.

• Band—Band-finding and band-modeling tools.

• Match—Tools for calculating molecular weights and other values from 
standards, tools for comparing lanes and bands in lanes.

• Volume—Band quantity and array data tools.

• Analysis—Colony counting, Differential Display, VNTR analysis.

• Excision—Cut lanes or bands, or individual spots using EXQuest Spot Cutter.

• Reports—Band and lane analysis reports, Phylogenetic Tree, Similarity Matrix.

• Window—Commands for arranging multiple image windows.

• Help—Quick Guides, on-line Help, software registration.

Below the menu bar is the main toolbar, containing some of the most commonly used 
commands. Next to the main toolbar are the status boxes, which provide information 
about cursor selection and toolbar buttons.
2-1
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2.1.b Main Toolbar

The main toolbar appears below the menu. It includes buttons for the main file 
commands (Open, Save, Print) and essential viewing tools (Zoom Box, Grab, etc.), 
as well as buttons that open the secondary toolbars and the most useful Quick Guides 
(Printing, Volumes, Molecular Weight, and Colony Counting).

Fig. 2-1. Main toolbar.

Tool Help

If you hold the cursor over a toolbar icon, the name of the command will pop up 
below the icon. This utility is called Tool Help. Tool Help appears on a time delay 
basis that can be specified in the Preferences dialog box (see section 2.5, 
Preferences). You can also specify how long the Tool Help will remain displayed.

2.1.c Status Boxes

There are two status boxes, which appear to the right of the main toolbar.

Fig. 2-2. Status boxes.

The first box displays any function that is assigned to the mouse. If you select a 
command such as Zoom Box, the name and icon of that command will appear in this 
status box and remain there until another mouse function is selected or the mouse is 
deassigned.

The second status box is designed to supplement Tool Help (see above). It provides 
additional information about the toolbar buttons. If you hold your cursor over a 

File commands Viewing commands Toolbars Quick Guides
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Chapter 2. General Information
button, a short explanation about that command will be displayed in this second status 
box.

2.1.d Secondary Toolbars

Secondary toolbars contain groups of related functions. You can open these toolbars 
from the main toolbar or from the View > Toolbars submenu.

The secondary toolbars can be toggled between vertical, horizontal, and expanded 
formats by clicking on the resize button on the toolbar itself.

Fig. 2-3. Secondary toolbar formats and features.

The expanded toolbar format shows the name of each of the commands. Click on the 
? icon next to the name to display on-line Help for that command.

Click on resize button

Hold cursor over icon

Click on question marks
for on-line help

to toggle format

Expanded format

to reveal the “tool tip”

Horizontal format Vertical format
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2.1.e Quick Guides

The Quick Guides are designed to guide you through the major applications of the 
software. They are listed under the Help menu; four of these are also available on the 
main toolbar.

Fig. 2-4. Quick Guides listed on Help menu and main toolbar.

The Quick Guides are similar in design to the secondary toolbars, but are application-
specific. Each Quick Guide contains all of the functions for a particular application, 
from opening the image to outputting data.
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Fig. 2-5. Example of a Quick Guide: Volumes

In their expanded format, the Quick Guide commands are numbered as well as 
named. The numbers provide a suggested order of operation; however, not every 
command is required for every application.

As with the secondary toolbars, you can click on the ? next to the name of a function 
to display the Help text.

2.1.f Right-Click Context Menu

With an image open, right-click anywhere on the image to display a context menu of 
common commands.

to indicate sequence for

Question marks
open on-line
Help

Key commands

Toggle format

creating volumes, and
outputting data

preparing the image,

Commands are numbered

Select Volumes
Quick Guide from

main toolbar
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Fig. 2-6. Selecting Zoom Box from the right-click context menu.

You can select commands from this menu as you would from a standard menu.

2.1.g Keyboard Commands

Many commands and functions can be performed using keyboard keys (e.g., press the 
F1 key for View Entire Image; press Ctrl+S for Save). Select Keyboard Layout 
from the Help menu to display a list of keys and key combinations and their 
associated commands.

The pull-down menus also list the shortcut keys for the menu commands.

2.2 File Commands
The basic file commands and functions are located on the File menu.
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Fig. 2-7. File menu.

2.2.a Opening Images

To open a saved image, select Open from the File menu or click on Open button on 
the main toolbar. This opens the standard Open dialog box for your operating system.
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Fig. 2-8. Open dialog box.

In the dialog box, open a file by double-clicking on the file name. To open multiple 
files, first select them using Ctrl-click or Shift-click key combinations, and then click 
on the Open button.

Note: Due to operating system limitations, it is possible to have image files open in two 
or more locations over a network simultaneously. To safeguard your image files 
keep them in a protected folder or on your local machine.

You can also open images from other The Discovery Series software (PDQuest, 
Diversity Database, DNACode).

Macintosh version:

Windows version:
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Note: It is possible to move image data between The Discovery Series software 
applications on different platforms (Windows and Macintosh). 

The application comes with a selection of sample images. In Windows, these are 
located in The Discovery Series/Sample Images/1D directory. On the Macintosh, they 
are stored in the Sample Images folder in the Quantity One folder.

Opening TIFF Images

The Open command can also be used to import TIFF images created using other 
software applications.

There are many types of TIFF formats that exist on the market. Not all are supported 
by The Discovery Series. There are two broad categories of TIFF files that are 
supported:

1. 8-bit Grayscale. Most scanners have an option between line art, full color, and 
grayscale formats. Select grayscale for use with The Discovery Series software. 
In a grayscale format, each pixel is assigned a value from 0 to 255, with each 
value corresponding to a particular shade of gray.

2. 16-bit Grayscale. Bio-Rad’s Molecular Imager FX and Personal Molecular 
Imager and Fluor-S, and VersaDoc imaging systems use 16-bit pixel values to 
describe intensity of scale. Molecular Dynamics™ and Fuji™ imagers also use 16-
bit pixel values. The Discovery Series understands these formats and can 
interpret images from both Bio-Rad and Molecular Dynamics storage phosphor 
systems.

Note: The program can import 8- and 16-bit TIFF images from both Macintosh and PC 
platforms.

TIFF files that are not supported include:

1. 1-bit Line Art. This format is generally used for scanning text for optical 
character recognition or line drawings. Each pixel in an image is read as either 
black or white. Because the software needs to read continuous gradations to 
perform gel analysis, this on-off pixel format is not used.

2. 24-bit Full Color or 256 Indexed Color. These formats are frequently used for 
retouching photographs and are currently unsupported in The Discovery Series, 
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although most scanners that are capable of producing 24-bit and indexed color 
images will be able to produce grayscale scans as well.

3. Compressed Files. The software does not read compressed TIFF images. Since 
most programs offer compression as a selectable option, files intended for 
compatibility with The Discovery Series should be formatted with the 
compression option turned off.

2.2.b Saving Images

To save a new image or an old image with changes, select Save from the File menu. 
In Windows, new images will be given a .1sc extension when they are first saved.

Save As can be used to save a new image, rename an old image, or save a copy of an 
image to a different directory. The standard Save As dialog box for your operating 
system will open.

To save all open images, select Save All from the File menu or click on the button on 
the main toolbar.

2.2.c Closing Images

To close an image, select Close from the File menu. To close all open images, select 
Close All. You will be prompted to save any changes before closing.

2.2.d Revert to Saved

To reload the last saved version of an image, select Revert to Saved from the File 
menu. Because any changes you made since last saving the file will be lost, you will 
be prompted to confirm the command.

2.2.e Image Info

Image Info on the File menu opens a dialog box containing general information 
about the selected image, including scan date, scan area, number of pixels in the 
image, data range, and the size of the file. Type any description or comments about 
the image in the Description field.
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Fig. 2-9. Image Info box.

History lists the changes made to the image including the date. If you have Security 
Mode active, the name of the user who made the change is also listed (See Section 
2.5, Preferences for information on Security Mode). 

To print the file info, click on the Print button in the dialog box.

Changing the Image Dimensions

You can change the dimensions of certain images using the Image Info dialog box. 
This feature is only available for images captured by a camera or imported TIFF 
images in which the dimensions are not already specified.
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For these types of images, the Image Info dialog box will include fields for changing 
the image dimensions.

Fig. 2-10. Image Info dialog box with fields for changing the image dimensions.

Enter the new image dimensions (in millimeters) in the appropriate fields. Note that 
the pixel size in the image (in micrometers) will change to retain the same number of 
pixels in the image.

2.2.f Reduce File Size

High-resolution image files can be very large, which can lead to problems with 
opening and saving. To reduce the file size of an image, you can reduce the image 
resolution by reducing the number of pixels in the image. (You can also trim 
unneeded parts of an image to reduce its memory size. See section 3.9.a, Cropping 
Images.)

Fields for changing
the image dimensions
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This function is comparable to scanning at a lower resolution, in that you are 
increasing the size of the pixels in the image, thereby reducing the total number of 
pixels and thus the file size.

Note: In most cases, reducing the resolution of an image will not affect quantitation. In 
general, as long as the pixel size remains less than 10 percent of the size of the 
objects in your image, changing the pixel size will not affect quantitation.

Select Reduce File Size from the File menu to open the Reduce File Size dialog box. 
The dialog box lists the size of the pixels in the image (Pixel Size: X by Y microns), 
the number of pixels in the image (Pixel Count: X by Y pixels), and the memory size 
of the image.

Fig. 2-11. Reduce File Size dialog box, before and after pixel size increase.

Lower the resolution by entering lower values in the Pixel Count fields or higher 
values in the Pixel Size fields (see the figure for an example).

Pixel size in the “x” dimension increased

Pixel Count and Memory Size reduced

Before:

After:
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Note: Since with most 1-D gels you are more concerned with resolving bands in the 
vertical direction than the horizontal direction, you may want to reduce the file 
size by making rectangular pixels. That is, keep the pixel size in the “y” 
dimension the same, while increasing the size in the “x” dimension.

When you are finished, click on the OK button. 

A pop-up box will give you the option of reducing the file size of the displayed image 
or making a copy of the image and then reducing the copy’s size.

Reducing the file size is an irreversible process. For that reason, we suggest that you 
first experiment with a copy of the image. Then, when you are satisfied with the 
reduced image, delete the original.

Fig. 2-12. Confirm Reduce File Size pop-up box.

2.3 Imaging Device Acquisition Windows
The File menu contains a list of Bio-Rad imaging devices supported by Quantity One. 
These are:

1. Gel Doc EQ

2. ChemiDoc EQ

3. ChemiDoc XRS

4. GS-800 Calibrated Densitometer
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5. VersaDoc

6. Personal Molecular Imager FX

7. Molecular Imager FX

8. PharosFX

To open the acquisition window for an imaging device, select the name of that device 
from the File menu. 

See the individual chapters on the imaging devices for more details.

2.4 Exit
To close Quantity One, select Exit from the File menu. You will be prompted to save 
your changes to any open files.

2.5 Preferences
You can customize basic features of Quantity One—such as menu options, display 
settings, and toolbars—using the Preferences dialog box. Select Preferences from the 
Edit menu to open this dialog.
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Fig. 2-13. Preferences dialog box.

Click on the appropriate tab to access groups of related preferences. After you have 
selected your preferences, click on OK to implement them.

2.5.a Misc.

Click on the Misc tab to access the following preferences.

Memory Allowance

To specify the amount of virtual memory allocated for the application at start-up, 
enter a value (in megabytes) in the Memory Allowance field. The default value of 
512 megabytes is recommended. If you receive a warning message that the amount of 
virtual memory is set too high, you can enter a smaller value in this field. However, 
this should be considered a temporary fix, and you should consider expanding your 
hard drive.

Enable DOS Filename Parsing

If this checkbox is selected, for 8-character file names ending in two digits, the final 
two digits are interpreted as version and exposure numbers. For example, the file 
name IMAGE-11.1sc would be parsed as IMAGE ver 1 xpo 1.1sc. This is designed to 
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enable backwards compatibility for users with DOS image files. You should only 
check this box if you are using these image files.

Enable UNIX Filename Parsing

This is similar to DOS file name parsing. Windows and Macintosh users are unlikely 
to run into difficulties with UNIX parsing; therefore, this setting is checked by 
default.

Maximize Application Window

In the Windows version, select the Maximize Application Window checkbox to 
automatically maximize the application window when Quantity One first opens. If 
this is unchecked, the menu and status bars will appear across the top of the screen 
and any toolbars will appear “floating” on the screen.

2.5.b Paths

Click on the Paths tab to access the following preference.

Temporary File Location

Temporary image files are normally stored in the TMP directory of your The 
Discovery Series folder. The full path is listed in the field. To change the location of 
your  temporary files, type in a new path or click Browse and select a new directory. 
To return to the default TMP directory, click Default.

2.5.c Display

Click on the Display tab to access the following preferences.

Zoom %

Zoom % determines the percentage by which an image zooms in or out when you use 
the Zoom In and Zoom Out functions. This percentage is based on the size of the 
image.
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Pan %

Pan % determines the percentage by which the image moves side to side or up and 
down when you use the arrow keys. This percentage is based on the size of the image.

Band Style

Bands in your gel image can be marked with brackets that define the top and bottom 
boundaries of the band, or they can be marked with a dash at the center of the band. 
Indicate your preference by clicking on the Brackets or Lines button. (This setting 
can be temporarily changed in the Band Attributes dialog box. However, all newly 
opened images will use the preferences setting.)

Auto “Imitate Zoom”

When this checkbox is selected,  the magnifying and image positioning commands 
used in one window will be applied to all open windows. This is useful, for example, 
if you want to compare the same band of group of bands in different gels; magnify the 
band(s) in one gel, and the same area will be magnified in all the other gel images.

Note that the images must be approximately the same size.

AutoScale Annotations

Select AutoScale Annotations if you want to display annotations in the image as a 
percentage of the image window not the image. This allows you to zoom in on an area 
of the image but have displayed annotations remain the same size in the image 
window. 

Disable hardware Acceleration for 3D Viewer

If you are having problems using the 3D Viewer, install the latest drivers for your 
graphics card. If, after updating your drivers, you are still having problems, select 
Disable hardware acceleration for 3D viewer. This allows Quantity One to emulate a 
graphics driver to render a 3D image.

Note: Disabling hardware acceleration reduces performance for the 3D Viewer.
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2.5.d Toolbar

Click on the Toolbar tab to access the following preferences, which determine the 
behavior and positioning of the secondary toolbars and Quick Guides.

Show Default Quick Guide at Startup

If this checkbox is selected, the Volumes Quick Guide will open automatically when 
you open the program. If you are in Basic mode, the Basic Quick Guide opens 
instead.

Align Quick Guide with Document

If this checkbox is selected, the Quick Guides will open flush with the edge of your 
documents. Otherwise, they will appear flush with the edge of the screen.

Guides Always on Top

If this checkbox is selected, Quick Guides will always appear on top of images and 
never be obscured by them.

Quick Guide Placement and Toolbar Placement

These checkboxes determine on which side of the screen the Quick Guides and 
toolbars will first open.

Placement Behavior

This setting determines whether a Quick Guide or toolbar will always pop up in the 
same place and format (Always Auto), or whether they will pop up in the last 
location they were moved to and the last format selected (Save Prior).

Toolbar Orientation

These option buttons specify whether toolbars will first appear in a vertical, 
horizontal, or expanded format when you open the program.
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Tool Help Delay and Persistence

Specify the amount of time the cursor must remain over a toolbar icon before the Tool 
Help appears by entering a value (in seconds) in the Tool Help Delay field.

Specify the amount of time that the Tool Help will remain on the screen after you 
move the cursor off a button by entering a value (in seconds) in the Tool Help 
Persistence field.

2.5.e Application

Click on the Application tab to access the following preferences.

Relative Quantity Calculation

The Relative Quantity Calculation option allows you to define how the relative 
quantities of defined bands in lanes will be determined for all reports, histograms, and 
band information functions: either as a percentage of the signal intensity of an entire 
lane or as a percentage of the signal intensity of the defined bands in a lane.

Selecting % of Lane means that the total intensity in the lane (including bands and 
the intensity between bands) will equal 100 percent and the intensity of a band in that 
lane will be reported as a fraction thereof.

Selecting % of Bands in Lane means that the sum of the intensity of the defined 
bands in a lane will equal 100 percent, and the intensity of an individual band will be 
reported as a fraction of that sum.

If you create, adjust, or remove bands in a lane with Relative Quantity defined as % 
of Bands in Lane, the relative quantities of the remaining bands will be updated.

Relative Front Calculation

The Relative Front Calculation option lets you select the method for calculating the 
relative positions of bands in lanes . This affects the calculation of both Relative Front 
and Normalized Rf values.

Relative front is calculated by either:
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1. Dividing the distance a band has traveled down a lane by the length of the lane 
(Follow Lane). This is useful if your gel image is curved or slanted.

2. Dividing the vertical distance a band has traveled from the top of a lane by the 
vertical distance from the top of the lane to the bottom (Vertical).

Note: “Lane” and “band” refer here to lanes and bands as defined by overlays on the 
gel image. For example, the top of a lane refers to the beginning of the lane line 
created in Quantity One, not necessarily the actual gel lane.

Note that if a lane is straight and vertical, both calculation methods will give the same 
result.

2.5.f Devices

This tab contains preferences for imaging devices and the EXQuest Spot Cutter.

Specify the imaging devices that you want to appear on the File menu. By default, all 
supported imaging devices are selected; clear the checkboxes of the imagers that you 
do not want to include on the File menu.

If you have connected the EXQuest Spot Cutter, select it under Spot Cutter. Click 
Setup spot cutter to run the spot cutter calibration wizard. 

Note: If you are changing the spot cutter settings, you need to restart the application 
before you can perform calibration. 

2.5.g Security

The Security tab of the Preferences dialog box contains the security options for CFR 
mode and the option for enabling Secure mode.

CFR Mode

Setting the Security preferences for CFR mode requires the user have administrator 
privileges. To locate the Security Preferences, select Preferences from the Edit menu 
and click the Security tab. 
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Fig. 2-14. Security Preferences

The following options are available on the Security tab of the Preferences dialog box:

Enable 21 CFR Part 11 mode - If this box is unchecked, all other options are inactive. 
To activate the other options and CFR mode check this box.

Program times out if inactive - When this box is checked, the user must enter their 
password to resume using Quantity One. The minutes field indicates the amount of 
time that must elapse before the application times out. 

Require login on startup - Check this box to require the user to enter the user’s 
password when the application opens. This password is the same password as the one 
used for logging on to Windows. This is an added security measure to prevent 
unauthorized users from starting Quantity One on a machine where they are not 
logged in.

Automatically create backup for new images - This option, when selected, creates a 
backup file when you save a newly acquired or imported image. Locate the backup 
file in the same folder as the original.

See Appendix K, 21 CFR Part 11, for further information.
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Secure Mode

Secure mode is not associated with CFR. However, you can enable Secure mode 
when CFR is enabled. Secure mode prevents any user from making changes to raw 
image data on the local machine. If a user opens any image on a machine where 
Secure mode is enabled, any commands that change the data, such as Subtract 
background, Filter Wizard, etc. as well as all analysis commands will be inactive 
(grayed out). 

To activate Secure mode, select Secure mode. Once checked, you will be prompted 
for a new Secure mode password which will be required for disabling Secure Mode.

Note: Secure mode only affects images opened on the local machine. Images stored on 
a network can still be opened and modified on other machines where Secure 
mode is disabled.

2.6 User Settings
If Quantity One is on a workstation with multiple users, each user can have his or her 
own set of preferences and settings.

In multiple-user situations, the preferences and settings are associated with individual 
user names. Under Windows, your user name is the name you use to log onto the 
computer. On a Macintosh, your user name is the Owner Name on the File Sharing 
control panel.

If you do not log onto your Windows PC or do not have a Owner Name on your 
Macintosh, then you do not have a user name and your preferences and settings will 
be saved in a generic file.
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3. Viewing and Editing 
Images

This chapter describes the viewing tools for magnifying and optimizing images. This 
chapter also describes the tools for cropping, flipping, and rotating images, reducing 
background intensity and filtering noise, and adding text overlays to images.

These tools are located on the View, Image, Window, and Edit menus.

Note: The following chapters contain instructions for analyzing X-ray films, wet and 
dry gels, blots, and photographs. For the sake of simplicity, these are all referred 
to as “gels.”

3.1 Magnifying and Positioning Tools
The magnifying and positioning tools are located on the View menu and Window 
menu; some of these functions are also found on the main toolbar.

These commands will only change how the image is displayed on the computer 
screen. They will not change the underlying data. 
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Fig. 3-1. Viewing functions on View menu and main toolbar.

Zoom Box

Use Zoom Box to select a small area of the image to magnify so that it fills the entire 
image window.

Click on the Zoom Box button on the main toolbar or select the command from the 
View menu. Then drag the cursor on the image to enclose the area you want to 
magnify, and release the mouse button. The area of the image you selected will be 
magnified to fill the entire window.
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Fig. 3-2. Zoom Box tool.

Zoom In/Zoom Out

These tools work like standard magnifying tools in other applications.

Click on the Zoom In or Zoom Out button on the main toolbar (or select from the 
View menu). The cursor will change to a magnifying glass. Click on an area of the 
image to zoom in or out a defined amount, determined by the setting in the 
Preferences dialog (see section  2.5, Preferences).

Grab

This tool allows you to change the position of the image in the image window. Select 
Grab from the main toolbar or View menu. The cursor will change to a “hand” 
symbol. Drag the cursor on the image to move the image in any direction.

Arrow Keys

You can also move the image inside the image window by using the Arrow keys on 
the keyboard. Click on an arrow button to shift the image incrementally within the 
window. The amount the image shifts is determined by the Pan % setting in the 
Preferences dialog (see section  2.5, Preferences).

1. Click on Zoom Box button.

2. Drag box on image. 3. Boxed region is magnified to fill window.
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View Entire Image

If you have magnified part of an image or moved part of an image out of view, select 
View Entire Image from the main toolbar or View menu to return to the original, full 
view of the image.

Centering an Image

You can center the image window on any point in an image quickly and easily using 
the F3 key command. This is useful if you are comparing the same region on two gel 
images and want to center both image windows on the same point.

Position the cursor on the point on the image that you want at the center of the image 
window, then press the F3 key. The image will shift so that point is at the center of the 
image window.

Imitate Zoom

To magnify the same area on multiple images at the same time, use the Imitate Zoom 
command on the Window menu.

First, adjust the magnification in one of the images. Then, with that image window 
still selected, select Imitate Zoom. The zoom factor and region of the selected image 
will be applied to all the images.

Note: Imitate Zoom only works on images with similar dimensions.

Tiling Windows

If you have more than one image open, the Tile commands on the Window menu 
allow you to arrange the images neatly on the screen.

Select Tile to resize all the windows and arrange them on the screen left to right and 
top to bottom.

Select Tile Vertical to resize all windows and arrange them side-by-side on the 
screen.

Select Tile Horizontal to resize all windows and stack them top-to-bottom on the 
screen
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3.2 Density Tools
The density tools on the View > Plot Density submenu and the Density Tools toolbar 
are designed to provide a quick measure of the data in a gel image.

Fig. 3-3. Density tools on the menu and toolbar.

Note: The density traces will be slightly different than the traces for functions such as 
Plot Lane or Plot Band, because the sampling width is only one image pixel.

Density at Cursor

Select Density at Cursor and click on a band or spot to display the intensity of that 
point on the image. It also shows the average intensity for a 3 x 3 pixel box centered 
on that point.

Density in Box

Select Density in Box and drag a box on the image to display the average and total 
intensity within the boxed region.

Plot Density Distribution

Select Plot Density Distribution to display a histogram of the signal intensity 
distribution for the part of the image displayed in the image window. The average 
intensity is marked in yellow on the histogram.

The histogram will appear along the right side of the image. Magnify the image to 
display the data for a smaller region.
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Plot Cross-section

Select Plot Cross-section and click or drag on the image to display an intensity trace 
of a cross-section of the gel at that point. The horizontal trace is displayed along the 
top of the image, and the vertical trace is displayed along the side of the image.

The intensity at the point you clicked on is displayed, as is the maximum intensity 
along the lines of the cross-section.

Fig. 3-4. Plot Cross-section tool.

Plot Vertical Trace

Select Plot Vertical Trace and click or drag on the image to plot an intensity trace of 
a vertical cross-section of the image centered on that point.

3.3 Showing and Hiding Overlays
To conceal all plots, traces, info boxes, and overlays on an image, select Hide 
Overlays from the main toolbar or View menu.

Click on button, then
click or drag on the image.
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Note: Click once on Hide Overlays to conceal the overlays. Click twice to deassign 
any function that has been assigned to the mouse.

To redisplay the lane and band overlays, select Show Lanes and Bands from the 
View menu or main toolbar.

3.4 Multi-Channel Viewer
The Multi-Channel Viewer can display different types and levels of fluorescence in a 
gel that has been imaged at different wavelengths. You can merge the data from up to 
three different images of the same gel.

Note: The gel images being compared must be exactly the same size. When changing 
image filters, be careful not to move the gel. If the images are not exactly the 
same size, you can use the Crop tool (see Section 3.9.a, Cropping Images) to 
resize them.

With at least one image open, select Multi-Channel Viewer from the View menu. 
The first open image will be displayed in the viewer window using the Red channel, 
and the image name will be displayed in the field at the top of the viewer.
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Fig. 3-5. Multi-Channel Viewer.

Note: The color channel used to display the image in the viewer has no relation to the 
filter used to capture the image. The red, green, and blue channels are only used 
to distinguish different images.

To add another image to the viewer, make sure the image is open and click on the 
pull-down button next to the Green or Blue name field. Select the image name from 
the pull-down list. Add a third image using the same procedure.
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Fig. 3-6. Selecting images to display in the viewer.

To reassign the different images to different channels, use the pull-down buttons to 
the right of the name fields. Select <clear> from the pull-down list to remove an 
image from that channel of the viewer.

Viewing Options

To remove a particular color channel from the display, click in the checkbox 
associated with that channel to deselect it.

Select the Auto-Scale Image When Assigned checkbox to automatically adjust the 
brightness and contrast of each loaded image based on the data range in the image. 
This invokes the Auto-scale command from the Transform dialog (see section 3.8, 
Transform) when an image is first opened in the viewer. Note that this setting affects 
only how the image is displayed in the viewer, not the actual data.

Note: If you deselect this checkbox, any images currently displayed will remain auto-
scaled. Click on the Transform button in the viewer and click on the Reset 
button in the Transform dialog to undo auto-scaling.

Buttons for various viewing tools are included in the Multi-Channel Viewer. Tools 
such as Zoom Box and Grab will change the display of all the images in the viewer at 
once.

Click on the Transform button to open the Transform dialog. In the dialog, you can 
adjust the display of each channel independently by selecting the appropriate channel 
option button. Similarly, the Plot Cross-section command will report the intensity of 
each channel separately.
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Exporting and Printing

Click on the Export button to export a 24-bit TIFF image of the merged view. This 
will open a version of the Export to TIFF dialog (see section 13.6, Export to TIFF 
Image). Note that you cannot export data from the Multi-Channel Viewer—only the 
current view of the image (designated as Publishing Mode in the Export dialog). The 
colors in the viewer will be preserved in the exported TIFF image.

To print a copy of the merged view to a color or grayscale printer, click on the Print 
button. 

3.5 3D Viewer
The 3D Viewer allows you to see a three-dimensional rendering of a portion of your 
image. This is important for such instances as determining whether a selected band is 
actually two or more separate bands.

To see a 3D rendering of a portion of your image, select 3D Viewer from the View 
menu. Your curser turns into a crosshair. Click and drag your curser over the image 
area you would like to view creating a box. 

Note: viewing a large area of your image may reduce performance. 

• To reposition the box, position your cursor at the center of the box. The cursor 
appearance will change to a multidirectional arrow symbol. You can then drag 
the box to a new position.

• To resize the box, position your cursor on a box corner. The cursor appearance 
will change to a bi-directional arrow. You can then drag that corner in or out, 
resizing the box.

• To redraw the box, position your cursor outside the box and click once. The box 
disappears, and you can then draw a new box.

To view the selected area, position your cursor inside the box slightly off-center. The 
cursor appearance will change to an arrow. Click once to open the 3D Viewer.

Note: If you are having problems using the 3D Viewer, install the latest drivers for your 
graphics card. If, after updating your drivers, you are still having problems,  go to 
the Display tab of the Preferences dialog box and select Disable hardware 
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acceleration for 3D viewer. This allows Quantity One  to emulate a graphics 
driver to render a 3D image. See Section 2.5.c, Display, for further information.

Fig. 3-7.  3D Viewer

3.5.a Positioning the Image

Windows

For Windows operating systems, use your mouse to reposition and rotate the image.
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• Rotate the image - Left click and drag to rotate the image.

• Reposition the image - Right click and drag to reposition the image. 

• Zoom in/out - To zoom in or out, Click the center mouse button or roll the wheel. 
If you do not have a three button mouse or a mouse with a wheel, hold down the 
shift key and left click and drag to zoom in or out. 

Macintosh

For Macintosh operating systems, use mouse and keyboard combinations to 
reposition and rotate the image.

• Rotate the image - Click and drag to rotate the image.

• Reposition the image - Ctrl>click and drag to reposition the image. 

• Zoom in/out - Shift>click and drag to zoom in or out.

3.5.b Display Mode

The 3D Viewer window allows you to view the image in three different modes; wire 
frame, lighting, and textured. 

• Wire-frame shows the image in a transparent frame view.

• Lighting shows the image with different areas of light and shadow depending on 
the angle of view.  Use the slider bar to adjust the intensity of the lighting.

• Texture gives the image texture.

Use the Scale function to scale the image. This is useful for viewing shallow spots in 
the 3D Viewer.

If you lose the image because you moved it too far past the window border, or rotated 
it and disoriented the view, click Reset View to return the image to the original view. 

Note: Reset view does not change the scale factor. To reset the scale factor, close the 
3D Viewer and click the box again to re-open the 3D Viewer with the original 
scale factor. 
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3.6 Image Stack Tool
Use the Image Stack Tool to scroll through a series of related gel images. You can 
easily compare bands that appear, disappear, or change size in different gels run under 
different conditions.

Note: The images should be close to the same size, with bands in the same relative 
positions. You can use the Crop tool to resize images.

With all the images open, select Image Stack Tool from the View menu. The Image 
Stack Tool window will open.

Fig. 3-8. Image Stack Tool.
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In the Image Stack Tool window, all open gels are listed in the field to the right of the 
display window. To select an image to display, click on a gel name. The name will 
appear highlighted with an arrow and the image will appear in the window.

Click on another gel name to display that image.

Buttons for various viewing tools are aligned next to the Image Stack Tool window. 
These commands will change the display of all the images in the stacker at once (e.g., 
magnifying one image will magnify the same relative area in all the images).

Using the controls below the list of names, you can reorder the images and/or scroll 
through them in the stacker.

Reordering Images

To reorder the images in the stacker, first select an image name in the list, and then 
click on the Move displayed image arrow buttons to move it up or down in the list.

Image Playback

Using the controls under Playback, you can scroll through the images in the stacker.

First, highlight some or all of the gel names using Shift-click or Ctrl-click key 
commands. With multiple images selected, the Step arrow buttons become active. 
Click on the arrow buttons to scroll through the list of selected gels.

Alternatively, click on the Auto checkbox next to the arrow buttons to begin 
automatically scrolling through the list. You can adjust the auto-scroll speed using the 
Slow/Fast slider.

3.7 Colors
Select Colors from the Edit menu to open a dialog in which you can adjust the colors 
of the image, as well as windows, buttons, overlays, and other features of the display.
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Fig. 3-9. Colors dialog.

Selecting a Color Group

In the Colors dialog, click on the Color Group button to select the colors of a 
particular group of objects (e.g., pop-up boxes, image colors, etc.).

Fig. 3-10. List of Color Groups.

Click on a color group in the list to select it.
3-15



Quantity One User Guide
Changing a Color

After you have selected the color group to change, click on the specific color button. 
In the Color Edit dialog, adjust the RGB values of the color you selected.

Fig. 3-11. Color Edit dialog.

Saving/Selecting a Defined Set of Colors

After you have changed the colors within color groups, you can save these settings for 
future use on other images. The Colormap Name field displays the name of a defined 
set of colors and color groups. There are several predefined colormaps, or you can 
create your own.

To select a predefined colormap, click on the Load button.
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Fig. 3-12. Selecting a Colormap.

From the list displayed, click on the set of colors you want to apply.

To create your own colormap, adjust the colors within the color groups as described 
above and type in a new colormap name. Click on OK to apply the changes.

To remove a colormap, click on the Delete button. Select the colormap to be deleted 
from the displayed list. A pop-up box will ask you to confirm the deletion.

To return to the Standard colormap, click on the Reset button. All colors will  reset 
to their default values.

3.8 Transform
Use the Transform dialog to adjust the image brightness and contrast and optimize the 
image display. These controls affect the image display only, and will not change the 
underlying data.

With an image open, select Transform from the Image menu or main toolbar.

A user-defined set of colors
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Fig. 3-13. Transform command.

The Transform dialog contains a Preview Window, a Frequency Distribution 
histogram, a Transform Plot, and three main methods of optimizing the image: Auto-
scale, High and Low sliders, and a Gamma slider. You can use these controls to 
adjust the way the software transforms raw image data into the visual display.
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Fig. 3-14. Transform dialog.

3.8.a Transform Subwindows

Preview Window

The Preview Window shows a smaller view of the same image that is displayed in the 
main image window. Changes in the controls are automatically reflected in the 
Preview Window. They are only applied to the main image when you click on OK.

Preview Window

Auto-scale

Transform Plot

Frequency Distribution histogram
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You can use viewing tools such as Zoom Box, Grab and View Entire Image in the 
Preview Window just as you can in the main image window, to focus on particular 
regions of interest.

Frequency Distribution Histogram

The Frequency Distribution histogram shows the total data range in the image and the 
amount of data at each point in the range. In a typical scan, there is a signal spike at 
the left (“gray”) end of the histogram due to background noise.

Transform Plot

The Transform Plot is a logarithmic representation of how the raw pixel data are 
mapped to the pixels of the computer screen.

3.8.b Transform Controls

Auto-scale

Click on the Auto-scale button to optimize the image automatically. The lightest part 
of the image will be set to the minimum intensity (e.g., white), and the darkest will be 
set to the maximum intensity (e.g., black). This enhances minor variations in the 
image, making fine details easier to see. You can then “fine-tune” the display using 
the High, Low, and Gamma sliders described below.

High/Low Sliders

If Auto-scale doesn’t give you the appearance you want, use the High and Low 
sliders to redraw the image manually. Drag the High slider handle to the left to make 
weak signals appear darker. Drag the Low slider handle to the right to reduce 
background noise.

As you drag the sliders, the slider markers on the Frequency Distribution histogram 
will move. Everything to the left of the Low marker will be remapped to minimum 
intensity, while everything to the right of the High marker will be remapped to 
maximum intensity. Using the histogram, you can position the markers at either end 
of the data range in the image, and use the low slider to cut off the “spike” of 
background noise.
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You can also type specific High and Low values in the text boxes next to the sliders. 
Click anywhere on the slider bars to move the sliders incrementally.

Log High/Low Sliders changes the feedback from the slider handles, so that when 
you drag them, the slider markers move a shorter distance in the histogram. This 
allows for finer adjustments when the data is in a narrow range.

Fig. 3-15. Two views of the Frequency Distribution histogram.

Low-High magnifies
area between slidersCan better distinguish background

noise from real data

Low slider remaps background noise to white High slider remaps weaker signals to black

the range of 
data in the image
is very limited

Log scaling enables you to 
better distinguish peaks

In this example,
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Gamma Slider

Some images may be more effectively visualized if their data are mapped to the 
computer screen in a nonlinear fashion. Adjust the Gamma slider handle to expand or 
compress the contrast range at the dark or light end of the range. This is reflected in 
the Transform Plot and Preview Window.

3.8.c Other Features

Full Scale and Low-High

The Full Scale and Low-High option buttons adjust how the range of data in the 
image is displayed in the Frequency Distribution histogram and Transform Plot. They 
do not change how the data is displayed in the image window.

Select Full Scale to adjust the displays so that they show the full intensity range of the 
image.

Select Low-High to magnify the range between the Low and High sliders. This 
makes it easier to view the data if it does not occupy the full intensity range of the 
image.

Log

The Log checkbox changes the way the data is displayed in the histogram so you can 
better discern subtle changes in signal intensity.

Image Max/Min and Units

Image Max and Min display the range of intensity in the gel image.

The image units are determined by the type of scanner used to create the image. For 
images measured in O.D.s, you can display the maximum and minimum O.D values 
in the image by selecting the Calibrated Quantity checkbox. If this box is not 
selected, the maximum and minimum numeric pixel values are displayed.
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Image Color

Click on this button to open a list of color maps, which you can define using the 
Colors command on the Edit menu (see section 3.7, Colors). Select a color map from 
the list to change the image in both the Transform window and the image window.

Invert Display

Select the Invert Display checkbox to change light bands on a dark background to 
dark bands on a light background, and visa versa. The image data will not change—
only the display.

Highlight Saturated Pixels

Select the Highlight Saturated Pixels checkbox to highlight areas of saturation in the 
image in red.

Always Auto-Scale

Select this checkbox to automatically Auto-Scale every new image that you open. 
The software will examine the data range in every image and optimize it accordingly. 
This setting disables the other image-optimization controls in the Transform dialog.

Reset

To return to an unmodified view of the image, click on Reset.

3.9 Resizing and Reorienting Images
The Image menu and toolbar contain commands for changing the size and orientation 
of images.
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Fig. 3-16. Resizing and reorienting tools.

Note: Many of these commands will permanently change the image. You will be 
prompted to confirm any permanent changes.

3.9.a Cropping Images

Use the Crop tool to eliminate unwanted parts of an image, such as border space 
around the gel. You can also use this command to reduce the file size of an image.

Select Crop from the Image menu or toolbar. The cursor will change to a Crop 
symbol.

Define the region to be cropped by dragging the cursor across the image, creating a 
box. Everything outside the box will be deleted.

The dimensions of the crop area (in millimeters and number of pixels) and the file 
size of the image inside the crop area are listed at the bottom of the crop box. 

1. To reposition the crop box, position the cursor at the center of the box. The cursor 
will change to a multidirectional arrow. Then drag the box to a new position.
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2. To resize the box, position the cursor on a box border line or corner. The cursor 
will change to a bidirectional arrow. You can then drag the border or corner in or 
out, resizing the box.

3. To redraw the box, position the cursor outside the box. The cursor will change 
back to the Crop tool, and you can redraw the box.

After you are satisfied with the size of crop box, position the cursor inside the box 
slightly off-center. The cursor will change to a scissors symbol. Then click to perform 
the crop.

A pop-up box will prompt you to: (1) crop the original image, (2) crop a copy of the 
original image, or (3) cancel the operation.

Fig. 3-17. Crop box and pop-up Crop dialog.

If you click on the Copy and Crop button, you will be prompted to enter the name 
and version number of the image copy before cropping.
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Advanced Crop Commands

To ensure that your scans are exactly the same size and shape, you can use the tools 
on the Image > Advanced Crop submenu to save the crop box from one scan and 
apply it to others. These tools also allow you to crop a gel of the same scan.

To define and save a crop box and apply it to another scan:

1. Select Define Crop Area from the submenu and drag a crop box on an image. 
Position the box as described in Cropping Images.

2. Select Place Crosshair from the submenu and click a landmark inside the box that 
is present in all the gels you want to crop. This could be a spot or some other 
image detail. The crosshair will make it easier to position the box in the other 
images so that it encloses the same area.

3. Select Save Crop Settings from the submenu, enter a name for the current crop 
settings in the pop-up box, and click Apply.

4. Complete the crop action in the current image by positioning your cursor inside 
the box slightly off-center and clicking to perform the crop, as described in 
Cropping Images.

5. Open or select the next image you want to crop, select Load Crop Settings from 
the submenu, and select the name of the settings you saved. The crop box and 
crosshair will appear on the image.

6. Reposition the crop box so that the crosshair is correctly aligned with the 
appropriate image object, then complete the crop as described in step 4 above.

To delete any crop settings you have saved, select Delete Crop Settings from the 
submenu and choose the settings to be deleted from the list.

3.9.b Flipping and Rotating Images

Use the image flipping and rotating commands to reorient lanes and bands for proper 
analysis.

Note: These actions will erase any analysis you have performed on the image. You will 
be prompted to confirm the changes.
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Flipping

To flip the image right-to-left, select Horizontal Flip from the Image menu or 
toolbar. To flip the image top-to-bottom, select Vertical Flip.

90° Rotations

Select Rotate 90 Left, Rotate 90 Right, or Rotate 180 from the Image > Rotate 
menu or Image toolbar to perform the specified rotation.

Custom Rotation

Use the Custom Rotation command to rotate the image in increments other than 90°. 
Select Custom Rotation from the Image > Rotate submenu or Image toolbar. A 
green “plus” sign will appear next to the cursor. Click on the image and a circular 
overlay with an orange arrow will appear. A pop-up box will indicate the angle of 
rotation in degrees and radians.
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Fig. 3-18. Custom rotation; the arrow points in the direction of the new top of the image.

To perform the rotation, position the cursor on the arrowhead and drag. As you drag, 
the arrow will rotate and the angle in the box will change. Position the arrow so that it 
points in the direction of the new top of the image.

Note: To center the arrow on a particular point on the image (e.g., to align along a 
particular lane), position the cursor on the point and press the F3 key. The center 
of the arrow will shift to the new position.

To complete the rotation, click on the Rotate button in the pop-up box. Another 
window will open containing the rotated image, and you will be prompted to save this 
image under a new name or version number.

If you are not satisfied with the rotated image, close the window without saving and 
start over.
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Note: Because an image is composed of square or rectangular pixels, Custom Rotation 
performs some minor smoothing on the image for rotations other than 90o. Also, 
any analysis performed on the image will be lost.

3.10 Whole-Image Background Subtraction
Image background due to gel opacity, random signal noise, or other factors can 
interfere with quantitation and data analysis. Quantity One has several tools for 
subtracting background intensity from gel images. This section describes whole 
image background subtraction. You can also subtract background from individual 
lanes (see section  4.2, Lane-Based Background Subtraction) and bands (see section 
 7.6, Volume Background Subtraction).

Whole-image background subtraction is useful for reducing background resulting 
from the opacity of the carrier medium (film, gel matrix, or blot matrix) or film 
fogging.

Note: Whole-image background subtraction permanently changes the image. You will 
be prompted to confirm the change.

Select Subtract Background from the Image menu.
3-29



Quantity One User Guide
Fig. 3-19. Subtract Background dialog.

The Subtract Background dialog has a preview window, which contains a smaller 
view of the image. Changes in the subtract background controls are reflected in the 
preview window and are only applied to the main image when you click on OK.
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Auto-scale

Click on the Auto-scale button to automatically adjust the Dark Contrast and 
Background settings to optimal levels. You can then manually adjust these settings 
using the other controls.

Dark Contrast Slider

Use the Dark Contrast slider to reveal the level of background in the image before 
subtraction. This slider is similar to the High slider in the Transform dialog. Drag the 
slider handle to the left to make faint signals appear stronger. Click on the slider bar to 
move the slider incrementally, or type a value into the field next to the slider.

Note: The Dark Contrast slider itself does not eliminate background intensity; 
therefore, the OK button will not activate if you only adjust this slider. If you 
want to adjust the display contrast without subtracting background, use the 
Transform command (see section 3.8, Transform).

Fig. 3-20. Dark Contrast adjustment reveals true levels of background in the image.

After adjustment: background levels areBefore adjustment: the image 
seems clear of background more apparent
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Background Slider

To manually adjust the background subtraction levels, drag the Background slider to 
the right. You can also move the slider incrementally by clicking on the slider bar, or 
type a specific value into the field next to the bar.

Objects with signal intensities lower than the subtraction level will be eliminated 
from the image when you click on OK.

Background Box

Use the Background Box function to define a background area in the gel that is 
representative of the background in the entire image. This method of subtraction is 
useful for images with uniform backgrounds. 

Click on the Background Box button, then drag on a background area of the image. 
The average intensity of the pixels in the box will be used as the background level to 
be subtracted from the entire image.

Background Stripe

The Background Stripe function is useful for gels in which the background changes 
from top to bottom (e.g., gradient gels).

Click on the Background Stripe button, then drag on a background region to create a 
rectangular box down the length of the image. The average intensity of each 
horizontal row of pixels in the stripe will be subtracted from each pixel in that row 
across the entire gel. This way, if the image has more background at the bottom than 
at the top, more background will be removed from the lower regions of the image.

Note: Make sure that the background stripe runs the entire length of the lanes down the 
gel. The average of the topmost row in the stripe will be subtracted from all rows 
above the stripe, and the average of the bottommost row will be subtracted from 
all rows below.

The minimum and maximum intensities in the stripe are displayed next to the Min 
and Max labels in the box. Also, the average intensity value for the entire stripe is 
displayed next to Avg.
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Completing the Subtraction

When you are satisfied with the background subtraction shown in the preview image, 
click on OK. Because whole-image background subtraction is irreversible, you will 
be prompted to subtract from the original image, subtract from a copy, or cancel the 
operation.

If you choose Copy and Subtract, enter the name and/or version number for the new 
copy in the pop-up box and click on OK to complete the command.

3.11 Filtering Images
Filtering is a process that removes small noise features on an image while leaving 
larger features (e.g., bands) relatively unaffected. A wide range of filters are available 
for removing different types of noise from images. Depending on the nature of your 
data, you will probably need to use only one or two of the available filters. However, 
you should experiment with several different filters before selecting the ones that 
work best for your images.

The filtering commands are located on the Image menu and toolbar.
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Fig. 3-21. Filtering commands.

Note: Since filtering is an irreversible process, you will be asked if you want to create a 
copy of the original image before you filter. If you are experimenting with 
various filters, you should create copies of the image and compare them side-by-
side. If you filter the original image and save it, you cannot return to the original, 
unfiltered state.

3.11.a Filter Wizard

The Filter Wizard is designed to guide you through the filter selection process. First, 
you identify the type of noise in the image. Next, select the size of the filter to use on 
that noise. Finally, filter the image.

Select Filter Wizard from the Image menu or toolbar to open the dialog.
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Fig. 3-22. Filter Wizard dialog.

The dialog contains settings for identifying the different types of noise in the image. It 
also includes a density distribution histogram of the noise in the image to aid in filter 
selection.

Step I: Identify Noise Characteristics

The first step is to identify the type of noise in the image. Examine both the image and 
the density distribution histogram, then select one, both, or neither of the following 
checkboxes:

• Salt. This type of noise appears as specks that are lighter than the surrounding 
background. The density distribution histogram of this type of noise displays 
noise peaks at the high end of the range (right end of the plot). This type of noise 
is common in electronic cameras with malfunctioning pixels. It can also be 
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caused by dust or lint in the imaging optics or scratches on photographic film. 
Salt is a type of outlier noise (see below). 

• Pepper. This type of noise appears as specks that are darker than the surrounding 
background. The distribution histogram of this type of noise displays noise peaks 
at the low end of the range (left end of the plot). Its causes are similar to those of 
salt noise. Pepper is a type of outlier noise (see below).

Next, select one of the following option buttons to describe additional features of the 
noise.

• Gaussian. The distribution histogram of this type of noise has a Gaussian profile, 
usually at the bottom of the data range. This type of noise is usually an electronic 
artifact created by cameras and sensors, or by a combination of independent 
unknown noise sources.

• Uniform noise. This type of noise appears in the histogram as a uniform layer of 
noise across the data range of the image.

• Outlier noise. This category of noise includes salt and pepper noise (see above). 
The distribution histogram of this type of noise displays noise peaks at the high 
and low ends of the range.

After you have identified the type of noise, go to the next step.

Step 2: Select Filter Size

Image noise is filtered by means of a filtering window (or kernel), which is measured 
in pixels. This filtering window slides across the image, processing the pixels within 
it.

The available filter dimensions range from 3 x 3 to 9 x 9 pixels. To select an 
appropriate size, magnify a background region of the image so that you can see the 
individual pixels. The filter size you select should be larger than the average noise 
feature but smaller than the data features.

Note: A smaller filter will alter the image less than a larger filter. Large filters can result 
in better suppression of noise, but can also blur desirable features in the image.
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Step 3: Begin Filtering

After you have completed the selections, the filter name and size will be displayed at 
the bottom of the Filter Wizard dialog.

To being filtering, click on the OK button. Because filtering is an irreversible process, 
you will be prompted to filter the original image, filter a copy of the image, or cancel 
the operation.

If you choose Copy and Filter, enter a name and/or version number for the new copy 
in the pop-up box and click on OK.

3.11.b Selecting a Filter Directly

If you know the type and size of filter you want, you can select it directly from the 
Image > Filter List submenu. The submenu includes all the available filters.

The types of filters are:

• Weighted Mean. This filter is useful for reducing Gaussian noise. It calculates 
the weighted mean of the pixels within the filtering window and uses it to replace 
the value of the pixel being processed.

• Out of Range Pixel. This filter is useful for suppressing salt-and-pepper noise; 
its effect on Gaussian noise is minimal. This filter calculates the mean of the 
pixel values in the filtering window, including the pixel being processed. If the 
difference between the mean and the individual pixel value is above a certain 
threshold, then the individual value is replaced by the mean.

• Median. Also useful for suppressing salt-and-pepper noise, this filter calculates 
the median value of the pixels within the filtering window and uses it to replace 
the value of the pixel being processed. The median filter produces very little 
blurring if a small-sized window is selected.

• Maximum. This filter is useful for eliminating pepper noise in an image (it 
worsens the effect of salt noise). It replaces the value of the pixel being processed 
with the maximum value of the pixels within the filtering window.

• Minimum. This filter replaces the value of the pixel being processed with the 
minimum pixel value within the filtering window. This filter is useful for 
eliminating salt noise in an image (it worsens the effect of pepper).

• MidValue. This filter is useful for suppressing uniform noise within an image; 
however, it worsens the effect of pepper and salt. This filter replaces the value of 
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the pixel being processed with the mean of the maximum and minimum pixel 
values within the filtering window.

• PowerMean. This filter is useful for suppressing salt and Gaussian noise within 
an image (it worsens the effect of pepper noise). It replaces the value of the pixel 
being processed with the power mean of the pixel values within the filtering 
window.

• ContraMean. This filter is useful for suppressing pepper and Gaussian noise 
within an image (it worsens the effect of salt). It replaces the value of the pixel 
being processed with the contra-harmonic mean of the pixel values within the 
filtering window.

• Adaptive. This filter is useful for suppressing Gaussian noise and salt and/or 
pepper within an image. If the image contains a mix of salt and pepper, select this 
filter.

To begin filtering, select a filter type from the pull-down list. A pop-up box will 
prompt you to select a filter size.

Fig. 3-23. Selecting a filter size.

Click on a button to select a size. (See, Step 2: Select Filter Size for guidance.) 
Because filtering is an irreversible process, you will be prompted to filter the original 
image, filter a copy of the image, or cancel the operation.

If you choose Copy and Filter, enter a name and/or version number for the new copy 
in the pop-up box and click on OK.
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3.12 Invert Data
The Invert checkbox in the Transform dialog (see “Invert Display” on page 23) 
inverts the display of the image. However, in some cases you may need to invert the 
actual image data.

If the image has light bands or spots on a dark background (i.e., the signal intensity of 
the background is greater than the signal intensity of the sample), you need to invert 
the data before analysis.

Select Invert Data from the Image menu or toolbar. This function is reversible. You 
may need to use the Transform controls to adjust the appearance of the inverted 
image.

3.13 Text Overlays
To create and display textual notes directly on the image, select Text Overlay Tools 
from the Edit menu or main toolbar. This will open the Text Overlay Tools toolbar.

Fig. 3-24. Text Overlay Tools toolbar.

Creating a Text Overlay

To create a text overlay, click on the Text Tool, then click on the image at the spot 
where you want the text to appear. This opens the Text Overlay Properties dialog.

Select tool

Text tool
Line tool Alignment toolsCopy Paste
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Fig. 3-25. Text Overlay Properties dialog.

To enter text, type in the main field. Use the buttons in the dialog to select the 
properties of the text, including format, alignment, and justification.

Select the font style, font size, color of the text, and color of the background in the 
text box using the pull-down lists.

After you have typed the text, click on OK. The text will appear on the image at the 
spot where you originally clicked.

Editing a Text Overlay

To edit a text overlay, make sure the Text Tool or Select Tool is selected, and then 
double-click on the overlay to open the Text Overlay Properties dialog. The existing 
text will be displayed and can be edited.

Line Tool

You can use the Line Tool to draw a line between text and an image feature, or 
between any two points of interest on the image.

Click on the Line Tool button, then drag on the image to create the line.

To resize or adjust a line, make sure the Line Tool or Select Tool is selected, and then 
position the cursor on one end of the line (marked by a circle) and drag.

Text color

Background color
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To add arrowheads to a line, make sure the Line Tool or Select Tool is selected, and 
then double-click on the middle of the line. A dialog will pop up with options to add 
arrowheads to one or both ends of the line.

Moving and Copying Text and Lines

You can move, copy, or delete a single text overlay or line or a group of overlays and 
lines within an image. You can also copy and paste between images.

First, you must select the object(s). Click on the Select Tool button. To select a single 
overlay or line, click on it. To select multiple objects, either drag a box around them 
or hold down the Shift key and click on them individually. When dragging to select a 
group of objects, make sure that you completely surround all the objects to be 
selected.

Each selected overlay/line will have a green border.

• To move the selected object(s), position the cursor over the selection and drag.

• To copy within an image, hold down the Ctrl key while dragging the selected 
object(s). The copy will be created and dragged to the new position.

• To delete the selected object(s), press the Delete key.

• To copy between images, click on the Copy to Clipboard button, then open or 
select the image you want to copy to and click on the Paste from Clipboard 
button. The copied object(s) will be pasted into the new image in the same 
relative position they were copied from.

Note: If you are pasting into an image with a different pixel size (i.e., resolution), you 
will receive a message that the placement of the copy may not be exact. Click on 
OK to complete the paste, then position the pasted objects manually.

Viewing Previously Created Text Overlays/Lines

Previously created text overlays and lines will appear on the image when you open 
the Text Overlay Tools toolbar.

If you have concealed all overlays using the Hide Overlays command (section 3.3, 
Showing and Hiding Overlays), click on any of the buttons on the Text Overlay Tools 
toolbar to redisplay the text.
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3.14 Erasing All Analysis from an Image
To delete all analysis and overlays from an image (including any lanes, bands, 
volumes, standards, text overlays, etc.), select Clear Analysis from the Edit menu. 
Since this process is irreversible, you will be prompted to confirm the selection.

3.15 Sort and Recalculate
To update, renumber, and recalculate all lane and band information, select Sort and 
Recalculate from the Edit menu.

3.16 Automation Manager
The Automation Manager allows you to save objects such as lanes, automated band 
detection, standard bandsets, volume overlays, and text and line overlays in a 
template file. These files can then be automatically applied to images either 
individually or in batches. To open the Automation Manager, select 
Analysis>Automation Manager. 
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Fig. 3-26. Automation Manager dialog

3.16.a Step 1 - Select Template

The Select template field lists all the templates that are currently open. The 
Automation Manager remembers the files that were open the last time the application 
was open. To create a new template, click New. A new template appears in the list. 
See Section 3.16.b, Step 2 - Edit Selected Template for how to modify a new 
template. To open an existing template not currently in the list, click Open. This opens 
the standard Open dialog. To remove a template from the list, click Close.

3.16.b Step 2 - Edit Selected Template

Step 2,  Edit Selected Template, lists the name of the currently selected template and 
the list of options available to the template. To edit the template, check the option(s) 
you would like to include and/or uncheck the option(s) you would like to remove 
from the template.
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Use Single Image for Template

The Automation Manager allows you to specify a single image as the source for all 
options you select. Checking the Use Single image for template box opens the Select 
Source Image for this Script item dialog opens.

Fig. 3-27. Select an image

Make sure the image you select contains the object(s) you wish to apply to the 
destination images.

If you wish to  use options from multiple images, then uncheck the box labeled, Use 
single image for template. As you check each option in step two you will be 
prompted to select a source image for that option.

Note: The source image must be open when the option check box is selected. Once you 
have finished checking options from a source, the source image can be closed.

When you are satisfied with your changes, click Save, or Save As to save it as a new 
template.  If this is a new template, you must enter a new name for the template when 
you click Save. To change the name of a template, click Save As and enter a new 
name.
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Default Automation

The default automation template is applied to the currently active image when you 
select Analysis>Apply Default Automation. To set a new default template, highlight 
the desired template in the Automation Manager and click Set as Default. 

To run the default automation template on the currently active image, select Apply 
Default Automation from the Analysis menu.

Once a default template is chosen, The Automation Manager does not need to be open 
to be applied, nor do you need to select a default each time Quantity One opens as it 
remembers the default from the last open session of the application.

3.16.c Step 3 - Select Images

This portion of the Automation Manager lists the currently open images. Select the 
images to which you wish to apply the selected template. Use ctrl>click and 
shft>click to select more than one image, or click Select All to select all the images in 
the list. 

3.16.d Step 4 - Apply Selected Template

Click Apply to apply the selected template in step 1 to the selected images in step 3.
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4. Lanes
Before you can use many of the analysis functions, you must first define lanes and 
bands on the gel image. This chapter describes the tools for defining lanes.

Note: If you want to  compare bands across lanes (using standards or band matching), 
the lane lines should be approximately the same length, with their starting points 
aligned across the top of the image. This is important for calculating the relative 
mobility of the bands. If gel wells are visible in the image, you should center the 
start points of the lane lines on the wells and position the ends of the lanes 
slightly below the last band for best results.

4.1 Defining Lanes
You can define lanes individually or as part of a frame. The functions for doing this 
are on the Lane menu and toolbar.

Fig. 4-1. Lane menu and toolbar.

In Quantity One, lanes are defined by red lane lines overlaid on a gel. The lane lines 
can be created individually (see section  4.1.c, Single Lanes), or they can be created 
as part of a lane frame.
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Fig. 4-2. Features of a lane frame.

4.1.a Lane Frames

The fastest way to define all the lanes on a gel is to create a lane frame using the Auto 
Frame Lanes command. If this command doesn’t work well on your images, you can 
create and place a lane frame manually.

Auto Frame Lanes

Note: Auto Frame Lanes works best on gels with large numbers of clearly defined 
lanes and bands. Also, the lanes should be reasonably vertical and contain 
approximately the same amount of sample.

Select Auto Frame Lanes from the Lane menu or toolbar. The program will 
automatically detect the lanes and place a frame over them.

Anchor point

Border and Lane (in red)

anchor lines
(in white)
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The lane frame contains individual lane lines numbered sequentially from left to 
right. The border and anchor lines of the frame are marked with dashed white lines, 
the lanes are solid red lines, and each anchor point (interior and corner) is marked 
with a circle. 

The top and bottom of the frame are parallel with the top and bottom of the image. 
However, the interior anchor points and lines will “bend” the frame to follow the 
actual lanes in the gel, compensating for any curving or distortion in the gel.

If Auto Frame Lanes detects too few or too many lanes, you can add or delete lanes 
using the single lane commands (see section 4.1.c, Single Lanes).

If Auto Frame Lanes does not work on the image, you will be prompted to create a 
lane frame manually. To delete the lane frame, select Clear Analysis from the Edit 
menu.

Manual Frame Lanes

If Auto Frame Lanes does not work with your images, you can frame the lanes 
manually.

Select Frame Lanes from the Lane menu or toolbar. In the dialog, enter the number 
of lanes in the gel and click on OK.

Fig. 4-3.  Frame Lanes dialog.
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Fig. 4-4.  Lane frame created using the Frame Lanes command.

The lane frame will be marked by corner anchor points, with no interior anchors. You 
can edit the frame as described below.

4.1.b Editing the Frame

If the frame is too large or small, or does not follow the lanes on the image, you can 
adjust it using the frame editing commands.

Fig. 4-5. Edit Frame tools.

Corner 
anchor points
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Adjusting the Entire Frame

The following commands are located on the Lane > Edit Frame submenu:

• To stretch the frame in one direction (e.g., to encompass additional bands at the 
top or bottom of the image), select Stretch Frame from the submenu or Lane 
toolbar and drag an anchor point in or out. The opposite anchor point will remain 
fixed while the frame expands or contracts.

• To move the entire frame to a new position, select Move Frame from the 
submenu and drag an anchor point. The entire frame will move.

• To rotate the frame, select Rotate Frame from the submenu and drag an anchor 
point. The entire frame will rotate.

• To resize the entire frame, select Resize Frame from the submenu and drag an 
anchor point in or out. The frame will expand or contract from the center.

Adding and Adjusting Frame Anchors

To adjust a corner anchor point, select Add/Adjust Anchors from the Edit Frame 
submenu or toolbar and drag the anchor. This will move the anchor point and attached 
frame lines.

If the gel lanes are not straight, you can create additional anchor points along the 
frame to change the shape of individual lines.

Still using Add/Adjust Anchors, click anywhere on the frame lines. This creates 
interior anchor points both where you clicked and on the other side of the frame, 
connected by a frame line. Then drag the anchor points to bend the frame.

Add and adjust as many anchor points as you need to bend the lane lines to follow the 
lanes in the gel.
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Fig. 4-6.  Adjusting the anchor points of the lane frame.

Removing/Unadjusting Anchors

To remove an anchor point, select Unadjust Anchors from the Edit Frame submenu 
or toolbar and click on the anchor. The anchor will disappear and the adjusted lanes 
will straighten out.

4.1.c Single Lanes

You can define individual lanes using the single lane tools. These are located on the 
Lane > Single Lane submenu or on the Lane toolbar.

New anchor points

New anchor lines
4-6



Chapter 4. Lanes
Fig. 4-7. Single Lane tools.

Note: You can use the single lane commands on any lane within a frame; however, the 
lane will be detached from the frame.

To mark an individual lane, select Create Lane and drag a line from the top to the 
bottom of the gel lane. The lane line will be marked in red. Repeat this procedure to 
manually mark all the lanes you want to analyze in the gel.

Note: If the lane numbering gets out of sequence, select Sort and Recalculate from the 
Edit menu to renumber the lanes.

Adjusting Single Lanes

You can adjust the position of any lane line. Select Adjust Lane from the 
Lane > Single Lane submenu or the Lane toolbar and either drag one of the existing 
anchor points or click anywhere on the lane to create a new anchor point and drag it 
into position.

To undo any lane adjustments, select Unadjust Lane from the submenu or toolbar 
and click on an anchor point to remove it. If you remove the anchor points at either 
end of the lane line, you will delete the entire line.

Deleting Lanes

You can delete both single lane lines and lines from a lane frame.

Select Remove Lane from the Single Lane submenu or toolbar and click on the lane. 
You will be prompted to confirm the deletion. 

Note: If you delete a lane from a group of lanes or a frame, select Sort and Recalculate 
from the Edit menu to renumber the remaining lanes.
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4.1.d Lane Width

Lane width is important for band quantition. Only the region of the band within the 
lane sampling width is quantitated, so the defined lanes should be slightly wider than 
the actual lanes in the gel.

You can adjust the sampling width of all the lanes using the Detect Bands dialog (see 
section 5.2.a, Detection Parameters). See section 5.1, How Bands Are Identified and 
Quantified, for a full discussion of the effect of sampling width on band quantitation.

To adjust the width of a single lane, select Lane Width from the Lane menu or 
toolbar and click on the lane line. The Sample Width dialog will display the current 
width of the lane.

Fig. 4-8. Sample Width dialog.

Enter a new width in millimeters and click on the OK button.

4.1.e Lane Profile

After you have defined a lane, you can review the intensity profile of the lane. A lane 
profile provides a quick visualization of the intensity of your sample data, and is also 
useful for determining the level of background in the gel.

Select Plot Lane from the Lane menu or toolbar, then click on a lane. A lane profile 
graph will be displayed.
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Fig. 4-9. Profile of a defined lane.

In the lane profile, bands are represented by peaks and background intensity is 
represented by the baseline region below the peaks. The profile is generated by 
calculating the average intensity of each horizontal row of pixels across the specified 
width of the lane.

To close the lane profile, click on Hide Overlays on the main toolbar.

4.2 Lane-Based Background Subtraction
After defining lanes, we strongly recommend that you perform lane-based 
background subtraction. This is the best method for removing background intensity 
from lanes, and is required for Gaussian modeling of bands.

Lane-based background subtraction uses a “rolling disk” method of subtraction, 
named for a hypothetical disk that rolls along underneath the lane profile, removing 
different intensity levels along the length of the lane.

The size of the disk determines how much background will be subtracted. A large 
disk will follow the profile trace less closely, touching fewer points along the trace 

Intensity peaks

Background
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and removing less background. A smaller disk will more closely follow the profile 
trace, removing more background.

A disk radius that is too large will result in poor removal of background. A disk radius 
that is too small may subtract actual data. 

Fig. 4-10. Examples of the background trace for small and large rolling disks. The small disk 
follows the profile trace more closely, resulting in more background subtraction.

Select Lane Background from the Lane menu or toolbar and click on a lane. The 
lane will be highlighted, the lane profile will be displayed, and the Lane Background 
Subtraction dialog will open.

Small Radius Large Radius
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Fig. 4-11. Lane Background Subtraction dialog.

In the dialog, you can set the same subtraction level for all lanes or specify an 
individual subtraction level for the selected lane. Any changes you make will be 
automatically applied to the image. To close the dialog, click on Done.

4.2.a Profile Trace

When you make changes in the dialog, note that the profile trace of the lane also 
changes. In the standard view, the original “raw” trace of the line is shown in black, 
and the orange line represents the background beneath the peaks of the trace as 
defined by the rolling disk.

As you change the size of the rolling disk, the orange line changes, following the 
contours of the profile more or less closely as shown in Fig. 4-10.

To display the trace with the background removed, select Show lane trace with 
background subtracted. The orange line in the trace disappears along with the 
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background, and you can visually compare the relative intensities of the bands in the 
lane.

4.2.b All Lanes Off

To turn off lane-based background subtraction for all the lanes in the image, select the 
All Lanes Off button.

4.2.c All Lanes On (Same Level)

Select this option to set the same subtraction level for all lanes. The Rolling Disk Size 
field in the All Lanes section of the dialog displays the rolling disk radius in number 
of pixels. Enter a new value in the field, or use the arrows to change the value in 10 
percent increments.

Typical rolling disk sizes range from 50 to 150. As you change the size, study the 
level of background subtraction in the lane trace.

4.2.d Subtraction Varies by Lane

You can set a different subtraction level for each lane in the gel using the controls in 
the Selected Lane area of the dialog. Any changes you make with these controls will 
only be applied to the selected lane; to select a different lane, click on it with the Lane 
Background command assigned.

Click on the Lane Off button to turn off subtraction for the selected lane. Select Lane 
On to turn on subtraction for the lane.

To adjust the subtraction level for the lane, change the value in the Rolling Disk Size 
field under Selected Lane. This field displays the rolling disk radius in number of 
pixels. Enter a new value in the field, or use the arrows to change the value in 10 
percent increments.

Typical rolling disk sizes range from 50 to 150. As you change the size, study the 
level of background subtraction in the lane trace.

When you make changes to the selected lane, the Subtraction Varies by Lane button 
is selected. To turn off individual lane subtraction, choose either All Lanes Off or All 
Lanes On.
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4.3 Compare Lanes
The Compare Lanes graph allows you to superimpose the intensity profiles of any 
number of lanes from any number of open images.

Select Compare Lanes from the Lane menu or toolbar, then click on the first lane 
you want to display. The Compare Lanes window will open.

Note: The image must have defined lanes for this command to work.

Fig. 4-12. The Compare Lanes dialog.

The X axis of the graph is the Rf value and the Y axis is the pixel intensity value at 
each point along the lane. Compare Lanes automatically “best fits” lanes within the 
display window to maximize the range of intensity values included in the graph. Rf 
values are displayed from 0.0 to 1.0.
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Adding and Removing Lanes from the Graph

To add a lane to the graph, click directly on the lane in the image. The plot of the lane 
will appear in the graph.

Each lane you add will be displayed in one of eight colors, and will be identified by 
color in a legend underneath the graph. If you add more than eight lanes, the colors 
will repeat, but each lane will still be identified underneath the trace display. There is 
no limit to the number of lanes that can be displayed simultaneously.

To remove a lane profile, click on the Remove Lane button. A pop-up box will 
prompt you to select the lane to remove. If you remove a lane, the colors of the 
remaining lanes will change. Check the lane legend for an updated color code.

Magnifying the Graph

Use the Zoom In and Zoom Out buttons in the dialog to magnify regions of interest 
in the profiles. Alternatively, drag the cursor horizontally across the graph and release 
the mouse button to magnify the defined range.

Note: The magnifying functions in Compare Lanes only magnify the profile in the 
direction of the X axis. Therefore, the profile will appear to “stretch” without 
increasing in height.

The Full View button returns the graph to its default display.

If you have magnified part of the graph, the Left arrow and Right arrow scroll 
buttons can be used to pan left or right along the graph.

Show Gaussian Modeling

The Show Gauss Model checkbox is active if any of the selected lanes includes 
Gaussian modeling (see section 5.7, Gauss-Modeling Bands). If you select this 
checkbox, the Gaussian-fitted profiles will be superimposed on the regular lane 
profiles. The Gaussian profiles are displayed in white.

Align Band Types

The Align Band Types checkbox is active if any of the selected lanes includes 
defined band types (see section 6.2, Band Matching).
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If this checkbox is selected, the profiles of all bands that have been identified as the 
same band type will be stretched and superimposed on one another, so their peaks 
align. This is useful if the same band appears as peaks in slightly different positions in 
different lanes, and you want to align the peaks to confirm that they are all the same 
band type.

Note: This command only changes the lane profiles as they are displayed in the 
Compare Lanes dialog, and will not affect image data in any way.

Fig. 4-13. Two band types as they appear in two lanes, before alignment and after.

Note that this function will not align band types from different band sets (e.g., Band 
Type 1 in Band Set A and Band Type 1 in Band Set B will not be aligned). However, 
the same band types from different images will be aligned.

Note: The Rf values in the X axis will no longer be accurate if Align Band Types is 
selected, since some band profiles will be stretched and their peaks shifted.

Printing and Exporting

Click on the Print button to print a copy of the Compare Lanes display.

Click on the Export button to export the data points in the graph to a spreadsheet. 
This will open the Compare Lanes Export dialog.

Unaligned Aligned
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Fig. 4-14. Compare Lanes Export dialog.

This Export dialog includes a field for the number of data points to be taken along the 
length of each lane. The default value in this field is the maximum number of data 
points that are available for the lanes you are comparing.

Select the export format (tab or comma delimited) and destination (file or clipboard), 
then click on OK.

Note: The exported data will be different depending on whether you have checked 
Align Band Types, Show Gauss Model, or neither. If the Show Gauss Model 
checkbox is selected, each lane that has been Gaussian fitted will have two 
columns of data: one for the Gaussian-fitted profile and one for the regular 
profile. If the Align Band Types checkbox is selected, the exported values will 
reflect the stretched and shifted profiles of those lanes that have been aligned.

4.4 Lane-based Arrays
The lane-based array functions allow you to create a lane frame for the cells in an 
array. You can then specify the cell dimensions and quantitate them using the 
Quantity Standards function (see section 6.3, Quantity Standards).

Number of data points
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Note: You can quantitate arrays outside of lanes using volume arrays (see section 7.7, 
Volume Arrays).

The first step in defining an array is specifying the number of columns and rows and 
creating an array frame.

Got to the Lane menu, open the Lane-based Array submenu, and select Frame 
Array.

Fig. 4-15. Lane-based Array tools.

Enter the number of columns in the array and click on OK.

Fig. 4-16. Setting number of array columns.

In the next box, enter the number of rows and click on OK.

Fig. 4-17. Setting the number of array rows.
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The array matrix will appear on the image. Each column will be marked by a red line, 
and each cell will be marked by top and bottom brackets.

Note: If the cells appear marked by lines instead of brackets, select Band Attributes 
from the Band menu and select Brackets in the dialog.

When you first create the array matrix, it will probably not be centered on the 
columns and cells in the actual image. In the next step, you will adjust the position of 
the matrix.

Adjusting the Array Matrix

The Add/Adjust Anchors tool will be automatically assigned to the mouse after you 
create the frame (otherwise, select it from the Lane > Edit Frame submenu). Position 
the cursor on the corner points of the frame and drag them into position so that the red 
lines run down the middle of the array columns and the top and bottom brackets are 
centered on the array cells (see section 4.1.b, Editing the Frame for guidance on 
adjusting frames).

If necessary, the Adjust Lane command (see “Adjusting Single Lanes” on page 7) 
and Adjust Band command (see section 5.3.b, Adjusting Bands) can be used to 
adjust the placement of columns and cells within the frame.

Reducing Background in the Array

After you have positioned the array, you should reduce lane background using the 
Lane Background command (see page 4.2, Lane-Based Background Subtraction). 
Lane background will affect quantitation of the cells.

Setting Array Cell Height and Width

Now you should adjust the cell brackets so that they completely enclose the cells in 
the array.

Select Array Cell Height from the Lane > Lane-based Arrays submenu and enter the 
height in millimeters of the array cells.
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Fig. 4-18. Setting the array cell height.

When you click on OK, the cell brackets will adjust to the specified height. If you 
aren’t sure of the exact height, you can experiment with different values.

Select Array Cell Width and enter the width in millimeters of all the cells in the 
array.

Fig. 4-19. Setting the array cell width.

When you click on OK, the cell brackets will adjust to the specified width. If you 
aren’t sure of the exact width, you can experiment with different values.

Analyzing Array Data

When the brackets fully enclose each cell in the array, you are ready to analyze the 
data. You can display various measures of cell quantity on the image using the Band 
Attributes command on the Band menu. With the Band Attributes dialog open, select 
from Peak Density, Average Density, Trace Quantity, Relative Quantity, and other 
measures. You can also report these values by selecting Lane Reports from the 
Reports menu.
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To use known quantities to calculate unknowns, you can use the Quantity Standards 
function (see section 6.3, Quantity Standards).
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5. Bands
After you have defined the lanes on the gel image, you can automatically identify and 
quantitate bands using a set of adjustable parameters.

Note: You can quantitate bands, arrays, or other objects outside of lanes using volumes. 
See Chapter 7 for details.

The tools for band detection are located on the Band menu and on the Band Tools 
toolbar.

Fig. 5-1. Band menu and Band Tools toolbar.

Note: Before detecting bands, you should subtract background from the lanes using the 
Lane Background command (see section 4.2, Lane-Based Background 
Subtraction).
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5.1 How Bands Are Identified and Quantified
You can automatically identify all the bands in an image using the Detect Bands 
command (see section 5.2, Band Detection), or you can mark them individually using 
the Create Band command (see section 5.3, Identifying and Editing Individual 
Bands).

Each identified band is defined by brackets above and below the band. The width of 
each set of brackets is determined by the lane sampling width (see section 5.2.a, 
Detection Parameters). The height of the brackets is determined automatically, using 
a band-finding formula together with parameters that you select.

Fig. 5-2. Illustration of bracket quantitation.
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Chapter 5. Bands
When a band is quantitated, the average intensity of each horizontal row of pixels 
within the brackets is calculated. Next, the number of pixel rows between the top and 
bottom brackets is determined. Taken together, these result in an intensity profile for 
the band.

Finally, the area under the profile curve to the baseline is integrated, resulting in units 
of intensity x millimeters. This is the “trace quantity” of the band.

Note: Because the profile of an ideal band conforms to the shape of a Gaussian curve, 
band profiles can be “fitted” to a Gaussian model. The band quantity can then be 
quantitated from the area under the Gaussian curve. This is the best to resolve 
overlapping or closely spaced bands in images. See section 5.7, Gauss-Modeling 
Bands, for details.

5.2 Band Detection
The Detect Bands command automatically detects the bands in defined lanes, based 
on parameters that you select.

Note: Before detecting bands, you should subtract background from the lanes using the 
Lane Background command (see section 4.2, Lane-Based Background 
Subtraction).

Select Detect Bands from the Band menu or toolbar. The Detect Bands dialog will 
open.
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Fig. 5-3. Detect Bands dialog, short and expanded formats, with default values.

When you first open the Detect Bands dialog, all bands will be automatically detected 
based on the default parameters in the dialog, and the bands will appear marked on 
the image. The bands can be marked by either lines or brackets, depending on the 
settings in the Band Attributes dialog (see section 5.5, Band Attributes).

Note: If you have already manually identified bands (using Create Band, Adjust 
Band, etc.), the Detect Bands function will overwrite them. You should use 
Detect Bands first, and then manually add, adjust, or remove bands as needed.

Click here to toggle format

Band tools buttons are
included in the dialog
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The Detect Bands dialog has a short format and an expanded format; toggle between 
them by clicking the toggle box in the lower right corner.

To change a parameter in the dialog, you can either type in a new value or use the 
arrows to increase or decrease the setting by 10 percent. Experiment with different 
settings to find those best suited to your images.

5.2.a Detection Parameters

Lanes to Detect 

If the intensities of the bands vary from lane to lane, you may need to use different 
detection parameters on different lanes. Specify whether you want to use the detection 
parameters for all the lanes or a single lane by selecting All or One next to the Lanes 
prompt. If you choose One, type the lane number in the field next to the One button.

When to Detect

If you select Auto next to the Detect prompt, band detection will occur immediately 
each time you change a detection parameter. You will not need to click on the Detect 
button located at the bottom of the form.

To change more than one parameter before detecting, choose Manual. With the 
Manual option, you can change parameter settings first, and then apply them by 
clicking the Detect button.

Normalization

Normalization is a way to compensate for differences in intensity between lanes. It 
does not normalize for band quantitation.

The intensity of each lane is determined by the darkest band in that lane. For example, 
suppose that in all but one of the lanes the darkest band has an intensity of 50,000 
counts. In the one light lane, the darkest band is only 25,000 counts. With 
normalization, band detection will be twice as sensitive when processing the light 
lane, improving the detection of faint bands.
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Select No next to the Normalize prompt to apply the band detection parameters in the 
same way to every lane in the gel image. Select Yes to normalize for the intensity of 
the lane.

Shadow Rejection

“Shadow bands” are common gel artifacts. Shadow bands are spaced at tandem repeat 
intervals and decrease in intensity as they progress further from a real band. The 
Shadows parameter is designed to limit the detection of shadow bands (see also Band 
Limit). 

Select Reject to turn on the shadows filter. A band will detected only if it is darker 
than the one above it or spaced further than one tandem repeat unit from the previous 
band. This greatly reduces the number of shadows identified as real bands.

Select Accept to turn off the shadows filter.

Band Limit

If you know that all the lanes in a gel contain a specific number of bands, you can 
click on the Limit button next to the Bands prompt and type in the number of bands 
that you know are present. Only that number of bands will be detected in each lane, 
reducing the need for later editing.

Sensitivity

The Sensitivity setting determines the minimum signal intensity in the image that will 
be defined as a band. The higher the sensitivity value, the more bands will be 
detected.

If the sensitivity is set too high, background noise may be detected as bands. If the 
setting is too low, real bands may be missed.

The default sensitivity setting is 10.00. If the gel has faint bands (e.g., O.D. < 0.05, 
counts < 2,000), you may want to increase this value to 20.00.
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Lane Width

The Lane Width setting determines the width along the lane lines that are sampled 
for band detection and quantitation.

When a band is detected, an average intensity for each horizontal row of pixels within 
the band brackets is calculated. The lane width determines the number of pixels in 
each row. Study the band lines in the image while you adjust the width. Select a width 
that is slightly wider than the bands in the gel.

Fig. 5-4. Adjusting the lane width.

You can also change the widths of individual lanes using the Lane Width command 
(see section 4.1.d, Lane Width).

Minimum Density 

When Normalize is turned off, the Min. Density defines the lowest signal intensity 
that will be counted as a band.

Before selecting a Min. Density value, use the Plot Lane command on the Lane 
menu to plot a trace of a lane that includes some faint bands. Then enter a value that is 
lower than the intensity of the peak of a faint band but is still above the background.

If faint bands are still undetected after adjusting this parameter, you may want to 
increase the Sensitivity setting.

Adjust the lane
width until the band
lines are slightly
wider than the bands
in the image.
5-7



Quantity One User Guide
If Normalize is turned on, Min. Density changes from an absolute value to a 
percentage. This percentage is the fraction of the signal intensity of the darkest band 
in the lane that will be detected as a band. For example, if the darkest band in a lane is 
50,000 counts and the Min. Density is set to 25,000 counts, when you turn on 
Normalize, the Min. Density will switch to 50% (i.e., a band must be at least half as 
dark as the darkest band in the lane).

Noise Filter

The Noise Filter is used to minimize the number of small fluctuations in the image 
(i.e., noise) that are called bands while still recognizing larger features (i.e., real 
bands). This filter becomes especially important at higher Sensitivity levels.

The Noise Filter value refers to the size of the filter in pixels (e.g., a value of 2.50 
equals a filter size of 2.50 x 2.50 pixels). Features smaller than the filter size will not 
be recognized as bands. Entering a noise filter size of zero turns it off completely. The 
default value is 4.00. 

If band detection detects doublets as single bands, decrease the Noise Filter setting 
and/or increase the Sensitivity.

You can also try decreasing the Size Scale parameter instead of the Noise Filter to 
improve the detection of closely-spaced bands. However, if you decrease both the 
Noise Filter and the Size Scale, the fuzziness around bands may be mistakenly 
detected as separate bands.

Shoulder Sensitivity

Normally, band detection tries to distinguish shoulders as separate bands. When 
looking at a lane trace, these bands appear as flat or gently sloping abutments to 
darker, better-defined bands (i.e., there is no dip on the trace between the two bands).

Increasing the Shoulder Sensitivity will result in more shoulders being detected as 
bands. Changing this setting to zero will result in no shoulders being recognized as 
separate bands.

If band detection calls a doublet a single band, check the lane trace to see if there is a 
dip between the peaks of the two bands. If there is no dip, increasing the Shoulder 
Sensitivity value will help resolve the two bands.
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Size Scale

The Size Scale field helps distinguish between trends in signal intensity and random 
intensity fluctuations. It is the number of pixels in a vertical column that are taken 
together to determine whether a band is present. 

The Size Scale parameter is similar to the Noise Filter in that it uses the size of 
objects in the image to determine the nature of those objects. The default Size Scale 
setting of 5 pixels is optimal for most gel images. It can be set to any whole number 
greater than or equal to 3.

If a gel image has high levels of background noise, a larger Size Scale is appropriate. 
At low noise levels, a smaller value is preferable. You can also increase the Size Scale 
if the gel only has a small number of thick bands scanned at high resolution.

5.2.b Parameter Sets

You can save detection parameters for use on similar images. Enter a name for the set 
in the Parameter Set Name field, and click on the Save button.

Fig. 5-5. Parameter set controls in the Detect Bands dialog.

To load a saved set of parameters, click on the Load button and select the set from the 
list. To remove a set of parameters, first load it, then click on Delete.

5.2.c Default Parameters

To return all detection parameters to their default values, click on the Reset button at 
the top of the form.
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5.3 Identifying and Editing Individual Bands
To manually identify and edit individual bands in an image, use the Create Band, 
Adjust Band, and Remove Band commands on the Band menu and toolbar. (These 
are also included on the toolbar in the Detect Bands dialog.)

Fig. 5-6. Create, Adjust, and Remove Bands buttons.

Note: When editing individual bands, it is useful to display the band brackets. Select 
these in the Band Attributes dialog (see section 5.5, Band Attributes).  If your 
bands are very closely spaced, defining them in brackets mode gives you greater 
control for more precise band definition. It also allows you to define overlapping 
bands.

5.3.a Identifying Individual Bands

With the bands displayed as brackets, select Create Band from the menu or toolbar, 
then click on either the top or bottom boundary of the band in the gel. An intensity 
trace of the lane will pop up next to the band.

Drag the cursor until the area of the band that you want to define—represented by the 
peak on the intensity trace—has been completely enclosed. The area of defined band 
will be highlighted on the trace.
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Fig. 5-7. Creating a band with brackets displayed.

When you release the mouse button, brackets will enclose the band on the image.

With the bands displayed as lines, select Create Band from the menu or toolbar, then 
click on the center of the band of interest. A line will appear in the center of the band.

Fig. 5-8. Creating a band with lines displayed.

Note: After you have identified several bands, renumber the bands by selecting Sort 
and Recalculate from the Edit menu.
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5.3.b Adjusting Bands

To reposition a band’s boundaries, select Adjust Band from the menu or toolbar. If 
the bands are displayed as brackets, drag the upper or lower bracket of the band. If the 
bands are displayed as lines, drag near the upper or lower boundary of the band that 
you want to adjust.

When you drag the band boundary, a pop-up lane trace will appear, and the area of 
defined band will be highlighted on the trace. Drag the band boundary to the correct 
position.

5.3.c Deleting Bands

To undetect a band, select Remove Band from the menu or toolbar and click on the 
band. If the bands are displayed as brackets, a trace of the band will be displayed and 
a pop-up box will ask you to confirm the action. If the bands are displayed as lines, 
the band line will simply be deleted.

If the bands are displayed as lines, you can delete more than one band at a time. Select 
Remove Band, and drag a box around the bands to be removed.

If you undetect a band, it will no longer be counted as a band, but its intensity will still 
contribute to the total lane intensity.

Note: After you undetect bands, renumber the bands in the image by selecting Sort and 
Recalculate from the Edit menu.

5.4 Plotting Traces of Bands

Fig. 5-9. Plot Band and Bands in Lane buttons.

Plot Band displays an intensity profile of a band. Select the command from the menu 
or toolbar and click on the band of interest.
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Bands in Lane displays an intensity trace of a lane with the defined bands 
highlighted. Select the command from the menu or toolar and click on the lane of 
interest.

Fig. 5-10. Bands in Lane command.

5.5 Band Attributes
You can display different types of information about defined bands. Select Band 
Attributes from the Band menu or toolbar to open the dialog.
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Fig. 5-11.  Band Attributes dialog.

At the bottom of the dialog, select how you want to mark defined bands on the 
image—as Brackets or Lines. Lines are usually easier to read than brackets in gels 
with closely packed bands, while brackets are better for displaying and editing the 
boundaries of bands.

You can also select the band data to display on the image next to each band:

• None.

• Band number—The sequential number of a band in lane, as counted from the 
top of the lane.

• Relative front—The distance of a band from the top of its lane, divided by the 
total length of the lane. The lane length can be determined either by measuring a 
vertical line from the top of the lane to bottom or (if the lane is curved) by 
measuring along the length of the lane. Set the preferred measuring method in the 
Preferences dialog (see section 2.5.e, Application).

Note: Note that normalized Rf is derived from relative front; however, normalized Rf is 
calculated only for bands that have been modeled using standards or band sets, 
and can change based on the modeling.

• Molecular Weight/Isoelectric Point/Base Pairs/other units—This value is 
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determined by the type of standards defined for the gel, the band’s position in the 
lane, and any modeling performed on the gel (using band matching or multiple 
lanes of standards) to compensate for gel distortion or smiling.

• Peak density—The intensity value of a band peak.

• Average density—The total intensity of the rows of pixels used to generate the 
profile of a band, divided by the number of rows.

• Trace qty—The quantity of a band as measured by the area under its intensity 
profile curve. Units are intensity x mm.

• Relative qty—The quantity of a particular band as measured by its intensity, 
expressed as a percentage of either the total intensity of all the bands in the lane 
or the total intensity of the lane (including the areas between bands). The 
calculation method (% of Lane or % of Bands in Lane) is set in the Preferences 
dialog (see section 2.5.e, Application).

• Gauss Peak Density—The intensity value of a band’s Gaussian peak (after 
Gaussian modeling).

• Gaussian Trace Quantity—The quantity of a band as measured by the area 
under its Gaussian-fitted profile.

• Contour qty—The quantity of a band that has been identified using the Contour 
or Draw Band tools. It is the sum of the intensities of all the pixels within the 

band boundary multiplied by the area of each pixel. Units are intensity x mm2.

• Contour area—The area (in mm2) inside the boundary of a band that has been 
identified using the Contour or Draw Band tools.

• Calibrated qty—The quantity of a band as calculated from the trace quantity 
and quantity standards. (Note that this is different than quantity determined using 
volumes.) Units are user-defined.

• Normalized qty—The trace quantity of a particular band expressed as a 
percentage of the quantity of a selected band type that is present in the same lane.

• Band type—The band type number of a band that has been matched and placed 
in a band set.

• Band model—Displays the modeling lines across the gel that are generated by 
band matching, standards, or both. These lines are used to compensate for gel 
distortion or smiling.

• Tandem repeats—The number of repeated base-pair units in a band that has 
been analyzed using the VNTR Calculations function (see section 11.2, Variable 
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Number Tandem Repeats).

• Differential Display—If the band types have been normalized, this displays 
trends in increasing or decreasing expression of a band type across a gel based on 
its normalized quantity.

5.6 Band Information
The Band Information dialog displays information about each defined band. Select 
Band Information from the Band menu and click on a band.

An intensity profile of the band’s lane will be displayed with the the selected band 
highlighted, and the dialog will open.

Fig. 5-12. Band Information dialog.

The lane and band number of the band you clicked on are listed at the top of the 
dialog. Enter new numbers in these fields to display information for a different band.

The band set and band type will be listed, if known. Other information includes:
5-16



Chapter 5. Bands
• Relative front—The distance of the band from the top of its defined lane, 
divided by the total length of the lane. The lane length can be determined either 
by measuring a vertical line from the top of the lane to bottom or (if the lane is 
curved) by measuring along the length of the lane. Set the preferred measuring 
method in the Preferences dialog (see section 2.5.e, Application).

Note: Note that normalized Rf is derived from relative front; however, normalized Rf is 
calculated only for bands that have been modeled using standards or band sets, 
and can change based on the modeling.

• Molecular Weight/Isoelectric Point/Base Pairs/other units—This value is 
determined by the type of standards defined for the gel, the band’s position in the 
lane, and any modeling performed on the gel (using band matching or multiple 
lanes of standards) to compensate for gel distortion.

• Peak density—The intensity value of the band’s peak.

• Average density—The total intensity of the rows of pixels used to generate the 
profile of the band, divided by the number of rows.

• Trace qty—The band quantity as measured by the area under its intensity profile 
curve. Units are intensity x mm.

• Gauss Peak Density—The intensity value of the band’s Gaussian peak (after 
Gaussian modeling).

• Gaussian Trace Quantity—The band quantity as measured by the area under its 
Gaussian-fitted profile.

• Contour qty—The quantity of a band that has been defined using the Contour 
or Draw Band tools. It is the sum of the intensities of all the pixels inside the 

band boundary multiplied by the area of each pixel. Units are intensity x mm2.

• Relative qty—The quantity of a band as measured by its intensity, expressed as a 
percentage of either the total intensity of all the bands in the lane or the total 
intensity of the lane (including the areas between bands). The calculation method 
(% of Lane or % of Bands in Lane) is set in the Preferences dialog (see 
section 2.5.e, Application).

• Normalized qty—The trace quantity of the band expressed as a percentage of 
the quantity of a selected band type that is present in the same lane.

If the quantity of the band is known, you can enter the quantity and units next to the 
Quantity/Units prompt.
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To calibrate the band against known quantities, click on the Calibration button and 
select the calibration curve. (See section 6.3.a, Creating and Applying a Set of 
Quantity Standards, for information on calibration curves.)

5.7 Gauss-Modeling Bands
If the bands are closely spaced or overlapping, Gaussian modeling can provide more 
accurate quantitation than regular band detection.

Gaussian modeling “fits” a Gaussian curve to each band profile and calculates band 
quantity from the area under the curve. Since the profile of a well-resolved, distinct 
band conforms to the shape of a Gaussian curve, this creates a band profile that is as 
close to ideal as possible.

Fig. 5-13. Profiles of two overlapping bands, before (top) and after (bottom) Gaussian mod-
eling. Modeling better resolves the band quantities.

Before:

After:
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For a band that overlaps with an adjacent band, Gaussian fitting provides the best way 
to resolve the area that overlaps. (This quantity would be lost with conventional band 
detection.)

Note: Gaussian modeling requires little or no background in lanes. Subtract lane 
background using the Lane Background command (see section 4.2, Lane-Based 
Background Subtraction) prior to modeling. Also, high-resolution images require 
significantly more time to model. To reduce image resolution, use the Reduce 
File Size command (see section 2.2.f, Reduce File Size).

To model bands using Gaussian fitting, first detect the bands, then select Gauss-
model Bands from the Band menu.

Note: Gaussian modeling will not create bands or eliminate detected bands. It will 
simply apply a Gaussian curve to the profiles of detected bands.

In the pop-up box, select All to model all lanes, or One to model a single lane. If you 
select One, type the number of the lane in the field. 

Fig. 5-14. Gauss-model Bands dialog.

Click on OK. A status box will display the progress of the modeling.

Reviewing the Results

Bands that have been Gauss-modeled will appear as normal bands in the image. To 
view the results of Gaussian fitting, magnify a few bands in a modeled lane using the 
Zoom Box tool, then select Bands in Lane or Plot Band from the Band menu and 
click on the lane.

Plot Band displays the Gaussian curve superimposed on the profile of the selected 
band. Bands in Lane displays the Gaussian profiles of all the bands in the lane, as 
shown in Fig. 5-13.
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The Band Information dialog displays information about the Gaussian peak and trace 
quantity for modeled bands that you click on. In the dialog, you can compare the 
Gaussian values to the regular band detection values.

These quantities can also be displayed in the Lane Report and All Lanes Report.

Note: The quantities determined by Gaussian fitting cannot be used to in conjunction 
with Quantity Standards (see section 6.3, Quantity Standards). However, you 
can use the original trace quantities in calculating Quantity Standards after you 
have Gauss-modeled the bands.

Adjusting Bands in a Gauss-modeled Lane

If you use any of the individual band commands—Create Band, Delete Band, 
Adjust Band—in a lane that has been Gauss-modeled, the modeling will be 
automatically removed from that lane. The Gaussian models in a lane are 
interdependent, so changing a single band invalidates the modeling. After you have 
adjusted the bands, you can remodel the lane.

Incorrect Modeling

The Gauss-model Bands command will try to model all the bands in the selected 
lanes. Carefully review the results of modeling using the Plot Band, Bands in Lane, 
and Band Information commands as described above.

If the Gaussian curve does not adequately conform to the profile of a band, or if the 
Gaussian peak and trace quantities differ greatly from the normal peak and trace 
quantities in the Band Information dialog, it may be because there is too much lane 
background. Use the Lane Background command with a smaller rolling disk size to 
remove more background, then remodel the lane.

If Gaussian modeling does not work well with the bands in the image, simply remove 
the modeling. To remove the modeling from a particular lane, select Remove One 
Gauss-model from the Band menu and click on the lane. To remove the modeling 
from all lanes, select Remove All Gauss-models.

Removing Gaussian modeling will not affect band detection.
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5.8 Irregularly Shaped Bands in Lanes
If some bands in lanes are irregularly shaped, you can use the contour or drawing 
features to define them. These functions give you more control over defining bands 
than either Detect Bands or Create Bands.

Note: These tools are similar to the Volume Contour Tool and the Volume Freehand 
Tool, except that they are lane-dependent. To quantify objects without defining 
lanes, see Chapter 7.

Contoured or hand-drawn bands are quantitated based on the signal intensity of all the 
pixels within the band boundary, using the following formula:

Quantity = Sum of the intensity of a pixel x pixel size for all the pixels in 
the boundary.

The intensity of a pixel is multiplied by the area of the pixel. This is done for all the 
pixels within the contour or drawn boundary. The area of the pixel is determined by 
the resolution of the image.

The resulting values have units of intensity x mm2.

Fig. 5-15. A contoured band scanned at 100 x 100 micrometers.

0.1 mm
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1 

m
m

Contoured/drawn band showing individual 
pixels with different intensities.

One pixel enlarged to 
show dimensions.
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The commands for contouring and drawing bands are located on the Contour 
submenu and Draw Band submenu of the Band menu, and on the Contour Tools 
toolbar.

Before using these commands, magnify the image so that the individual pixels in the 
band are clearly visible. This allows you to position the cursor more accurately.

5.8.a Contouring Bands

Fig. 5-16. Contour tools.

Creating Contours

Select Create Contour from the Band > Contour submenu or toolbar and click on a 
pixel at the edge of the band. This displays a contour that encloses pixels whose 
intensity is equal to or greater than that of the pixel at the cursor. 

Fig. 5-17. Creating a Contour

If the contour does not encircle the band, reposition the cursor and click again. A new 
contour will be drawn in place of the old.

Contour encloses pixels
with intensities greater 
than or equal to intensity
of pixel at cursor 
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Contour Information

To display information for the selected contour, select Contour Information. A pop-
up box will show the area, total intensity, and average intensity.

Converting a Contour into a Band

When you are satisfied with the contour, select Contour to Band from the menu or 
toolbar to redefine the contour as a band and assign it to the nearest lane.

Note: Before you can convert a contour into a band, you must define the lane 
containing the band.

The contour boundary will change color from yellow to red, and a band line will 
appear on the nearest lane.

Note: Gaussian modeling and the Plot Band command do not work on contoured 
bands.

To list areas and quantities of contoured bands in reports, select the Contour Area 
and Contour Qty report formatting options. Display this information on the image 
using the Band Attributes dialog.

5.8.b Drawing Tools

Fig. 5-18. Drawing tools.

Density in Region

Density in Region displays intensity information for any area on an image.
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Select Density in Region from the Band > Draw Band submenu or Contour Tools 
toolbar, and use the cursor to draw a line around a region of interest. 

Fig. 5-19. Density in Region tool.

When you close the border, a pop-up box will display information about the enclosed 
area. For very small regions, magnify the region before using this command.

Drawing Band Boundaries

Note: To use the drawing tools, at least one lane must be defined on the image. Also, 
magnify the region you want to draw in using Zoom Box.

Use Draw Band Boundary to draw the boundary of a band manually. Select the 
command from the Band > Draw Band submenu or Contour toolbar, and drag the 
cursor around the region that you want to define as a band. A boundary line will 
appear.

Fig. 5-20. Draw Band Boundary tool.

If you make a mistake and need to retrace part of the band boundary, backtrack with 
the cursor; the path will be erased and you can redraw it.
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Note: Be sure to magnify the image before drawing a boundary. If you try to draw a 
very small boundary, the software will think that you are backtracking and erase 
the boundary.

When the cursor crosses the line, the color of the line will change to indicate that it is 
a band boundary, and a band line will appear on the nearest lane.

If you keep drawing, each time the line crosses itself a new band will be created, 
replacing the old band.

Note: Gaussian modeling and the Plot Band command do not work on drawn bands.

To list areas and quantities of drawn bands in reports, select the Contour Area and 
Contour Qty report formatting options. Display this information on the image using 
the Band Attributes dialog.

Editing Band Boundaries

To change a drawn band boundary, select Edit Band Boundary from the Band > 
Draw Band submenu or Contour toolbar and drag the cursor across the previously 
defined boundary. A line will appear. When you recross the old boundary, the line will 
change colors and the new boundary will be created.
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6. Standards and Band 
Matching

After you have defined the lanes and bands in a gel, you can identify the standard 
lanes, enter the values of the standards, and determine the values of the experimental 
bands using those standards. You can also compare sample similarity by matching 
bands across lanes.

Finally, you can identify bands of known quantity and use these to generate a 
calibration curve for quantitating unknown bands.

These tools are found on the Match menu and Match Tools toolbar.

Fig. 6-1. Standards and matching tools.

6.1 Standards
If your gel includes lanes of standards, you can enter the values of the standards and 
automatically calculate the values of the unknown bands in the gel.
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Note: In general, the more standard lanes in a gel, the greater the accuracy of the 
calculated band values. We recommend a minimum of two standard lanes per gel. 
Also, the modeling algorithm works best with standard lanes spaced evenly 
across the gel, as shown in the following figure. Multiple standard lanes also 
facilitate comparisons of sample similarity.

Fig. 6-2. Standard lanes as defined on a gel image.

With the image open and lanes and bands defined, select Standards from the Match 
menu or toolbar. A dialog will open, listing any saved standards as well as predefined 
Bio-Rad standards. 

Standard LaneStandard Lane Standard Lane
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Fig. 6-3. Selecting a set of standards.

Sets of Bio-Rad molecular weight and base pair standards are installed with the 
software.

6.1.a Selecting Predefined Standards

If you are using Bio-Rad or other predefined standards, select them from the pop-up 
list. The Standards dialog will open (see section 6.1.c, Standards Dialog), displaying 
the values of the standards.

6.1.b Creating New Standards

To create a new set of standards, select New Standards. A dialog will pop up in 
which you can specify the units.
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Fig. 6-4. Specifying units.

Click on the Units button to specify the units. This opens a dialog in which you can 
select from a list that includes Base Pairs, Isoelectric Point, Molecular Weight, and 
Normalized Rf.

Note: Rf (relative front) expresses the distance a band has traveled down a lane as a 
fraction of either the total length of the lane or the vertical distance from the top 
of the lane to the bottom (the calculation method can be specified in the 
Preferences dialog).This provides a generic measure of the positions of bands in 
lanes. Normalized Rf is derived from relative front, and includes the results of 
modeling across the gel that comes when multiple lanes of standards are defined 
on the image. Such modeling is designed to take into account any distortion or 
smiling across a gel.

To specify a set of units not on the list, click on the New button and specify the unit’s 
parameters in the dialog. To edit a set of units, select them and click on Edit.
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Fig. 6-5. Units dialog.

Note: “Ascending” means that bands of higher molecular weight or isoelectric point are 
at the top of the gel image, and bands of lower molecular weight or isoelectric 
point are at the bottom of the gel image.

To select a set of units, select them from the list and click on Select, then click on 
OK. The Standards dialog will open. Here you can enter values for the standards, 
apply them to the bands on the image, and save them as a set for future use.

6.1.c Standards Dialog

The Standards dialog contains the values of the standards, and includes tools for 
applying them to the standard lanes in the image and displaying and adjusting the 
standards regression curve.

The dialog opens with a default name for the standards. For new standards, this is a 
generic name (e.g., Standards 1). You can enter a new name in the field.
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Fig. 6-6. Standards dialog.

You can enter additional information next to the Comment prompt. The <category> 
buttons and fields can be used to further define the standards.

Entering Standard Values

If you are creating new standards, enter the values of the standard bands in the table in 
the middle of the dialog. Predefined standards already have these values entered.
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Fig. 6-7. Entering the values of the standards.

The table has three columns, labeled Type, Name, and the units you previously 
selected (e.g., KDa, pI, Rf). In the units column, type a value for the first standard 
band and press the Enter key. The cursor will skip to the field below, and you can 
enter a value for the second standard band. Repeat this process until all the standard 
values have been entered.

Note: The values do not need to be entered sequentially. They will automatically sort 
themselves in ascending or descending order, depending on how you specified 
the units.

You can enter a name for each standard band in the Name column. This will appear in 
subsequent reports and printouts.

To remove a standard value, click on the triangle button at the beginning of the row 
and select Delete. The remaining standards will be renumbered.

Applying Standard Values to Lanes

To apply the values to the standard lanes on the image, click on the Apply to Lane 
button and click on a lane. 

Standard value
Click here to delete
a value and
renumber the 
remaining standards
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Fig. 6-8. Click on the Apply to Lane button and click on the lanes containing standards.

The values will be applied to the bands in the lane you select. Click on any remaining 
standard lanes to apply the same values to them.

Note: In general, the more evenly spaced the standard lanes, the greater the accuracy of 
the calculated band values. We recommend a minimum of two standard lanes per 
gel. Modeling lines that connect the standard bands in different lanes are used to 
compensate for any smiling or distortion across the gel. 

You can also click on the Arrow button next to a standard value to apply that value to 
a particular band in a lane on the image. Click on the button, then click on the 
standard band. The remaining bands in the lane will be numbered sequentially based 
on the initial assignment.
6-8



Chapter 6. Standards and Band Matching
Fig. 6-9. Applying a single standard value.

After you have applied the standard values to a lane, the bands in that lane will 
change color to blue, indicating that they are now standards.

You are now ready to select the standards regression curve to use for calculating the 
unknowns.

Removing Standard Values from Lanes

The Clear from Lane command removes all the standard values from the lane(s) you 
select. Click on the button, then click on the lane or lanes from which you want to 
delete the standard values.

Showing the Modeling Lines

Click on the Show Modeling Lines button in the Standards dialog to display lines 
across the gel connecting the same standard bands in different lanes. Unknown bands 
that fall along these lines  have the same values as the standards.

To redisplay only the band numbers with no modeling lines, click on the Show Band 
Types button.

6.1.d Standards Regression Curve

After you have applied the standard values to the image, you are ready to select the 
regression model to use to calculate the values of the unknown bands. (Note: You 
must apply the values to a lane before you can view and adjust the regression curve.)

Click here to apply
this standard value
to a particular band
on the image
6-9



Quantity One User Guide
Click on the Standard Curve button in the Standards dialog, then click on a lane. A 
graph of the standards regression curve is displayed on the image, and the Standard 
Curve Options dialog is displayed as well.

Fig. 6-10. Displaying the standard curve and options dialog.

As you click on different lanes, the curve is displayed for each lane in turn. The X 
axis is the standard value and the Y axis is the Rf value.

Use the Std Curve Options dialog to change the regression model for the curve, as 
well as various display options.

Standards Regression Models

Select different regression models in the Std Curve Options dialog while you study 
the standard curve with the standard points displayed. Then choose a curve that best 
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fits the data points. (The correlation coefficient provides another measure of curve 
fit.)

Note: Note that point-to-point semi-log is the only method available if you perform 
band matching on the image, because band matching adjusts the positional values 
of bands in localized areas based on your identification. Point-to-point semi-log 
is appropriate for this kind of localized variation, whereas the other methods are 
not. Therefore, you should select point-to-point semi-log if you intend to perform 
band matching (required for similarity analysis) on the gel.

Point-to-point semi-log. This and the Elder-Southern method are especially useful 
for describing band migration in static-field electrophoresis gels. This is the only 
method available if you perform band matching on the image (see note above).

Elder-Southern.  This and the point-to-point semi-log method are especially useful 
for describing band migration in static-field electrophoresis gels. At least three 
standard points are required to use this method.

Linear. This method of least-squares polynomial fits is useful for modeling pulsed-
field electrophoresis gels.

Quadratic. At least three standard points are required to use this method of least-
squares polynomial fits.

Cubic. At least four standard points are required to use this method of least-squares 
polynomial fits.

Logistic. At least five standard points are required to use this method of nonlinear 
least-squares curve fitting.

Cubic-Spline. At least five standard points are required to use this beta-cubic-spline 
method.

Display Options

The following options will change how the curve graph is displayed:

Show Standard Points displays the standard data points on the graph.  The standard 
points in that lane will be marked on the graph as triangles. Note that known band 
types will appear marked as standards.
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Show Calculated Points displays the calculated points on the graph. The calculated 
points in the lane will be marked on the graph as circles.

Perform Log Transform changes the shape of the curve from linear to log. This will 
not change the calculated values.

Show Numerical Data of Points displays the value of each band on the graph next to 
its corresponding point.

Display Correlation Coefficient displays the correlation coefficient for the linear, 
quadratic, and cubic regression models.

Note: The correlation coefficient is a measure of how well the regression model fits the 
data. It is the square root of the proportion of total variation that can be explained 
by the regression model. A correlation coefficient of 1.000 would indicate 100 
percent certainty of fit.

6.1.e Displaying Calculated Values

To view the calculated values of all the bands in the gel image, select Band 
Attributes from the Band menu, then select the value to be displayed (molecular 
weights, base pairs, etc.). Values can be displayed and printed in report format using 
the lane and match reports on the Reports menu.

6.1.f Saving, Opening, and Deleting Standards

Standards are saved with the image; you can also save copies of them in a separate 
archive that is available to all images.

To save the standard values with the image, click on the Close button to close the 
Standards dialog, then save the image. When you open the image again, the standards 
will be available when you select Standards.

To save these standards for use on other images, click on the Archive button. The 
standards will be saved in an archive file separately from the image.

To use a set of archived standards, open any image, then choose Standards from the 
menu or toolbar and select the archived standards. They will be imported into the 
image.
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To delete a set of standards you have created, open them, then click on the Delete 
button at the bottom of the dialog. A pop-up box will ask you to confirm that you 
want to proceed with the deletion before completing the action. This will delete the 
standards from both the image and the archive.

To modify a set of standards you have created, open them, make your changes, then 
save the image and (if desired) archive the new standards.

Read-Only Standards

You can make archived standards read-only. Read-only standards cannot be deleted 
from or modified in the archive using the methods described above; they can still be 
deleted from or modified in the image.

To make standards read-only, insert a tilde character (~) in front of the name of the 
standards, then click on the Archive button. These standards will always be available 
under that name in the list of standards.

All Bio-Rad standards are read-only.

Disabling/Deleting the Archive

To delete the archived standards (including Bio-Rad standards), remove the 
oneprefs.dbs database from the fixed.prm folder on your hard drive. Under 
Windows, this folder is located in the Bio-Rad/Program Files/The Discovery Series 
directory. On the Macintosh, this file is located in The Discovery Series folder in the 
Preferences folder in the System Folder.

After you remove this file, a new, empty oneprefs.dbs database will be automatically 
created the next time you open an image. You can use this to begin a new archive.

6.2 Band Matching
To compare the similarity of samples in a gel (using the phylogenetic tree, similarity 
matrix, etc.), you must match bands across lanes using the commands on the Match 
menu and toolbar.
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Note: If you have run standards on the gel, you should define them before proceeding 
as described in the previous section. Multiple lanes of standards will facilitate the 
band matching program; however, they are not required.

Fig. 6-11. Matching tools.

Select Match from the menu or toolbar and click on a representative experimental 
lane in the gel image. This may be a lane that contains most or all of the bands that 
you are interested in, and/or a lane in which the bands are particularly well-resolved. 
Each band in this lane will be designated as a different “band type.”

Note: If you have defined standards in the gel, a pop-up box will warn you that the 
regression model for calculating band values will be restricted to point-to-point 
semi-log. If you selected a different regression model when defining standards, it 
will be changed.

The first time you click on an experimental lane with the Match command, a pop-up 
box will prompt you to specify the matching tolerance.
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Fig. 6-12. Query box: Apply matching to the whole lane?

Tolerance is the minimum spacing that the matching model expects to find between 
unique bands. It is expressed as a percent of lane height. You can enter a value 
between 0.2 and 10 percent. If the bands are very close together, enter a tolerance of 
2.5 percent or less.

After you select a tolerance, click on Yes to automatically match all bands across the 
lanes. (Click on No to match only the specific band you clicked on.)

When you click on Yes, the bands in the lane you selected will change to green, 
indicating that they are known band types that have been identified by you. A band 
type number will appear next to each band.

The automatic matching mechanism will attempt to match the bands in the other lanes 
to the known band types. Matched bands are labeled in red, with the number of the 
band type appearing next to each band. These matched bands are connected by 
modeling lines.

Yellow bands are bands that the software cannot accurately match. The matching 
algorithm is deliberately conservative to avoid incorrect labeling, so a number of 
yellow bands may appear on the image.

Your next step will be to identify the yellow bands as either new band types, or 
existing band types that could not be automatched.

To summarize:

• Green bands are known band types.
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• Red bands are bands that have been automatically matched with the known band 
types.

• Yellow bands are bands that have not been matched and are unclassified.

Displaying Band Types and Modeling Lines

To display the band type numbers on the image, select Show Band Types from the 
Match menu or toolbar.

Band type modeling lines reveal the path along the gel image that the software uses to 
match bands of the same type in different lanes. These lines are based on the positions 
of the known (green) bands and any standards you may have defined.

To display the band type modeling lines, select Show Band Models from the Match 
menu or toolbar.

6.2.a Editing the Results of Band Matching

After you have matched bands automatically, you can manually indentify the 
remaining unknown bands as new or existing band types. Use the tools on the Match 
menu and toolbar to manually identify new bands, unmatch bands, or identify bands 
as outliers from the band set.

Note: The modeling lines are designed to give you guidance on identifying new bands.

• To identify an unknown (yellow) band as a new band type, select Match and 
click on the unknown band. 

• To match a band to a particular band type, select Match and first click on the 
identified red or green band. Then click on the red or yellow band you want to 
match. The band will appear green (known) and the modeling line will change to 
reflect the match. 

• If a matched (red) band in a lane is in fact a new band, select Match, hold down 
the Shift key, and click on the red band.

• To change a matched band to unknown (yellow), select Unmatch and click on 
that band.

• To remove a green band from the modeling, select Outlier and click on that 
band. An X will appear through the band, indicating that the software is ignoring 
it when auto-matching bands across the gel image.
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Manually match bands until all the bands in the image are identified. The gel should 
have no yellow (unknown) bands, and the modeling lines should intersect at or near 
the middle of the bands across the gel. If the modeling lines are not parallel, the lanes 
may be warped or distorted and thus difficult to compare using the automatic analysis 
features.

6.2.b Band Set Dialog

The Band Set dialog contains the values of all the experimental bands in a gel, a tool 
bar for band matching, and other information about the bands.

To open the dialog, select Matched Band Set from the Match menu or toolbar and 
click anywhere on the image.

The dialog will open with a default name for the band set (e.g., Band Set 1). Enter a 
new name at the top of the dialog, and add any comments or category/attribute 
information you want to associate with the band set.
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Fig. 6-13. Band Set dialog.

List of Band Types

The values of the individual bands are listed in the dialog. These values are based on 
any standards you have defined and the band matching. If you have not defined 
standards, normalized Rf units are used.
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Fig. 6-14. Applying and editing band type values.

If you change any of the values in the list, that will be reflected in the matching on the 
image.

Click on the numbered Arrow button next to a band value and click on a band in the 
gel to identify that band.

You can enter names for the band types in the Name column. These will appear in 
subsequent reports and print-outs.

To remove a band from the set, click on the triangle icon next to the band value. 
Confirm the deletion, and the remaining band types will be renumbered.

Band Set Toolbar

The toolbar in the Band Set dialog contains all the commands needed for matching.

Assign band type to

Delete band type

the mouse

Band type value
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Fig. 6-15. Band set toolbar.

Apply to Lane applies the values in the band set to any lane in the gel. Click on the 
button, then click on the lane. The bands in that lane that can be matched will change 
to red.

Clear from Lane removes the identified values from any lane in the gel. Click on the 
button, then click on the lane to be cleared. The bands in the lane will change to 
yellow.

Create Band and Remove Band are standard band commands that have been 
included in the toolbar for convenience (see section  5.3.a, Identifying Individual 
Bands).

Match is used to identify a new band. Click on the button, then click on the unknown 
(yellow) band to identify it and add it to the set.

Unmatch removes the identification of a band. Click on the button, then click on the 
matched band to change it to unknown.

Propagate Band Set applies all the values in the set to the bands in a lane, based on a 
few identified bands in the lane. Click on this button, then click on the lane. The 
bands in that lane that can be matched will change to green to indicate their known 
status.

Outlier excludes a known (green) band from the band set model. However, the band 
will still be marked as known.

Show Band Types displays all the red, green, and yellow bands on the image, with 
the band type numbers next to the matched bands.

Show Band Models displays the modeling lines across the gel image.

Apply to Lane

Clear from Lane

Create Band

Remove Band

Match

Unmatch

Propagate Band Set

Outlier Show band types

Show band models

Standard curve
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Standard Curve displays the Standards Regression Curve (see section 6.1.d, 
Standards Regression Curve). Click on the button, then click on any lane in the image.

Other Band Set Functions

The units of the bands are displayed in the top half of the dialog, as is the matching 
tolerance used. Tolerance is the minimum spacing between unique bands that you 
specified when you created the band set.

The Normalization button allows you to pick a specific identified band that appears 
in all the lanes to normalize the relative quantities of the other bands against (see 
section 11.1, Differential Display for more information).

Click on the resize button in the lower right corner to reconfigure the dialog to its 
smaller, palette version, which displays only the tool buttons and band type buttons.

To delete the band set, click on the Delete button.

To close the band set, click on OK.

Note that the band set is saved when you save the image.

6.2.c Tips for Gels Without Standards

If you are not using standards, we recommend that you load at least two lanes per gel 
with a reference sample containing many if not most of your experimental bands of 
interest.

Select the Match command from the menu or toolbar, and click on this reference 
sample lane to create a new band set. Then select Matched Band Set from the Match 
menu to open the Band Set dialog, and apply that band set to other reference sample 
lanes using the Propagate Band Set command.

Propagate Band Set is a feature that not only simplifies identifying bands, it allows 
the software to do some optimizations that will significantly speed up modeling. 
Choose another reference sample lane that you want to apply the band set to. Start by 
using the Match command to identify one or two bands in the lane, then click on the 
Propagate Band Set button and click on the lane to assign the remaining band types 
to the lane.
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Once the reference sample lanes have been modeled, identify any unknown bands 
using the methods outlined in the previous sections.

6.2.d Normalizing for Quantity

You can normalize the quantities of the bands in a gel to the quantity of a particular 
identified band that appears in all lanes. This is useful if you have loaded different 
amounts of sample in each lane.

Note: Quantity normalization is required for calculating Differential Display.

Select Normalize from the Match menu and click on a matched band that appears in 
every lane. (If the band is not present in a lane, the normalized quantity for that lane 
will be zero.) The quantity of that band will be set to 100 in each lane, and the 
quantities of the other bands will normalized to that band.

You can view the normalized quantities using the Band Attributes dialog or in various 
reports.

6.2.e Graphs of Match Data

You can display graphs of different kinds of data associated with the matched bands. 
The commands for displaying these are located on the Match > Match Graphs 
submenu.

Fig. 6-16. Match Graphs submenu.

From the Match Graphs submenu, select a type of graph and click on a matched band. 
The bands in the matched group will be displayed along with the selected graph.
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Fig. 6-17. Example of a match graph.

• Average displays a histogram of the average densities of the bands in a band 
type.

• Calibrated Quantity displays a histogram of the quantities of the bands in a 
band type as calculated from a calibration curve (see section 6.3, Quantity 
Standards).

• Contour displays a histogram of the intensity of each contoured band in a band 
type. This function only works with contoured bands.

• Normalized Quantity displays a histogram of the normalized quantities of the 
bands in a band type. See section 6.2.d, Normalizing for Quantity, for 
instructions on how to normalize for quantity.

• Peak displays a histogram of the peak intensities of the bands in a band type.

• Relative Quantity displays a histogram in which each bar represents the quantity 
of the band in a lane as a percentage of either (1) the total intensity data in the 
band’s lane, or (2) the total intensity of all the bands in the band’s lane. The 
calculation method (% of Lane or % of Bands in Lane) is set in the Preferences 
dialog.

• Trace displays a histogram of the trace quantities of the bands in a band type 
group.
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Each bar of the histogram is labeled on the X axis with the lane number, and (where 
space permits) the band number. The Y axis is labeled with quantitative values. If the 
bands in the match group span the entire image window, the histogram will not 
include bars for the bands in the left-most lanes because of the space required for 
labeling the axis. 

To avoid this problem, decrease the size of the image using Zoom Out until there is 
blank space between the left side of the window and the first band of the match group. 
Redisplay the histogram. If one or more bars are still not included, continue 
decreasing the magnification until you can see all the data.

6.3 Quantity Standards
From bands of known quantity, you can generate a calibration curve for determining 
the quantities of all the bands in lanes or cells in lane-based arrays. (To quantitate 
bands outside of lanes, see Chapter 7.)

Using the Quantity Standards dialog, you plot the quantities of the known bands 
against their intensities to generate a calibration curve. You then apply this curve to 
unknown bands in the current gel as well as other gels.

To create a calibration curve, the quantities of at least two bands must be known. The 
greater the number of known bands and the wider the range of their values, the more 
accurate the calibration curve will be.

Note: The band intensities calculated by Gaussian fitting (see section 5.7, Gauss-
Modeling Bands) cannot be used in conjunction with Quantity Standards. 
However, you can continue to use the trace intensity (i.e., the area under a band’s 
intensity profile) to calculate Quantity Standards after you have Gauss-
modeled your bands.

6.3.a Creating and Applying a Set of Quantity Standards

Select Quantity Standards from the Analysis menu. A pop-up box will prompt you 
to create a new curve or load a saved calibration curve.
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Fig. 6-18. Loading a quantity calibration curve.

Select Create New to open a blank Quantity Standards dialog.

Fig. 6-19. Quantity Standards dialog.

The dialog will open with a default name for the quantity standards (e.g., Cal 1). 
Enter a new name, specify the quantity value units (e.g., µg), and enter any 
descriptive information in the appropriate fields at the top of the dialog. 
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The calibration curve is generated by plotting the quantities versus the intensities of 
the known bands. The intensities of the bands can be measured in several different 
ways. Click on the Measure button to display a list.

Fig. 6-20. Band attributes to measure for relative quantity.

The options in the Measure dialog are:

• Trace density—The intensity of a band as measured by the area under its 
intensity profile curve. Units are intensity x mm.

• Contour density—The intensity of a band that has been defined using the 
Contour or Draw Band tools (see section 5.8, Irregularly Shaped Bands in 
Lanes). It is the sum of the intensities of all the pixels inside the band boundary 

multiplied by the area of each pixel. Units are intensity x mm2.

• Peak density—The intensity value of a band’s peak.

• Average density—The total intensity of the rows of pixels used to generate the 
profile of a band, divided by the number of rows.

Identifying the Known Bands in the Gel

The dialog includes three buttons that can be used to select the known bands in the 
gel:

• To select bands one at a time, click on the Band button, then click on each band 
of known quantity. Each band will be highlighted.

• If all of the known bands are the same band type, click on the Match button, then 
click on one of the bands. The matched group of bands will be highlighted.
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• If all of the known bands are in one lane, click on the Lane button, then click on 
the lane with the known quantities. The entire lane will be highlighted.

Fig. 6-21. Buttons for selecting bands of known quantity.

In the lower part of the Quantity Standards dialog, the lane and band numbers of the 
selected bands will appear in the Band column. The intensity of each band will also 
be listed.

Entering the Quantities

Enter the quantity of each known band in the Quantity column. When you enter a 
quantity, the value of the band in the Status column will change from Unknown to 
Known.

Fig. 6-22. Entering the known quantities. 

After you have entered a few quantities, the status of the remaining bands in the list 
may change to O.R., meaning that the remaining bands are out of the current range of 
values (based on their intensities and what you have already entered).
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Alternatively, the software may automatically calculate an unknown quantity (if it is 
between two known quantities) and enter a value for it; in this case the Status column 
will indicate that the quantity has been calculated (Calc.)

In either case, you can type a quantity directly into the Quantity column and the 
status will change to Known.

Relative Deviation of Known Quantities

After three values have been entered, the relative deviations of those bands are 
automatically calculated and displayed in the Rel. Dev. column. The relative 
deviation is calculated from the known value that you entered and the back-calculated 
value from the calibration curve.

If the deviation value is too high, you can exclude a band from the calibration curve. 
Click on the arrow button next to the problem band. In the pop-up box, select 
Remove to remove the band from the Quantity Standards dialog. All the information 
about that band will be deleted.

Alternatively, select Outlier from the pop-up list to retain the information about the 
band in the calibration file but exclude it from the calibration curve.

6.3.b Calibration Curve

Interpolation and Extrapolation

There are two methods for calculating the calibration curve:

• Point to Point generates a curve in which each data point is connected directly to 
the next, regardless of the shape of the resulting curve.

• Linear Regression (using the method of Least Squares) generates a smooth 
curve that is the “best fit” of the values you provided.

Select the preferred option next to Interpolation in the dialog.

Next, indicate whether the curve should be extrapolated beyond the highest and 
lowest known values by selecting Yes or No next to the Extrapolation prompt. Note 
that values extrapolated from the Point to Point curve may be unreliable.
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Displaying the Calibration Curve

To display the calibration curve, click on the Show Curve button at the bottom of the 
Quantity Standards dialog. A graph of the known quantities versus measured 
intensities will be displayed in a separate window.

Fig. 6-23. Calibration curve with linear regression and extrapolation.

Known values used to calculate the curve are marked by circles. Values identified as 
outliers are marked by squares.

• To change the status of a point on the graph, click on it. The status will toggle 
between Known and Outlier.

• To display a legend at the bottom of the graph, click on Titles.

• To print the graph, click on Print.

• To close the graph window, click on Done.
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6.3.c Applying the Calibration Curve

After you have generated a calibration curve, you are ready to calculate the quantities 
of the unknown bands. Select a button next to Calibrate to calculate the quantity of 
an individual band, match, lane, or the entire gel.

Fig. 6-24. Buttons for calibrating bands of unknown quantity.

If you select Band, Match, or Lane, click on the button and then click on the object 
in the gel. Click on Gel to calculate the entire gel. Bands of calculated quantity are 
highlighted in the image.

Unapplying the Calibration Curve

To undo the quantity calculation for a band, match, lane, or gel, use the appropriate 
button next to Un-Calibrate.

6.3.d Generating Standard Bands via a Dilution Series

One way to generate bands of known quantity is to start with a stock solution and 
make several dilutions. Different dilutions can be loaded into different lanes, resulting 
in a dilution series.

Quantity One will calculate the values in a dilution series if you enter the known 
quantity and a dilution factor (e.g., for a solution that has been diluted to 10 times the 
volume, type 1/10 or 0.1).

In the Quantity Standards dialog, next to the band from the undiluted stock solution, 
enter the known quantity.

In the Dilution Factor column, type “stock.”

Next to the remaining bands in the series, enter the appropriate dilution factors in the 
Dilution Factor column.
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Fig. 6-25. Entering a dilution series.

The quantity of each band will be automatically calculated.

6.3.e Importing a Calibration Curve

A calibration curve created for one gel can be applied to other gels.

Make sure that the new gel you want to quantitate and the gel with the existing 
calibration curve are both open.

Click on the new gel to quantitate. Select Quantity Standards from the Analysis 
menu and click on Create New, as previously described.

In the new Quantity Standards dialog, click on the Import Curve button, and select 
the existing calibration curve from the list. When you make the selection, the values 
for the curve will be displayed in the new Quantity Standards dialog. Each standard 
value will be labeled Import in the Band column.

Checking the Imported Curve

If the quantity of one or more bands in the new image is known, you can verify the 
accuracy of the imported calibration curve. Go to Select in the Quantity Standards 
dialog, click on Band, then click on a known band. Its lane number, band number, and 
intensity will be displayed in one of the standard values fields.
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Fig. 6-26. Checking an imported calibration curve.

When you enter the band’s value, its status will change to Check, indicating that it is 
used to verify the accuracy of the calibration curve and is not used in calculating the 
curve itself.

Click on the Show Curve button to display the graph, and note that the Check bands 
are enclosed in diamonds. If the Check bands do not fall on or very near the 
calibration curve, we recommend that you do not use the imported standards for this 
gel.

Band used
to check
curve
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7. Volume Tools
You can use the Volume tools to quantitate bands, spots, arrays, and other image data.

What is a Volume?

A volume is the total signal intensity inside a defined boundary drawn on an image. 
To measure the amount of a particular object (e.g., a band or spot), you draw a volume 
rectangle, contour, free hand, or circle around the object and compare the intensity 
data inside the boundary with the data of other objects or a standard using the Volume 
Analysis Report and Volume Regression Curve (see section 12.6, Volume Analysis 
Report).

Volume = Sum of the intensities of the pixels within the volume 
boundary x pixel area

Volume units = intensity units x mm2

Volumes are similar to band contours (see section 5.8.a, Contouring Bands), except 
that they are not dependent on lanes and bands.

7.1 Creating a Volume
To create a volume, select Volume Tools from the main toolbar or the Edit menu. 
These commands are also located on the Volume menu.
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Fig. 7-1. Volume tools.

Note: When using any of the following tools, be careful to completely surround the 
data you want to quantitate. You should also adjust for background intensity (see 
section 7.6, Volume Background Subtraction). You may want to experiment with 
several different volumes drawn around the same object before selecting the one 
that gives you the best quantitation data.

Volume Contour Tool

Use the Volume Contour tool to quickly create a volume boundary that follows the 
outer edge of the object you want to quantify. To use this tool, first magnify the 
object, then click on the Volume Contour button. Using the tool:

• Click on a pixel at the edge of a band or other object to create a contour that 
encloses pixels of equal or greater intensity.

• Drag to create a contour that changes as you move over pixels of different 
intensity. Drag from inside the object outward until the contour follows the outer 
edge of the object. When you release the mouse button, the volume is created.
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Fig. 7-2. Volume contour.

The contour should completely surround the data you want to quantify.

To edit the contour, position the cursor on the border. The cursor will change to a 
pencil tool. Drag across the line; a new white line will appear. When you recross the 
old line, a new contour will be created.

Volume Free Hand Tool

Use the Volume Free hand Tool to manually draw a volume boundary. First magnify 
the band or other object (you must be able to see the individual pixels). Then click on 
the Volume Free hand button and use the cursor to draw a line around the object. 
When the line crosses itself, a free hand volume is created.

Fig. 7-3. Volume free hand.

If you make a mistake while drawing, backtrack with the mouse. The line you draw 
should completely surround the data you want to quantify.

To edit the volume, position the cursor on the border and drag across the line; a new 
white line will appear. When you recross the old line, a new free hand volume will be 
created.
7-3



Quantity One User Guide
Volume Rect Tool

Use the Volume Rectangle Tool to create a volume box around an object. Click on 
the Volume Rect button, then drag a box around the object to be quantified. When 
you release the mouse button, the volume is created.

Fig. 7-4. Volume rectangle.

To resize the box, click on it to select it, then position the cursor on one of the corner 
anchor points and drag.

To rotate the box, click on it to select it, then hold down the Shift key while dragging 
an anchor point. The volume will pivot around its center. This is useful if the object is 
lying at an angle—for example, if the gel is smiling.

Volume Circle Tool

Use the Volume Circle Tool to create a circular boundary around an object (such as a 
spot). To use this tool, click on the Volume Circle button, then position the cursor at 
the center of the object to be quantified and drag outward. As you drag, a circle will 
appear. When you release the mouse button, the volume is created.

Fig. 7-5. Volume circle.
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The volume circle should completely surround the data you want to quantify.

To resize the circle, click on it to select it, then position the cursor on the circle border 
and drag.

7.2 Volume Labels
Volume labels help to identify the type of the volumes you create. As you create each 
volume, it is given a default Auto label. The default labels are: U1, U2, U3, etc. The 
“U” stands for unknown, as distinguished from standard (Std) and background (B) 
volumes. The number indicates the sequence in which the volume was created. To 
change the volume type, double click the volume to open the Volume Properties 
dialog box.

Fig. 7-6. Volume Properties dialog box.
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At the top of the Volume Properties dialog box is the current label for the selected 
volume. Volume Type lists the types of volumes: Unknown, Standard, and 
Background. The type of the current volume is indicated by the selected radio button. 
Choose a new type by clicking a different radio button. If you choose Standard as the 
new volume type, you must enter a concentration greater than zero in the 
Concentration field. 

Note: If you change a volume’s type (e.g., change an unknown to a standard), any 
subsequent volumes of the original type will be renumbered. For example, if you 
create volumes U1 and U2, and then designate U1 as a background volume, U2 
will be renumbered U1.

7.2.a Editing Volume Labels

In the Volume Properties dialog box you can choose to give the selected volume a 
User label as well as modify the style of the Auto labels. 

Editing User Labels

To create or edit a User label for the selected volume, click Edit User Label to open 
the Text Overlay Properties dialog box. In the Text Overlay Properties dialog box 
you can change the, font, size, color, orientation, and background of the selected text. 
The text field displays the current volume label. To change the text of the label, type a 
new label in the text field. 

Note: A change to the text of the label will not cause a renumbering of unedited volume 
labels. However, if you change the type for a particular volume, this will 
renumber the subsequent volumes without changing the text or style of the User 
label.

If you want to remove the User label and return the Auto label for the selected 
volume, click Use Auto Label. Note that changes do not take effect until you click 
Done. So if you find you want to keep the User label, click Cancel instead.

Editing Auto Labels

To modify the style of  the Auto labels, click Edit Auto Labels. Like the Edit User 
Label tool, this opens the Text Overlays Properties dialog box. Use the options in 
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the Text Overlays Properties dialog box to modify the style of the Auto labels. Note 
that you must first select the text in the text field before making any changes. 

Note: Editing the Auto labels affects only the style of the labels, not the text or 
numbering of the Auto labels.

Modifying the style of your Auto labels does not affect the style of any existing User 
labels. To modify the styles for your User Labels, you must modify each individually. 
See Editing User Labels for further information.

When you first create volumes, they appear labeled. Click  Show/Hide Volume 
Labels on the Volume menu or toolbar to hide the labels.

7.3 Volume Features
Each new volume you create initially has a green border, which indicates that the 
volume is selected. If you click elsewhere on the image, the border will change to 
blue, indicating that the volume is deselected.

To reselect the volume, click on it again. If you move the cursor over the volume, 
selected or not, the border changes to gold.

After you create a volume, you can view the volume data (area, density, etc.) by 
selecting the Volume Analysis Report from the Reports menu.

Tips

The volume you draw should completely surround the data you want to quantitate. 
You should also adjust for background intensity

You may want to experiment with several different volumes drawn around the same 
object before selecting the one that gives you the best quantitation data.

Displaying Volumes

To display previously created volumes after opening an image, select Volume Tools 
from the Edit menu or main toolbar.
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If you have concealed all overlays using Hide Overlays, click on any button in the 
Volume toolbar to display the hidden volumes.

7.4 Moving, Copying, and Deleting Volumes
You can move, copy, or delete a single volume or group of volumes within an image. 
You can also copy and paste volumes between images.

First, select the volume(s). Click on the Select Tool button on the Volume toolbar. To 
select a single volume, click on it. To select multiple volumes, either drag a box 
around them or hold down the Shift key while you click on them one at a time. When 
you drag to select a group of volumes, make sure that you completely surround all the 
volumes.

Each selected volume will have a green border.

• To move the selected volume or volumes, position the cursor over the selection 
and drag.

• To copy within an image, hold down the Ctrl key while dragging the selected 
volume or volumes. The copy will be created and dragged to the new position.

• To delete the selected volume or volumes, press the Delete key.

• To copy between images, click on the Copy to Clipboard button on the Volume 
toolbar, then open or select the image you want to copy to and click on the Paste 
from Clipboard button. The copied volume(s) will be pasted into the new image 
in the same relative position it was copied from.

Note: If you are copying to an image with a different pixel size (i.e., resolution), you 
will receive a message that the placement of the copy may not be exact. Click on 
OK to complete the paste, then position the pasted objects manually.

7.5 Volume Standards
You can use volumes of known concentration to calculate the concentrations of 
unknown volumes.
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To classify a particular volume as a standard, double-click on it. This will open the 
Volume Properties dialog.

Fig. 7-7. Volume Properties dialog.

Select the Standard option button, then enter the concentration in the Concentration 
field. (Do not include units.) Click on OK to close the dialog.

Standard volumes have the default names S1, S2, S3, etc., based on their creation 
sequence. Display or hide volume names using Show/Hide Volume Labels 
command as previously described.

After you have identified two or more standards, you can use the Volume Regression 
Curve (see section 12.7, Volume Regression Curve) under the Reports menu to 
calculate the concentrations of the unknown volumes.

Note: Volumes that fall above the greatest standard value, or below the lowest standard 
value, cannot be guaranteed for accuracy.

To change a standard back to an unknown, double-click on it, then select the 
Unknown button.
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7.6 Volume Background Subtraction
When you draw a volume, you will probably include some background pixels inside 
the volume. These background pixels will usually have an intensity value that you do 
not want to include in the volume quantitation. There are two ways of calculating this 
background intensity: local and global.

The background subtraction method is selected in the Volume Report Options dialog 
(see section 12.6.a, Volume Report Options).

Local Background Subtraction

Local background subtraction calculates a separate background intensity for each 
unknown and standard volume you create. For each volume, the intensities of the 
pixels in a 1-pixel border around the volume are added together and divided by the 
total number of border pixels. This gives an average intensity for the background 
around each volume, which is then subtracted from the intensity of each pixel inside 
the volume.

Fig. 7-8. Local background is calculated from a one-pixel border around the volume

Any pixels inside the volume that have the same intensity as the background pixels 
will be reduced to zero, thereby eliminating them from the quantitation.

One-pixel border
around the volume
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Global Background Subtraction

Note: If you select Global Background Subtraction in the Volume Report Options 
dialog, but do not define a background volume as outlined below, you will 
effectively select no background subtraction.

Global background subtraction calculates a single background intensity for the entire 
gel. This average background intensity is then subtracted from all the volumes in the 
gel. The steps for calculating global background subtraction are:

1. Create a volume using one of the volume tools in a representative background 
region of the image (i.e., a region where there is no data and where the average 
pixel intensity appears to be the same as the background intensity surrounding 
your data).

2. Double-click on the volume to open the Volume Properties dialog, and select the 
Background option button.

Fig. 7-9. Defining a background volume object.

The average intensity of the pixels in the background volume will be calculated and 
subtracted from each pixel in all standard and unknown volumes. Any pixels inside 
the volumes that have the same intensity as the average background will be reduced to 
zero, thereby eliminating them from the quantitation.
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If you create more than one background volume, all the pixels in those background 
volumes will be used to calculate the average background.

Background volume(s) will have default names B1, B2, etc., based on their creation 
sequence. You can display/hide volume names using the Show/Hide Volume Labels 
command.

Note: If the region you identified as background has a higher average intensity value 
than a data object, that object will have a negative adjusted volume in the Volume 
Analysis Report. If this happens, select a new background region that has less 
intensity than the data object.

Displaying the Results of Background Subtraction

The Volume Analysis Report (see section 12.6, Volume Analysis Report) will display 
both the unadjusted volume and the volume with background subtracted (adjusted 
volume) of standards and unknowns, so you can see exactly how much intensity was 
subtracted.

7.7 Volume Arrays
The Volume Array Tool on the Volume menu and toolbar can be used to quantitate 
dot blots, slot blots, and other arrays.

Note: You cannot create a volume array in an image with asymmetric pixels (i.e., 
different dimensions in x and y). If you want to create a volume array in such an 
image, select Reduce File Size from the File menu to change the pixel 
dimensions of the image  (see section 2.2.f, Reduce File Size).

What Is a Volume Array?

A volume array is a matrix of volume circles or rectangles that can be 
sized/positioned as a group and overlaid on images of blots, wells, or cells for easy 
quantitation. The individual cells in the array have the same functionality as standard 
volumes. You can define cells as background volumes, standards, and/or unknowns, 
as described in the sections above.
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You report the array data as you would standard volumes, using the Volume Analysis 
Report.

Creating a Volume Array

On the Volume menu or toolbar, select the Volume Array Tool. This will open the 
Build Volume Array dialog.

Fig. 7-10. Build Volume Array dialog.

In the dialog, you can select a standard microtiter plate dimension (96 wells, 384 
wells, or 1536 wells) or select Rows x Cols and enter the number of rows and 
columns in the array in the appropriate fields.

Select the shape of the wells/cells (Circular or Rectangular) and click on OK.

The array overlay will be created and displayed on the image.
7-13



Quantity One User Guide
Fig. 7-11. Array overlay.

Like regular volumes, array volumes are initially displayed without labels. To show 
the labels of the individual wells/cells, click on the Show/Hide Volume Labels 
button on the toolbar. Like regular volumes, array volumes are initially labeled U1, 
U2, U3, etc.

Note: If large volume arrays are slow to display or edit on your computer and the 
volume labels are showing, try hiding the volume labels using the Show/Hide 
Volume Labels command. This will increase the processing speed considerably.

When you create an array overlay, it is automatically selected (the cells will be 
displayed with green borders) and the Select tool is assigned to the mouse. You can 
then move the array overlay so that it is properly centered on the image, resize the 
cells so they fit the blots/wells in the image, and resize the overlay so the four corners 
fit over the four corners of the array on the image.

To delete the entire array overlay, select it and click on the Delete key.

Moving an Array

To reposition an array overlay, move the cursor over any individual cell until the 
cursor changes to a multidirectional arrow and the cell border turns yellow. Then hold 
down the cursor and drag the entire array to a new position.
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Fig. 7-12. Moving an array.

Resizing an Array

To resize an array overlay, make sure it is selected, then position the cursor over the 
dot at the center of one of the corner cells. Green lines will appear connecting the 
array frame at the four corners.

Fig. 7-13. Resizing an array.

Hold down the mouse button and drag the array frame in or out to compress/expand 
the array.
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Resizing the Array Cells

To resize the individual cells in the array, magnify any individual cell and move the 
cursor over the cell border (or corner anchor point, in the case of rectangles) until it 
changes to a cursor with an adjustment symbol. Hold down the mouse button and 
drag to move the border in or out. All the cells in the array will be resized accordingly.

Fig. 7-14. Resizing an array cell.

Copying an Array

To copy an array within the same image, select it, then hold down the Ctrl key while 
dragging it. The copy will be created and dragged to the new position.

To copy an array between images, select it, then click on the Copy to Clipboard 
button on the Volume toolbar. Open or select the image you want to copy to and click 
on the Paste from Clipboard button. The copied array will be pasted into the new 
image in the same relative position it was copied from.

Note: If you are pasting into an image with a different pixel size (i.e., resolution), you 
will receive a message that the placement of the copy may not be exact. Click on 
OK to complete the paste, then position the pasted array manually.

Ungrouping an Array

You can ungroup the individual cells in an array, so they behave like normal, stand-
alone volumes.
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With the array selected, select the Array Ungroup command from the menu or 
toolbar. This command cannot be undone, and you will be prompted to confirm the 
action.

The ungrouped array will appear deselected (i.e., displayed in blue). You can then 
move the cells individually, and perform all normal volume operations on the 
individual cells.
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8. Colony Counting
You can use Quantity One to automatically count the number of white, blue, or plaque 
colonies in a Petri dish.

Note: For best results, when capturing the image of a Petri dish, the dish should fill the 
imaging window. Also, images with colonies should not have asymmetric pixels. 
(Asymmetric pixels can be generated by densitometers and the Reduce File Size 
command.) The colony counting function will not work properly on images with 
asymmetric pixels.

Select Colony Counting from the Analysis menu to open the Colony Counting 
dialog.

Fig. 8-1. Colony Counting dialog.
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The dialog has been arranged from top to bottom to guide you through the procedure.

8.1 Defining the Counting Region
First, you must define the region you want to count in the Petri dish image.

Click on the Define Counting Region button in the dialog and position the cursor at 
the center of dish image. Drag the cursor outward. As you drag, a blue circle will 
expand on the image—this defines the border of the counting region.

Fig. 8-2. Defining a counting region.

If you make a mistake in defining the counting region, click on the Reset button at the 
bottom of the dialog to start over.

Position the blue border until it is just inside the interior edge of the Petri dish.

Drag cursor
out from
center to
define region 
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Note: If the border disappears when you release the mouse button after dragging, check 
to make sure that the Show Data Area checkbox is checked. This checkbox is 
located at the bottom of the dialog.

If the circle is slightly off-center, you can reposition it by positioning the cursor on the 
center “target” of the circle. The cursor will change to a multidirectional arrow, and 
you can drag the entire circle.

To resize the counting region circle, position the cursor on the outer edge of the circle. 
The cursor will change to a bidirectional arrow and you can drag the border in or out.

8.2 Counting the Colonies
After you have positioned the circle, you are ready to detect colonies.

If you are counting plaques, click on the Plaque checkbox. (Because plaques appear 
as clear circles on a darker background, this checkbox must be selected for proper 
detection.)

Before counting, you may want to adjust the Sensitivity and Averaging parameters 
described below.

When you are ready to count, click on the Count button.

Sensitivity

The Sensitivity setting determines the minimum signal intensity in the image that will 
be counted as a colony. (This is based on the slope of the signal’s peak.) The higher 
the sensitivity, the more colonies will be detected.

If the sensitivity is set too high, background noise will be erroneously detected as 
colonies. If the setting is too low, real colonies may be missed.

The default sensitivity setting is 10.00. If the image has faint colonies (e.g., O.D. < 
0.05, counts < 2,000), you may want to increase this value to 20.00.
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Averaging

Averaging is designed to prevent random signal noise (such as salt or pepper) in the 
image from being detected as colonies. If the image is noisy, you should select the 
highest value that still results in good separation of colonies (default = 3).

A low averaging value may result in noise being detected as colonies. A high 
averaging value may result in two closely spaced colonies being counted as one.

8.3 Displaying the Results
When you click on Count, the number of detected colonies will appear in the Results 
section of the dialog in the White column.

Fig. 8-3. Example of a dish with white colonies.

The colonies will also appear marked as gold triangles on the image itself.

Note: If the colonies are not marked on the image, make sure that the Mark White 
Colonies checkbox at the bottom of the dialog is checked.

A text box on the image will indicate how many colonies were detected on the image.
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Doing a Recount

To recount using different parameters, change the Sensitivity and/or Averaging 
settings. This will erase the old count. Then click on Count again to recount.

Redrawing the counting region circle or clicking on the Reset button will also erase 
the count.

8.4 Making and Erasing Individual Colonies
If automatic colony detection has missed or erroneously detected some colonies, you 
can manually mark or unmark them directly on the image using the buttons under 
Tools/Options.

Fig. 8-4. Colony counting tools.

To mark a colony, click on the Make Colony button, then click on the spot on the 
image that you want to identify as a colony.

To unmark a colony, click on the Erase Colony button, then click on the colony on 
the image that you want to unmark.

The colony count will change accordingly.
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8.5 Using the Histogram to Distinguish 
Colonies

The histogram in the Colony Counting dialog is a graphical representation of the 
signal data in the image. You can use the histogram and associated sliders to reduce 
the number of incorrectly identified colonies and/or distinguish between white and 
blue colonies in the image.

Colonies Versus Background Noise

If there is a clear peak on the left end of the colony counting histogram, it is probably 
due to background intensity or noise in the image. (For information on subtracting 
background from entire images, see section 3.10, Whole-Image Background 
Subtraction; for information on filtering noise from images, see section 3.11, Filtering 
Images.)

If background is being detected as colonies, you can use the histogram and the Cutoff 
slider to correct this.

Drag the Cutoff slider to the right until it is centered on the right edge of the 
background peak.

Fig. 8-5. Using the Cutoff slider.

The yellow portion of the bar beneath the histogram marks the range of image data 
has been designated as background noise, and is not being considered for colony 
counting purposes. The gold portion of the bar marks white colony data range.

Background peak

Cutoff mark
8-6



Chapter 8. Colony Counting
The colony count displayed in the dialog and on the image should decrease. On the 
image, you should also see the incorrectly identified colonies disappear as you drag 
the slider.

White and Blue Colonies

If you know you have white and blue colonies in the image, and there are two clear 
peaks on the histogram to the right of the background peak, you can use the histogram 
to distinguish between these types of colonies.

Fig. 8-6. Using the White/Blue slider.

Drag the White/Blue slider to the left until it is positioned between the two peaks. 
The white colony data range is indicated by gold on the bar beneath the histogram, 
and the blue colony data range is marked with blue.

As you drag the slider, the numbers of white and blue colonies will change in the 
dialog and in the text box on the image. Also on the image, you should see the marked 
white colonies (gold triangles) change to blue colonies (blue squares).

Note: If the blue colonies are not marked on the image, check to make sure that the 
Mark Blue Colonies checkbox at the bottom of the dialog is checked.

White peak Blue peak

White/blue 
division mark
8-7



Quantity One User Guide
8.6 Ignoring a Region of the Dish
If a particular region of your Petri dish is damaged and you do not want to consider 
the colonies (if any) that appear there in the final count, you can exclude that region 
of the dish from the calculations.

Click on the Ignore Region button, then position the cursor on one edge of the region 
you want to ignore. Drag the cursor on the image, defining the full region you want to 
ignore.

Fig. 8-7. Marking a region to ignore.

As you drag, you will create a “pie slice” marked with red cross-hatching. Any 
colonies in this region will not be considered in the final count.

When you have defined the region, release the mouse button. If you want to change 
the size of the ignored region, position the cursor on the edge of the pie slice near the 
rim of the blue circle. The cursor will change to a bidirectional arrow, and you can 
drag the edge of the pie slice.
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Colony Count and Adjusted Count

After you have defined a region to ignore, two different counts will appear in the 
dialog: the colony count and the adjusted count.

The Colony Count is the number of colonies that appear in the defined circle minus 
those in the ignored region.

The Adjusted Count is an estimate of the total colony count in the Petri dish; it uses 
the known colonies to extrapolate the number of colonies that might have appeared in 
the ignored region if it had not been damaged. The adjusted count is calculated based 
on the area of the ignored region and the density distribution of colonies in the rest of 
the circle.

8.7 Saving/Resetting the Count
A colony count can be saved to the image and/or a separate spreadsheet file.

Saving to the Image

Any count you perform is automatically stored with the image. To save the count with 
the image, exit the Colony Counting dialog by clicking on the Close button, and use 
the Save commands under the File menu to save the image.

To view the count data again, simply open the image and open the Colony Counting 
dialog.

To save a count or multiple counts to a spreadsheet file, see the following section.

Resetting the Count

Click on the Reset button to clear the Colony Counting dialog and any changes you 
have made to the image. This command cannot be undone.
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8.8 Saving to a Spreadsheet
The Batch File controls allow you to export colony data from an image or multiple 
images to a Microsoft® Excel spreadsheet for review and comparison. To activate 
these controls, click on the Batch Mode checkbox.

Fig. 8-8. Batch Mode controls.

Creating/Opening a Batch File

To create a new batch file, click on the New Batch button. This will open a dialog in 
which you can specify the name and location of the spreadsheet you want to create.

Fig. 8-9. Creating a batch file.

When you click on Save, the new batch file name will be displayed in the Colony 
Counting dialog.
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To open an existing batch file, click on the Open Batch button. This will open a 
similar dialog. Select the Excel file you want to open from the appropriate directory.

Naming/Saving a Count

Enter a name for the count you want to save in the Count Name field, or use the 
default name (the file name plus a time stamp). Enter any comments in the Count 
Comment field. This data will be included in the spreadsheet.

To save the currently displayed count to the batch file, click on the Save Count 
button. The number of colonies, as well as associated count settings, will be added to 
the spreadsheet. After you have saved the current count, the Save Count button will 
become deactivated. If you adjust the count in any way, the button will become active 
again and you can add the adjusted count to the spreadsheet.

Loading Another Image

After you have saved the count(s) for the current image, you can open another dish 
image by clicking on the Load Next button. This will open a standard Open dialog 
from which you can select the image.

The new image will be loaded into the Colony Counting dialog.

Note: The image will only be loaded into the Colony Counting dialog; it will not open 
in a separate image window in Quantity One.

After you have saved the count(s) for the new image to the batch file, you can either 
load another image using the Load Next command or click on Close to close the 
Colony Counting dialog.
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9 ReadyAgarose™ 96 Plus
ReadyAgarose 96 plus gels are pre-cast agarose gels that accommodate 96 samples 
and standards. These high throughput gels allow loading samples from 96 well 
microtiter plates. The gels are 4 and 12 multi-channel pipet compatible, and the 
tip-to-tip spacing of the multi-channel pipetors results in adjacent samples from 
microtiter plates being loaded in alternating wells on the ReadyAgarose 96 plus gel.

The ReadyAgarose 96 plus feature of Quantity One allows you to manipulate the gel 
image to rearrange the lanes from samples run on the ReadyAgarose 96 plus gels and 
put them in a 96 well microtiter plate format, thus simplifying sample tracking for 
analysis.  This allows easy comparison and analysis of gel data based on the 
microtiter plate format. 

When acquiring the gel image, zoom in such that there is minimum blank space 
around the gel. This is extremely important with low resolution imagers. Once the gel 
image is acquired, the ReadyAgarose 96 plus feature uses a step-by-step approach to 
analyze the image.  The First step is to align the gel image.  Quantity One then places 
lane overlays over each lane.  You can then make slight adjustments to the size and 
position of the lane overlays. The final step allows you to determine the lane format. 
There are three lane formats from which to choose, 8 x 14, 4 x 28 (default), or 2 x 56 
format (includes standard lanes). 

9.1 ReadyAgarose Wizard
Once you have acquired your image, select ReadyAgarose 96 plus from the Analysis 
menu. This opens the ReadyAgarose 96 plus Wizard.

Step 1 - Positioning the Image

The first panel of the wizard displays your image with four red crosshairs.
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Fig. 9-1. Positioning the Image

Click and drag each crosshair to place them over the four triangles visible in the gel 
holder. The ideal position is at the tip of the triangle. When you have correctly 
positioned the crosshairs, click the Next button.

Step 2 - Resizing, Repositioning, and Spacing the lanes

In the next panel, the image displays 96 lanes based on the position of the crosshairs 
in the previous panel.
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Fig. 9-2. Resizing and Repositioning the Lanes

Use the slider bars at the bottom to change position, resize the lanes, or modify the 
vertical spacing of the lanes. Note that the sliders move, resize, or space all the lanes 
at once. When you are satisfied with the location of the lanes, click Next.

Step 3 - Arranging the Lane View

This panel places the 96 lanes in a new view. The default view is 4 x 28.
9-3



Quantity One User Guide
Fig. 9-3. Arranging the Lanes

To arrange the lanes in a different view, select the appropriate view at the bottom of 
the panel. If you would like Quantity One to create an additional default image with 
the lanes in their original orientation, check the box labeled, "Create Default Image". 
When you are satisfied with the gel arrangement, click Finish to create your new 
image. 
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10. EXQuest Spot Cutter
The EXQuest Spot Cutter is a precision instrument that accurately locates and excises 
protein spots from 1D gels or blots, and loads them into microplates for down-stream 
processing and analysis. 

Fig. 10-1. EXQuest Spot Cutter

The following sections describe how to calibrate the EXQuest Spot Cutter and excise 
spots using Manual Excision or lane/Volume Excision.
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10.1 Calibration and setup
Before you can use the spot cutter for the first time, you must first calibrate the 
instrument. The calibration wizard helps you to quickly calibrate the camera as well 
as set the plate and wash station positions. The calibration wizard functions the same 
whether you are using the gel tip or the membrane tip. 

To open the calibration wizard, go to the Devices tab of the Preferences dialog box, 
make sure you have selected the EXQuest Spot Cutter, and click Setup Spot Cutter.

Fig. 10-2. EXQuest Spot Cutter wizard

10.1.a System Calibration

The wizard guides you step-by-step through the system calibration. System 
calibration synchronizes the coordinates of the camera and the coordinates of the 
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cutter. Follow the directions on each panel then click Next to continue. If you find 
you made an error, or need to repeat a step for any reason, click Back.

Note: Clicking Back requires you to re-perform any completed steps.

Focusing the Camera

If this is the first time calibrating the spot cutter, or you have replaced the camera, you 
need to focus the camera. Check the box labeled Perform Focus/Alignment step, then 
click Next.

If you do not need to focus the camera, clear the Perform Focus/Alignment step 
checkbox. You can also skip system calibration and go directly to plate alignment 
provided system calibration was performed earlier and is still valid.

Flat Field Calibration

In the Flat Field Calibration step, the spot cutter needs to create an image of the 
cutting stage. Make sure the cutting stage is clean and dry before proceeding.

Lens Calibration

In the Lens Calibration step, the spot cutter needs to create an image of the grid 
placed on the cutting stage. Place the calibration grid on the stage before proceeding.

System Position Calibration

This step requires the placement of pucks on the stage in a three-by-three grid. As the 
gel tip positions above each puck, it is necessary to center the puck beneath the tip. 
Once placed, click lower tip. This places the puck exactly where it needs to be. Once 
all pucks are placed properly, the camera takes an image of the pucks. 

Auto placement - If you have previously performed calibration, you can have the 
spot cutter automatically place the pucks for you. Simply place the pucks on the 
cutting stage. Check the box labelled Auto place pucks. When you click Next, the 
spot cutter takes an image of the pucks on the stage, then automatically moves the 
pucks to their proper positions. When the pucks are positioned, the spot cutter creates 
the system position image.
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10.1.b Calibrating the Plate and Wash Station Positions

The second part of the calibration wizard focuses on plate position and wash station 
position. Due to minor imperfections in the construction of the spot cutter, it is 
necessary to fine tune the position of the microtiter plate positions and the wash 
station.

Plate Position Calibration

To calibrate plate position, select a plate type from the list, place the plate in the right, 
rear plate position, and click Next. The spot cutter moves the tip to the location above 
the A1 well.

Fig. 10-3. Plate position for a 384 well plate
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The sliders allow you to adjust the tip by moving it along X and Y coordinates. Click 
Lower to lower the tip into the well. This gives you a clear idea of where the tip is in 
relation to the center of the well.

The tip height slider adjusts the height of the tip above the well when ejecting 
material into the well. This should be slightly above the lip.

After calibrating one type, you have the option to return to the plate selection panel to 
calibrate another type. If you anticipate using only one type of plate, you can skip 
calibrating the other types. If at a later time you find you need to use another plate 
type, you can return to this step without performing system calibration.

Wash Station Calibration

In the Wash Station Position step the tip moves to the location above the Wash 
station. If you are doing Membrane tip calibration, the tip moves to just above Wash 
Station #1. 

The sliders allow you to adjust the tip by moving it along X and Y coordinates. Click 
Lower to lower the tip. This gives you a clear idea of where the tip is in relation to the 
center of the wash station.

The tip height slider adjusts the height of the tip in relation to the wash station. The tip 
should be low enough to effectively wash the tip.

Calibration Summary

The Calibration summary describes all changes made during calibration. PDQuest 
generates a log that will be updated each time the spot cutter is calibrated. To view the 
log, click View Log.

Note: If this is the first time calibrating the spot cutter, the log is unavailable.

Click Finish to close the wizard. You are now ready to cut spots using the EXQuest 
Spot Cutter.
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10.2 Manual Excision
Manual Excision is used for basic spot cutting operations. If you want to excise entire 
lanes or create volumes to excise, use Lane/Volume Excision.

Before using this tool, make sure the spot cutter is connected, is switched on, and has 
warmed up, then select Manual Excision from the Excision menu. The software will 
connect with the spot cutter platform and camera, and the Manual Excision dialog 
box will open.

Fig. 10-4. Manual Excision

In the event that Quantity One cannot locate the spot cutter, a warning dialog box 
displays. Check your connections and click Retry. You also have the option of 
running Manual Excision in simulation mode.

Note: See the spot cutter hardware manual for instructions on installing the platform, 
camera, and associated hardware and software.
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The Manual Excision tool is designed to guide you through the spot cutting 
procedure. Click on the link for more information about each step.

• Acquire Image. In this step, you capture an image of your gel or membrane 
using the spot cutter camera.

• Specify the Cut Run Options. These options can be adjusted for each cut run.

• Specify Cuts. In this step, you identify the spots in the image that you want to 
cut.

• Performing the Cut Run. In this step, you perform the cut run. When the run is 
complete, you can acquire a confirmation image.

10.2.a Acquire the Image

Before acquiring an image, select the light option appropriate for your gel/membrane/
stain type:

• White Trans (gels and PVDF membranes).

• UV EPI (fluorescent gels).

Fig. 10-5. Acquire Image.

If UV light is selected, specify an exposure time in seconds in the field. Also, make 
sure that the UV lamp switch on the front of the cutter is on.

Note: For Sypro Ruby stains, an exposure time of 20-30 seconds is recommended.

When you have selected a light option, click Acquire Image.

Note: For UV exposures, there will be a 15-second delay while the lamps heat up 
before the exposure begins.
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The camera will take a single image of the gel or membrane on the platform, then a 
background image to adjust for image background. When the exposure is complete, 
the image will appear in the window.

To adjust the brightness and contrast of the image, open the Transform 
window by clicking on the button to the right of the image window.

10.2.b Specify Options

Under specify Options, you can make changes to various settings.

Cut

On the Cut tab you can choose to make multiple cut when possible, select the specific 
cutting tip size and the type of material you are cutting.

Fig. 10-6. Cut options.

If you want to make multiple cuts, check the box labelled Make multiple cuts when 
possible. Then enter the maximum number of cuts per object.

Next, select the cutting tip size you are using. Quantity One uses this to determine 
when you have reached the maximum capacity for wells on the plate.

Finally, select the material you are cutting from the drop down list.
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Plate

On the plate tab, select the plate type you are using for this cut run, then select the 
volume of each well. PDQuest uses this setting in conjunction with your cut settings 
to determine whether you will exceed the well capacity.

Fig. 10-7. Plate options.

Load order determines the order in which wells will be filled on the plate. 

Hydrate

To keep gels from drying out during long cut runs, you can have the EXQuest spot 
cutter automatically hydrate your gel(s) during the cut run. Check the hydrate box 
then enter the time, in minutes between hydration runs. 
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Fig. 10-8. Hydrate option.

To determine the area you want to hydrate, click Define hydration area, then click and 
drag on the image to create a box. To redraw the hydration area, click and drag again.

Note: You must define a hydration area for hydration to function.

Wash

When using the EXQuest with the gel tip, EXQuest will flush the tip after each cut is 
made. Enter the wash volume to flush through the cutter tip.

Fig. 10-9. Wash option.
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If you are using the membrane tip, you cannot adjust the wash volume as the tip is 
washed in the three membrane wash stations. 

10.2.c Specify Cuts

In Specify Cuts, click Add/move cut then click on spots in the image to identify 
which spots to cut. To make multiple cuts of large spots (if selected on the Cut tab of 
the Specify Options section), click and drag over the spot in the image.

Fig. 10-10. Specify cuts.

Use the Zoom Box tool on the right of the Basic Excision Tool to magnify each spot. 
When clicking on spots in the image, select the Snap to Peak checkbox to 
automatically center the cut circle on the spot peak (calculated from the spot intensity 
in the image).

To remove a cut, click Remove cut and click on a cut selection in the image.

Run Info

The Run Info section contains information regarding the current cut run.

Cuts - indicates the total number of cuts in the run including multiple cuts.

Wells - indicates the number of wells to be used.

Plates - indicates the number of plates needed for the run.

Min. well volume - indicates the minimum well capacity to avoid overflow based on 
the number of multiple cuts selected and cutter tip size. If the well volume for your 
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selected plate is less than the Min. well volume, then the overflow warning flashes 
and you will not be able to start a cut run.

Note: Minimum well volume and the overflow warning only display if you are using 
the EXQuest Spot Cutter with a gel head.

10.2.d Performing the Cut Run

After you have identified all the cuts you want to make and selected the appropriate 
options, you are ready to begin the cut run.

Click the Begin/Resume button.

Plate Selection

The Plate selection dialog box lists all the plates available for the cut run. The table 
shows the plate name, barcode/ID, plate size (96 well, 384 well, 96 tube), wells 
available on the plate, and used wells. If this is a new cut run, the number of plates 
listed is determined by the number of wells required for the cut run. 
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Fig. 10-11. Select plates.

In the Plate selection dialog box you can change the name of a plate and enter a 
barcode/ID directly in the table. The barcode helps to properly place the plates in the 
spot cutter.

To add a plate click Add plate. To remove a plate from the list, click Delete.

If the Use checkbox is cleared, the plate will be skipped in the cut run even if it has 
wells available. 

To skip specific wells in a plate to reserve them for such things as standards, click 
Edit in the table.This opens a plate diagram dialog box. 
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Fig. 10-12. Mark wells for skipping.

Click on a well to mark it for skipping in the cut run. Red wells are reserved wells, 
while blue wells are wells with material in them from a previous run.

Note: You cannot change the state of wells that have material in them.

When you have finished making your plate selections, click Done.

The plate wizard will direct you as to where to place the plate in the spot cutter.
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Fig. 10-13. Plate loading in the EXQuest Spot Cutter

As each cut is being made, it will be highlighted in yellow on the screen. After each 
cut has been made, the cut circle appears in white on the screen. Cuts that have not yet 
been made are circled in green.

Run Info

The Run Info section contains information regarding the current cut run.

Cuts - indicates the total number of cuts in the run including multiple cuts.

Wells - indicates the number of wells to be used.

Plates - indicates the number of plates needed for the run.

Min. well volume - indicates the minimum well capacity to avoid overflow based on 
the number of multiple cuts selected and cutter tip size. If the well volume for your 
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selected plate is less than the Min. well volume, then the overflow warning flashes 
and you will not be able to start a cut run.

Note: Minimum well volume only displays if you are using the EXQuest Spot Cutter 
with a gel head.

Ending the Cut Run

Click Pause to pause the cut run. You will be prompted to confirm the pause. Note 
that the cutter will pause only after the most recent cut has been deposited in a well. 
Any remaining cut requests will remain selected in the image, and you can click 
Begin/Resume to complete the remainder of the cuts.

When all cuts are complete, the cutting tip will return to the home position.

Confirming Cuts

When the cut run is completed, you have the option of taking a confirmation image. If 
you click Yes, PDQuest acquires a temporary image of the gel with the cut spots 
identified by plate and well number.

The specification for the EXQuest Spot Cutter spot pick-up is greater than 99% 
effective at picking up a spot that has been cut from a gel. However, there may be 
some spots that have not been picked up, and these can be re-cut. The efficiency of 
pick up on the second cut is again >99%, so the spot is reliably picked up the second 
time. 

Use the zoom tools to confirm all spots were cut. If there are spots that need to be re-
cut, click Add/move cut, and then right click the spot in the Manual Excision window. 

When you have identified al the spots that need to be re-cut, click Begin/Resume. 

10.2.e Other Options

Prime Pump (Gel head only)

The spot cutter should be primed: when it is first installed; anytime the water bottle is 
filled, when the cutting head is changed; and for the first cut run of the day. Click 
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Prime pump until no large air bubbles are visible in the tubing. For an empty system 
this usually takes 3 prime cycles.

Save

To save the image taken by the spot cutter, click the Save button in the Manual 
Excision Tool window. You will be prompted to enter a name and specify a location 
for the image before saving.

Import

If you have a cut list saved to a text file, you can import it into the Manual Excision 
Tool. This is useful if you have a large number of cuts for similar gels. 

Note: You can only import a cut list to an image that does not have any cuts added. 
However, after you import cuts, you can add additional cuts to the image.

Click Import to open the Import Excision Coordinate List dialog box.

Fig. 10-14. Importing a cut list

If the first line of your file is header information, select Skip first line of file. Next 
enter which column the coordinates are located in the file. For example, if your file 
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lists the spot number in column one, the X coordinates in column two and Y in three, 
then you would enter two for column X and three for column Y. Columns must be 
separated by tabs or by columns.

Click the browse button to locate the file you want to import. 

Units indicates the measurements of the coordinates, and Origin determines starting 
point for the measurements.

The image in the Manual Excision Tool displays the placement of the spots as orange 
circles before you complete the import. If the cuts are out of position, you can click 
and drag all cuts at once to better position them. If you need to move cuts 
individually, you can do so after import by clicking Add cut, then clicking and 
dragging the cut you want to move.

When you are satisfied with the placement of the cuts, click Done to complete the 
import.

Display Options

Select the Well check box (below the Manual Excision image window) to display the 
well number associated with each cut request.

Select the Position checkbox to display the position of the cut (in millimeters) on the 
gel.

10.3 Lane/Volume Excision
Lane/Volume Excision functions much like Manual excision, except that you define 
what to cut based on defined lanes or volumes. 

Before using this tool, make sure the spot cutter is connected, is switched on, and has 
warmed up, then select Lane/Volume Excision from the Excision menu. The software 
will connect with the spot cutter platform and camera, and the Manual Excision 
dialog box will open.
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Fig. 10-15. Lan/Volume Excision

In the event that Quantity One cannot locate the spot cutter, a warning dialog box 
displays. Check your connections and click Retry. You also have the option of 
running Lane/Volume Excision in simulation mode.

Note: See the spot cutter hardware manual for instructions on installing the platform, 
camera, and associated hardware and software.

The Manual Excision tool is designed to guide you through the spot cutting 
procedure. Click on the link for more information about each step.

• Acquire Image. In this step, you capture an image of your gel or membrane 
using the spot cutter camera.

• Specify the Cut Run Options. These options can be adjusted for each cut run.

• Specify Cuts. Select whether to cut lanes or volumes.

• Performing the Cut Run. In this step, you perform the cut run. When the run is 
complete, you can acquire a confirmation image.
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10.3.a Acquire the Image

Before acquiring an image, select the light option appropriate for your gel/membrane/
stain type:

• White Trans (gels and PVDF membranes).

• UV EPI (fluorescent gels).

Fig. 10-16. Acquire Image.

If UV light is selected, specify an exposure time in seconds in the field. Also, make 
sure that the UV lamp switch on the front of the cutter is on.

Note: For Sypro Ruby stains, an exposure time of 8-10 seconds is recommended.

When you have selected a light option, click Acquire Image.

Note: For UV exposures, there will be a short delay while the lamps heat up before the 
exposure begins.

The camera will take a single image of the gel or membrane on the platform, then a 
background image to adjust for image background. When the exposure is complete, 
the image will appear in the window.

To adjust the brightness and contrast of the image, open the Transform 
window by clicking on the button to the right of the image window.

10.3.b Specify Options

Under specify Options, you can make changes to various settings.
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Cut

On the Cut tab you can choose to make multiple cut when possible, select the specific 
cutting tip size and the type of material you are cutting.

Fig. 10-17. Cut options.

If you want to make multiple cuts, check the box labelled Make multiple cuts when 
possible. Then enter the maximum number of cuts per object.

Note: Make multiple cuts when possible is inactive when using Lane Excision.

Next, select the cutting tip size you are using. Quantity One uses this to determine 
when you have reached the maximum capacity for wells on the plate.

Finally, select the material you are cutting from the drop down list.

Plate

On the plate tab, select the plate type you are using for this cut run, then select the 
volume of each well. Quantity One uses this setting in conjunction with your cut 
settings to determine whether you will exceed the well capacity.
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Fig. 10-18. Plate options.

Load order determines the order in which wells will be filled on the plate. 

Hydrate

To keep gels from drying out during long cut runs, you can have the EXQuest spot 
cutter automatically hydrate your gel(s) during the cut run. Check the hydrate box 
then enter the time, in minutes between hydration runs. 

Fig. 10-19. Hydrate option.
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To determine which area you want to hydrate, click Define hydration area, then click 
and drag on the image to create a box. To redraw the hydration area, click and drag 
again. If you choose not to define a hydration area, then the EXQuest Spot Cutter will 
hydrate the entire cutter stage.

Wash

Enter the wash volume to flush through the cutter tip.

Fig. 10-20. Wash option.

10.3.c Specify Cuts

Under Specify Cuts, determine whether to use Lane Excision or Volume Excision.

Lane Excision

If you select Lane Excision, use the Lane tools to define lanes in the image. See 
Section 4.1, Defining Lanes, for information using the Lane tools.
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Fig. 10-21. Specify Cuts using Lane excision

Because of the circular shape of the cutting tip, it is necessary to overlap the cuts to 
some degree to reliably obtain a sample of everything in the lane.

Use the vertical slider to adjust the percent of overlap. Zero will give a single column 
of cuts and 100 will staggers the spots at approximately 45 degrees. Use the 
horizontal slider to stagger the cuts so that a complete gel piece is obtained with each 
cut. The lower the number, the closer the cuts will be. At zero, the cut edges overlap.

Fig. 10-22. Use the sliders to adjust cut overlap.

Note that when using lane excision, each individual cut will be placed in a separate 
well. 

Vertical = 100 
Horizontal = 0

Vertical = 20 
Horizontal = 50
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Volume Excision

If you want to excise individual bands from a gel or blot, select Volume excision 
under Specify cuts. 

Fig. 10-23. Specify cuts by volume

To create a volume to excise, select the Volume rectangle tool then click and drag on 
the image to make the volume. If Make multiple cuts when possible is selected on the 
Cut options tab, the volume will contain up to the maximum number of cuts indicated.

Note: If you select multiple cuts for volumes, all cuts for each volume will be placed in 
the same well.

Run Info

The Run Info section contains information regarding the current cut run.

Cuts - indicates the total number of cuts in the run including multiple cuts.

Wells - indicates the number of wells to be used.

Plates - indicates the number of plates needed for the run.

Min. well volume - indicates the minimum well capacity to avoid overflow based on 
the number of multiple cuts selected and cutter tip size. If the well volume for your 
selected plate is less than the Min. well volume, then the overflow warning flashes 
and you will not be able to start a cut run.
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10.3.d Performing the Cut Run

After you have identified all the cuts you want to make and selected the appropriate 
options, you are ready to begin the cut run. Close the door of the spot cutter before 
proceeding.

Click the Begin/Resume button.

Plate Selection

The Plate selection dialog box lists all the plates available for the cut run. The table 
shows the plate name, barcode/ID, plate size (96 well, 384 well, 96 tube), wells 
available on the plate, and used wells. If this is a new cut run, the number of plates 
listed is determined by the number of wells required for the cut run. 

Fig. 10-24. Select plates.

In the Plate selection dialog box you can change the name of a plate and enter a 
barcode/ID directly in the table. The barcode helps to properly place the plates in the 
spot cutter.
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To add a plate click Add a plate. To remove a plate from the list, click Delete.

If the Use checkbox is cleared, the plate will be skipped in the cut run even if it has 
wells available. 

To skip specific wells in a plate to reserve them for such things as standards, click the 
icon under Edit in the table.This opens a dialog box displaying the plate. 

Fig. 10-25. Mark wells for skipping.

Click on a well to mark it for skipping in the cut run. If you are continuing an 
unfinished cut run, some of the wells may already be marked as reserved. 
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Note: Reserved wells from unfinished cut runs may have material in them. Be sure 
there is no material in the well before you mark it as unreserved.

When you have finished making your plate selections, click Done.

The plate wizard will direct you as to where to place the plate in the spot cutter.

Fig. 10-26. Plate loading in the EXQuest Spot Cutter

As each cut is being made, it will be highlighted in yellow on the screen. After each 
cut has been made, the cut circle appears in white on the screen. Cuts that have not yet 
been made are circled in green.

10.3.e Other Options

Prime Pump

The spot cutter should be primed: when it is first installed; anytime the water bottle is 
filled, when the cutting head is changed; and for the first cut run of the day. Click 
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Prime pump until no large air bubbles are visible in the tubing. For an empty system 
this usually takes 3 prime cycles.

Save

To save the image taken by the spot cutter, click the Save button in the Manual 
Excision Tool window. You will be prompted to enter a name and specify a location 
for the image before saving.

Display Options

Select the Well Number check box (below the excision image window) to display the 
well number associated with each cut request.

Select the Cut Position checkbox to display the position of the cut (in millimeters) on 
the gel.
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11.Differential Display and 
VNTRs

Quantity One has tools for studying gene expression using differential display 
analysis and counting VNTRs or other repeated elements in gels.

These functions are located on the Analysis menu.

11.1Differential Display
Differential display is a popular technique using mRNA and PCR amplification to 
identify genes that are differentially expressed between and among cell types.1 The 
mRNA in a cell is amplified using RT-PCR and resolved on a DNA sequencing gel, 
where it can be compared with mRNA from related cell types to determine 
differential gene expression.

The Differential Display tool in Quantity One facilitates the side-by-side comparison 
of the bands in a sequencing gel by highlighting the up or down regulation of bands 
across lanes.

Note: You must match the bands in the gel image before using this function. See 
Chapter 6 for more information.

11.1.a Normalization

Before using the Differential Display function, you must normalize the bands in the 
gel for quantity across all the lanes. With the gel open and matched, select Normalize 
from the Match menu and click on a distinct, well-resolved band that appears in every 
lane of the gel. The quantity of that band in each lane will be set to 100, and the 
quantities of the other bands in the lane will be normalized to that band. (If the band is 
not present in a lane, the normalized quantity for that lane is zero.)

1. Liang, P., and Pardee, A. (1992) Science 257: 967-970. 
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See section 6.2.d, Normalizing for Quantity, for more information on normalization.

11.1.b Differential Display Searches

After you have normalized the gel, select Differential Display from the Analysis 
menu. A dialog will open in which you can specify certain parameters.

 

Fig. 11-1. The Differential Display dialog box.

You can perform two types of searches on bands across a differential display gel: an 
Outliers search or a Trends search. Both are determined by the Percentage and 
Quantity values that you specify in the Differs By field.

Outliers

Select the Outliers button to highlight bands with a normalized quantity that differs 
from the mean normalized quantity for that band type by the specified percentage 
and/or the specified quantity. An outlier is defined as a band with normalized quantity 
(nq) that satisfies one of the following criteria:

1. nq > ratio x mean and 
nq > mean + quantity

2. nq < (1/ratio) x mean and 
nq < mean – difference

Where: ratio = 1.0 + (percentage/100)
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Trends

Select the Trend button to search for increasing or decreasing levels of gene 
expression across samples, represented by trends in normalized quantity across lanes. 
With Trend selected, a linear regression of (nq) versus lane number is computed for 
each band type. The leftmost and rightmost lanes containing that band type are 
determined. The normalized quantities for these lanes are calculated from the 
regression model. If:

abs(leftmost_nq – rightmost_nq) > difference and 
Max(leftmost_nq, rightmost_nq) / Min(leftmost_nq, rightmost_nq) > ratio

then the band type is flagged as a trend. 

Displaying Results

Bands identified as outliers or belonging to a trend are highlighted with a white line 
in the image.

If a lane is missing a band assigned to a band type that is flagged as an outlier or a 
trend, the expected location of the band will be highlighted by a white box.

Use the Normalized Quantity button in the Differential Display dialog to display a 
histogram of the normalized quantities and the mean quantity for a band type. Click 
on the button, then click on the band. A graph will display the normalized quantities 
of that band across the entire gel.

11.2Variable Number Tandem Repeats
If your experiments involve the use of microsatellites, VNTRs, or other repeated 
elements, you can calculate the number of times a repeated element occurs in a band. 

Note: You must define the Standards in the gel before you can use this function (see 
section 6.1, Standards).

To calculate the VNTRs in the bands in a gel, select VNTR Calculations from the 
Analysis menu. (You can also select the VNTR Quick Guide from the Help menu for 
guidance on analyzing gels with VNTRs.)
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The Tandem Repeat Calculations dialog box will open.

Fig. 11-2. Tandem Repeat Calculations dialog box.

At the top of the dialog box is the equation used to calculate the number of times an 
element is repeated in a band. 

The band size is determined by the position of the band on the gel image. 

In the Flanking Region Size field, enter the size (in base pairs or other repeated 
units) of the part of the fragment that does not include any repeated elements. This 
would include primer length and the length of any sequences that fall between the end 
of the primer region and the beginning of the stretch of repeats.
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Fig. 11-3. Diagram of components of a DNA fragment.

In the Repeated Unit Size field, enter the size in base pairs of the repeated element 
(e.g., if you are working with (CA) repeats, enter “2”).

Testing for Ambiguity

The number of repeats calculated by the software may not be a whole number, due to 
the limitations of exact band size determination. Since the number of times an 
element is repeated must be a whole number, the calculated value is rounded to the 
nearest whole number.

In the dialog box, you have the option to “flag” those numbers 

Select Yes after Test for ambiguity? to flag values that deviate from the nearest 
whole number by a certain fraction. These values may warrant further review. In the 
Ambiguous if rounded > field, specify how much the calculated value must deviate 
from the nearest whole number for it to be flagged.

Finally, specify how to identify the ambiguous values using the Flag with * button or 
the Leave Blank button.

When you have entered all the information in the dialog box, click on the Done 
button. The number of tandem repeats will be displayed next to the bands. (Note that 
if no standards have been defined on the gel, no numbers will be displayed.)

If the numbers have been concealed (e.g., by the Hide Overlays command), you can 
redisplay them by selecting VNTR Display.

PCR Primer

Sequence between primer and VNTR

VNTR repeat unit
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12.Reports
Quantity One can display and print a variety of analysis reports. You can format the 
reports to include different kinds of data.

The available reports are listed under the Reports menu.

Fig. 12-1. Reports Menu.

12.1 Report Window
Many of the reports share the same basic report window.
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Fig. 12-2. Example of a report window.

The standard report window has buttons for printing the report, scrolling through the 
screen pages of the report, and exporting the report to a spreadsheet application. Some 
report windows also have a Reformat button for changing the data display.

To close a report window, click on the Close box in the upper right corner of the 
window.

Print One Page Print All Pages Export Reformat
Controls for scrolling
through screen pages

Click here to close the report window
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Scrolling

If a report has multiple pages, the scroll buttons in the report window become active. 
Use them to scroll to the next page, previous page, first page, or last page of the 
report. You can also enter a specific page number in the field to skip to that page.

Printing

Print the report using the Print One Page or Print All Pages commands in the report 
window.

Click on either of these buttons to open a smaller version of the standard print dialog 
(described in the next chapter).

Fig. 12-3. Print Report dialog.

Print One Page prints only the current screen page. Print All Pages prints all the 
pages in the report.

Windows version:

Macintosh version:
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Note: If you select Print All Pages, the number of pages printed may be less than the 
number of screen pages listed in the report window. This is because the print 
command reformats the data to make maximum use of the paper size.

Exporting Report Data

You can export the report data to a spreadsheet application for further computation 
and analysis.

Click on the Export button to open the Export Report dialog.

Fig. 12-4. Export Report dialog.

Exported data can be separated by commas or tabs, depending on the requirements of 
your spreadsheet application.

You can save the data to a text file or to the clipboard by selecting the appropriate 
option button. If you select File, when you click on OK a dialog will open in which 
you can save the file.

Reformatting Report Data

Click on the Reformat button to open the options dialog for the report and select 
different display options. This button is not available in all reports.
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12.2 Lane and Match Reports
There are four different lane and match reports: Lane Report, All Lanes Report, 
Match Report, and All Matches Report.

Lane Report generates a report on any you lane you select. First select the report 
from the Reports menu, then click on the particular lane.

All Lanes Report generates a report on all the lanes in the current gel image.

Match Report generates a report on a matched band that you select. First select the 
report from the menu, then click on a matched band. This report requires band 
matching (see section 6.2, Band Matching).

All Matches Report generates a report on all the matched bands in the gel . This 
report requires band matching (see section 6.2, Band Matching).

When you select any of these reports, the Report Options dialog will open, where you 
can specify the type and formatting of the data.

Fig. 12-5. Report Options dialog.
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Select the data to display using the checkboxes.

Select the Font Size, Column Spacing, and Line Spacing settings to be used in the 
report by clicking on the button next to each field and selecting from the list of 
options.

To save the report options, click on the Modify Report Settings button and enter a 
name for the report settings in the field.

To load or delete previously saved settings, click on the button next to the Settings to 
Load or Delete field and select from the list of saved settings. Then click on Load or 
Delete.

To display the report, click on the Report button. The report will be displayed in a 
standard report window (see section 12.1, Report Window).

12.3 Band Types Report
The Band Types Report shows the presence or absence of specific bands in specific 
lanes of a gel. The report window displays a schematic representation of all the bands 
and lanes in the gel, with the presence or absence of bands shown as specified in the 
options dialog.
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Fig. 12-6. Band Type Report.

Note: This report requires band matching (see section 6.2, Band Matching).

Select the report from the Reports menu, and select the display options in the Band 
Types Report Options dialog.

To save the report options, click on the Settings button in the options dialog and enter 
a name for the settings in the field. To load or delete previously saved settings, click 
on the button next to the Settings to Load or Delete field and select from the list of 
saved settings. Then click on Load or Delete.

To display the report, click on the Report button. 

This report window includes two additional options: Page Setup and Print Preview.

Page Setup Print Preview
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Fig. 12-7. Page Setup dialog.

The Page Setup dialog includes controls for selecting the paper size and orientation, 
paper tray, page margins, and printer. The Print Preview dialog displays the report as 
it will be printed.

12.4 1-D Analysis Report
The 1-D Analysis Report displays all the advanced analysis data (including band 
types, normalized quantities, amount of sample loaded, etc.) for all the lanes in the 
gel. The lanes will also be ranked in similarity to the lane you initially select to 
generate the report.

Note: This report requires band matching (see section 6.2, Band Matching).

Select 1-D Analysis Report from the Reports menu, then click on any experimental 
lane in the gel. A dialog will pop up, in which you can select the report data to 
display.
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Fig. 12-8. 1-D Analysis Report options.

To display the selected data, click on the Report button. The report will be displayed 
in a standard report window (see section 12.1, Report Window).

12.5 Similarity Comparison Reports
Quantity One has three reports for comparing the similarity of lane-based samples in 
a gel: Compare Lane Images, Phylogenetic Tree, and Similarity Matrix.

Note: These reports require band matching (see section 6.2, Band Matching).

Comparison Options

Before opening any of these reports, select Comparison Options from the Reports 
menu to specify some similarity settings.
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Fig. 12-9. Comparison Options dialog.

In the Comparison Options dialog, select All Bands to include every band in the 
sample similarity comparison, or selected Classified Bands to include only matched 
bands.

Next to Weighted, select Yes to use both band position and intensity when comparing 
sample similarity. Select No to use only band position when comparing samples. The 
next section describes how weighting is used in the similarity comparion equation.

Comparison Method

The method for computing similarity in Quantity One is the Dice Coefficient. The 
formula for the Dice Coefficient is:

where S and T are vectors representing two lanes in the same band set that are being 
compared.

To compute similarity, a vector is constructed that represents the bands identified in 
the lane. The vector depends on the comparison options (see above) selected. If the 
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search was done on classified (matched) bands only, then the vector S contains B 
elements (S = (s1, s2, s3 ... sB)), where B is the number of band types in the lane's 
band set. The values for s1, s2, s3 ... sB have the following values:

Weighting Off Search

si = 1 if the i'th band type is found in the lane.

si = 0 if it is not found.

Weighting On Search

If the band set has a normalizing band type, then:

si = The normalized density of the band assigned to the i'th band type.

si = 0 if the lane does not have a band assigned to the i'th type.

Otherwise:

si = The quantity of the band assigned to the i'th band type.

si = 0 if the lane does not have a band assigned to the i'th type.

12.5.a Compare Lane Images

The Compare Lane Images report displays the lanes in decreasing order of 
similarity to a lane that you select.

Select Compare Lane Images from the Reports menu, then click on a reference lane. 
Select the report features in the pop-up box.
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:

Fig. 12-10. Compare Lane Images options.

If you select the Images option, actual images of the lanes will be displayed in the 
report. If you select Diagrams, schematic representations of the lanes will be 
displayed.

To display the selected data, click on the Report button.
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Fig. 12-11. Compare Lane Images report.

The Compare Lane Images report is displayed in a standard report window (see 
section 12.1, Report Window). Change the report options by clicking on the 
Reformat button.

The Print Report dialog for this report contains special fields for entering a report 
title.
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12.5.b Phylogenetic Tree

Phylogenetic trees are schematic representations of sample similarity. To compare the 
similarity of samples in a phylogenetic tree format, select Phylogenetic Tree from the 
Reports menu. (You can also select Phylogenetic Tree Quick Guide under the Help 
menu to guide you through the process of generating a phylogenetic tree.)

In the pop-up box, select a clustering method for creating the tree. See the following 
pages for information about the different methods.

Fig. 12-12. Phylogenetic Tree.

Note: We have found that Ward's method, UPGAMA, and WPGAMA give the most 
plausible clusters and are affected the least by samples that are outliers.
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The report window for a phylogenetic tree is slightly different than the standard report 
window. The tree appears in a window with scroll bars for moving up and down and 
left and right.

To print the tree, click on the Print button.

Click on the Cluster Method button to select a different clustering method for 
displaying the tree. This will automatically recalculate and redisplay the tree.

Neighbor Joining

This type of phylogenetic tree is computed is based on minimizing the total branch 
length at each stage of clustering. The method also finds branch lengths between 
nodes. The approximate distance between any two samples in this tree can be found 
by adding the branch lengths that connect the samples. 

Other Methods1,2

The following methods are based on the algorithm below:

1. Begin with n clusters—one cluster for each sample.

2. Compute the similarity matrix for the samples. 

3. Convert the similarity matrix into a distance matrix d using the appropriate 
distance formula.

4. Join the two clusters with the minimum distance into one cluster. Compute the 
similarity value for this cluster.

5. Recompute the distance matrix d using the cluster that was formed in Step 4.

Steps 4 and 5 are repeated until there is only one cluster. The difference between the 
methods below is based on the definition of minimum distance in Step 4, and on the 

1. For a complete explanation of the calculations and assumptions used 
to generate these dendrograms, please refer to Sneath and Sokal. 
Numerical Taxonomy, San Francisco: W. H. Freeman & Company, 
1973.

2. Vogt and Nagel, Clinical Chemistry 38 (2): 182-198, (1992).
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method of computing the new distance matrix in step 5. In the discussion that follows, 
let:

p, q be indices indicating two clusters that are to be joined into a single cluster.

k be the index of the cluster formed by joining clusters p and q.

i be the index of any remaining clusters other than cluster p, q, or k.

np the number of samples in the p'th cluster.

nq the number of clusters in the q'th cluster.

n the number of clusters in the k'th cluster formed by joining the p'th and q'th cluster. 
n = np + nq

dpq the distance between cluster p and cluster q.

Single Linkage

This is also called Nearest Neighbor or Minimum Method.

Complete Linkage

This is also called the Furthest Neighbor or Maximum Method.

Single and Complete linkage are good algorithms for indicating outlier clusters. 

UPGAMA

Unweighted pair group method using arithmetic averages. This is also called 
Weighted Average Linkage.

dki min dpi dqi( , )=

dki max dpi dqi( , )=

dki
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n
-----⎝ ⎠
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n
-----⎝ ⎠
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WPGAMA

Weighted pair group method using arithmetic averages. This is also called Average 
Linkage.

WPGAMA is a special case of UPGAMA that favors the most recent member clusters 
in forming new clusters.

Centroid

Median

Centroid and Median are similar to UPGAMA and WPGAMA, respectively, but the 
distance formula contains an additional third term. Centroid and Median methods are 
not monatomic hierarchical clustering algorithms. In other words, the similarity value 
between cluster k and any other cluster may be greater than the similarity between 
cluster p and cluster q. This condition occurs if the centroids (or medians) of the 
different clusters have approximately the same distance as the distances between the 
samples that make up the cluster.

Ward's

This method attempts to minimize the information by describing a set of N samples 
using a fewer number of clusters.
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Options

Click on the Options button in the Phylogenetic Tree window to open the Options 
dialog.

Fig. 12-13. Two forms of the Options dialog.

The box on the left has controls that are specific for the Neighbor Joining method. 
The box on the right is applicable to the other tree methods. Both boxes share certain 
features.

Each allows you to choose between aligning the tree to the right or proportionally 
aligning it. Right alignment uses a fixed branch length for displaying the distance 
between nodes; proportional alignment differs for Neighbor Joining and other tree 
modes.

With the Neighbor Joining method, proportional alignment shows branch length sizes 
proportional to the min/max values set in the Options dialog. Other methods plot the 
nodes at locations determined by their similarity values.

The Fit Tree in Window option scales the tree so that the entire tree will fit onto a 
single printed page. With this turned off, the entire tree will appear with the correct 
distances between nodes preserved, and the printed tree can be tiled across multiple 
sheets of paper.

The Neighbor Joining Options dialog, click on the Designate New Root button to 
designate a new root node (the node at the very top of the tree), enabling you to look 
at the relationships between lanes from a different perspective. This will highlight all 
the nodes in the tree. Click on the node that you want to serve as the new root and the 

Neighbor Joining Only

All Other Methods
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dendrogram will be recalculated. To return to the original tree, click on Restore 
Original Tree.

The Min. and Max. sliders are active only for proportionally aligned Neighbor 
Joining trees. Use them to adjust the minimum and maximum distances between 
nodes on branches to highlight specific regions of data. Distances below the Min. or 
above the Max. values will be collapsed to fit in the window.

For non-Neighbor Joining trees, use the Clusters option to define the number of 
clusters (0 to 18) in the tree. The separate clusters will be identified in the tree by 
letters.

12.5.c Similarity Matrix

The Similarity Matrix report compares the similarity of all the lanes to one another. 
If there are N lanes in the gel, then the similarity matrix is an N by N matrix that is 
computed using the Dice Coefficient as described in section 12.4, 1-D Analysis 
Report.

The matrix has the following properties:

• The diagonal elements always have values of 100. This is because a lane is 
always 100 percent similar to itself.

• The matrix is symmetrical (Mij = Mji).

Select Similarity Matrix from the Reports menu to open this report.
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Fig. 12-14. Similarity Matrix report.

The Similarity Matrix report is displayed in a standard report window (see 
section 12.1, Report Window).

12.6 Volume Analysis Report
The Volume Analysis Report displays volume data.

Select Volume Analysis Report from the Reports menu or Volume toolbar. The 
Volume Report Options dialog will open, in which you can specify the information 
that will appear in the report.
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When you click on OK, the report will be displayed in a standard report window (see 
section 12.1, Report Window).

12.6.a Volume Report Options

Fig. 12-15. Volume Report Options dialog.

The volume report options are described below:

• Name—The name that is automatically assigned to the volume based on its type 
(U=Unknown, Std=Standard, B=Background) and order in which it was created.

• Type—Unknown, standard, or background.

• Volume—Sum of the intensities of the pixels inside the volume boundary x area 
of a single pixel (in mm^2).

• Adj. Vol.—Volume minus the background volume; if there is no background 
volume, this is simply the volume.
12-21



Quantity One User Guide
• % Volume—The volume expressed as a percentage of all the volumes in the 
image.

• Concentration—The quantity as calculated from the standards and the 
regression method. If you have not defined standards, this is not calculated.

• Area—The total area of the volume box you have drawn in mm^2.

• Mean Value—The mean intensity of the pixels inside the volume boundary.

• Std. Deviation—The standard deviation from the mean intensity.

• Min. Value—The value of the lowest intensity pixel in the volume.

• Max. Value—The value of the highest intensity pixel in the volume.

• Density—The total intensity of all the pixels in the volume divided by the area of 
the volume.

• Mean Background—The mean intensity of the pixels in the background 
volume.

• Num. Pixels—The number of pixels inside the volume.

• X location—The distance in mm from the left edge of the image to the center of 
the volume.

• Y location—The distance in mm from the top edge of the image to the center of 
the volume.

• Width—The width of the volume in mm.

• Height—The height of the volume in mm.

Specify the preferred Background Subtraction Method (Global or Local).

Note: If you select Global and have not defined a background volume, no background 
subtraction will be performed on the image.

The Image Display Options affect how the image is displayed and/or printed on the 
report.

You can choose whether to report on all volume objects (All objects) or only those 
objects you have selected (Selected objects)

Select the regression method for calculating the Volume Regression Curve. To 
display the curve, click on the Show Curve button.
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Select the Font Size and Line Spacing settings to be used in the report by clicking on 
the button next to each field and selecting from the list of options.

Saving the Report Options

To save the report options, click on the Modify Report Settings button at the bottom 
of the dialog. In the pop-up dialog, enter a name for the report settings in the field.

To load or delete previously saved settings, click on the button next to the Settings to 
Load or Delete field and select from the list of saved settings. Then click on Load or 
Delete.

12.7 Volume Regression Curve
If you have defined at least two standard volumes on the image, you can display a 
regression curve for calculating the quantities of the unknowns.

Note: Volumes that fall above the greatest standard value, or below the lowest standard 
value, cannot be guaranteed for accuracy.

Select Volume Regression Curve from the Reports menu.
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Fig. 12-16. Volume Regression Curve window.

On the curve, each standard volume is marked by a red X and each unknown is 
marked by a blue triangle.

The X axis is the adjusted volume and the Y axis is the concentration, based on the 
standards you have marked on the image.

To display the numbers and names of the volumes, click on the Show Name 
checkbox.

Select the preferred regression method from the list of option buttons. The regression 
equation for the selected method is displayed in the lower left of the window.
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To print the curve, click on the Print button. To close the window, click on the OK 
button.

12.8 VNTR Report
The VNTR Report displays the calculated VNTR data (see section 11.2, Variable 
Number Tandem Repeats).

Select VNTR Report from the Reports menu. A pop-up box will ask if you want to 
display the gel image in the report.

Fig. 12-17. Example of a VNTR Report.
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The report is displayed in a standard report window (see section 12.1, Report 
Window).

The report displays the molecular weight, the raw repeat number, and the rounded 
repeat number for each band in the gel image.

The raw repeat number is the number of repeats calculated using the information that 
you provided in the Tandem Repeat Calculation dialog, and is likely to include 
fractional values. The rounded repeat number is the raw repeat number rounded to the 
nearest whole number. 

An asterisk (*) will appear next to some of the rounded repeat numbers if you selected 
Test for Ambiguity and Flag with * in the Tandem Repeat Calculations dialog. The 
asterisk will appear next to numbers that vary from the raw repeat number by more 
than the selected ambiguity value.
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The commands for printing and exporting images are located on the File menu.

Reports are printed from within the individual report windows.

13.1 Print Image
Print Image prints a copy of the active image window and any image overlays that are 
displayed. The Print Image command opens the standard print dialog box for your 
operating system. When you are satisfied with all the print parameters, click Print to 
send the image to the printer.

13.2 Page Setup
Specify the printer settings using the Page Setup command on the File > Print 
submenu. This will open the standard Page Setup dialog box for Windows or 
Macintosh, in which you can select the paper size, page orientation, printer, etc.

13.3 Print Settings
Use the Print Settings command to configure what information to include and how the 
image appears each time you print an image. To open Print Settings, click Print 
Settings in the File>Print submenu. Any changes made to the Print Settings take 
effect immediately. You can also leave the Print Settings dialog box open to quickly 
change the settings for images as you print.

Note: You can have multiple Print Settings dialog boxes open, one for each open 
image, with different settings. However, If you use the print command 
(file>Print>Print Image or CTRL+P) for an image that does not have the Print 
Settings dialog box open, the print format will be based on the last Print Settings 
dialog box where changes were made.
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Fig. 13-1. 

Under the Headers and Footers settings, select what information you want to include 
in your prints. 

File name - Select File name add the name of the image file to the header of the 
print.\
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Acquisition Info - If Acquisition Info is selected, the date the image was acquired 
and the data range of the scan is included in the footer information.

Time printed - To add the date and time the image was printed, select Time printed.

Page number - Select Page number to add the page number to the footer information. 

The Pagination settings determine allow you to determine whether to print your 
images actual size or fit the images to the page.

Fit Image to Page - This fits the current view of the image to a single page based on 
the layout of the image. 

Print Actual Size - Select Print actual size to print your images based on the scan size 
of the gels.

Note: If you are using the Gel Doc EQ, ChemiDoc EQ, Fluor-S, or Fluor-S MAX, you 
must specify the correct image area size when capturing your images to ensure 
accurate 1:1 printing. You can specify the image area size in the acquisition 
window for the instrument. See the chapter on each imaging device for more 
information.

Under Image you can add a border to the image area of the prints. Adding a border is 
useful for determining the edges of faint images.

Click the Page Setup button to open the Page Setup dialog box. Note that, although 
you can print directly from the Print Settings dialog box by clicking either Print or 
Print Current Page, the print settings affect each image printed using the Print Image 
command.

Note: The Print Settings dialog box attempts to accurately display the image exactly 
how it will print. However, in some cases, such as images with large pixel 
dimensions set to Print Actual Size, small differences may be noticed between 
the preview window and the actual print.

13.4 Image Report
The Image Report displays the image and basic image information, including the 
image dimensions, pixel size, date of scan, type of imager, etc.
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To print an image report for a particular gel, select Image Report from the File > 
Print submenu. This will open a smaller version of the standard printer dialog box.

Fig. 13-2. Image Report.

Note: TIFF images do not contain all the tagged information that would normally be 
included in an image file (for example, imaging device, scan date, image color, 
etc.). For this reason, the Image Report may list this information as “Unknown” 
for imported TIFF files.

13.5 Video Print
Select Video Print from the File > Print submenu to print images and reports to a 
video printer. 
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Note: Video printing requires installation of the video board and cable that come with 
the Gel Doc EQ and ChemiDoc EQ systems. The video board and cable can also 
be ordered separately.

Settings for the Mitsubishi P90W/P91W Video Printer

There are three settings for the Mitsubishi P90W/P91W video printer. Set Contrast to 
zero, Brightness to zero, and Gamma to 5.

The dip switches should stay in the orientation in which they are shipped: Pin 1 is up 
(on), and Pins 2–10 are down (off).

13.6 Export to TIFF Image
You can export images in TIFF format for analysis and publishing using other 
applications. Select Export to TIFF Image from the File menu to open a dialog box 
in which you can specify the export parameters.
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Fig. 13-3. Export to TIFF Image dialog box.

There are two basic export options:

• Export the raw image data for further analysis

• Export the displayed view of the image for publishing.

If you choose to export the displayed view, you can export with or without the image 
overlays.

13.6.a Analysis Export Mode

To export a TIFF image for further analysis, select the Export raw data button. The 
publishing controls in the dialog box will become inactive.
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13.6.b Publishing Export Mode

To export a TIFF image that looks like the image as it is currently displayed on the 
screen, select one of the options under Publishing.

Export View Including Overlays

Select this option to include overlays with the exported image. The other controls in 
the dialog box will become inactive.

Export View Excluding Overlays 

Select this option to not include overlays with the exported image. This is the only 
mode available if you are exporting images from the Multi-channel Viewer (see 
section 3.4, Multi-Channel Viewer).

With this option selected, specify a resolution for the TIFF image by selecting 72 dpi 
(typical computer screen resolution), 150 dpi, 300 dpi (standard printing resolution), 
Same As Scan, or any resolution that you enter in the Specify field (up to the 
resolution of the scan).

Under Transform, you can specify a Linear transform or preserve the Current View 
(which is automatically log transformed).

Images with a higher Bit Depth (e.g., 16 bit or 24 bit RGB) can be compressed to a 
lower bit depth (e.g., 8 bit) during export.

Note: TIFF images are automatically exported from the Multi-channel Viewer in 24 bit 
RGB mode to preserve the colors displayed in the viewer.

Finally, if you are only displaying part of the image due to magnification or 
repositioning, you can preserve the Current View or export the Entire Image.

13.6.c Exporting the Image

The size of the pixels in the image and the file size of the image are listed at the 
bottom of the dialog. When you are ready to export, click on the Export button.

In the Save As dialog box, the default file name will have a .tif extension, and the file 
type will indicate that this is a TIFF image.
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13.7 Exporting a JPEG Image
The Export to JPEG Image command allows you to export an image as a JPEG 
image. The Export to JPEG Image is primarily  for exporting your images for use in 
reports, presentations, etc. rather than a TIFF image because a JPEG image is 
considerably smaller in size than a TIFF image. Unlike TIFF images, JPEG images 
cannot be opened by TDS applications.

To export an image as a JPEG, open the File menu and click Export to JPEG Image. 
This opens the Export to JPEG Image dialog box.

Fig. 13-4. Exporting to JPEG

In the Export to JPEG dialog box, under Export mode, use the slider to adjust the 
image quality. The higher the quality, the larger the file size.

Click Export to complete the operation. The default file name and location are based 
on the original image. You can change the file name or select a different folder to save 
in. Click Save to complete the export.
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Gel Doc EQ

Fig. A-1.  Gel Doc EQ.

Before you can begin acquiring images, the Gel Doc EQ system must be properly 
installed and connected with the host computer. See the Gel Doc EQ hardware 
manual for installation, startup, and operating instructions.
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To use the Gel Doc EQ, you will need to have the Bio-Rad-supplied acquisition board 
installed in your PC or Macintosh. The drivers for this board will be installed when 
you install the main software application.

Make sure that your Gel Doc EQ camera is turned on. If the camera is not turned on, 
the Gel Doc EQ acquisition window will open and an image capture error will be 
displayed.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “simulation mode.” 
In this mode, an acquisition window will open and the controls will appear active, but 
instead of capturing real images, the window will create “dummy” images of 
manufactured data.

You do not need to be connected to an imaging device to open a simulated acquisition 
window. This is useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device 
from the File menu. The title of the acquisition window will indicate that it is 
simulated.

A.1 Gel Doc EQ Acquisition Window
To acquire images using the Gel Doc EQ, go to the File menu and select Gel Doc 
EQ.... The acquisition window for the instrument will open, displaying a control 
panel and a video display window. 
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Fig. A-2.  Gel Doc EQ acquisition window

The Gel Doc EQ video display window will open in “live” mode, giving you a live 
video display of your sample. If no image is visible, make sure the camera is on, 
check the cable connections, make sure the iris on the camera is not closed, and make 
sure that the protective cap is off the camera lens. Also check to see that the 
transilluminator is on and working.

The control panel has been arranged from top to bottom to guide you through the 
acquisition procedure. There are six basic steps to acquiring an image using the Gel 
Doc EQ:

1. Position and focus the gel or other object to be imaged.

2. Select Mode.

3. Acquire the image.
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4. Optimize the display.

5. Analysis.

6. Select the output.

A.2 Step I. Position Gel
The Gel Doc EQ window will open in “live” mode, giving you a live video display of 
your sample.  In this mode, the Live/Focus button will appear selected, and frames 
will be captured and displayed at about 10 frames per second, depending on the speed 
of your computer.

You can use live mode to zoom, focus, and adjust the aperture on the camera, while 
positioning the sample within the area.

Note: Newer versions of the Gel Doc EQ feature a motorized zoom lens that can be 
controlled directly from the acquisition window using the Iris, Zoom, and Focus 
arrow buttons. Click on the Up/Down buttons while viewing your sample in the 
window to adjust the lens. These buttons will not be visible if you are connected 
to older versions of the Gel Doc EQ without the motorized zoom lens.

Fig. A-3.  Newer Gel Doc EQs feature camera control buttons in the acquisition window. 

You can also select the Show Alignment Grid checkbox to facilitate positioning.

Note: After positioning your sample, you should check the Imaging Area dimensions 
under Options (see section A.9, Options) to make sure that they conform to the 
size of the area you are focusing on. To determine the size of the area you are 
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focusing on, you can place a ruler in the Gel Doc EQ cabinet so that it is visible 
in the image.

A.3 Step II. Select Image Mode
The Image Mode option buttons allow you to set the type and scale of your data.

UV

Select this mode for fluorescent samples. With this mode selected, the data will be 
measured in linear intensity units.

White Light

Select this mode for reflective and transmissive samples. With this mode selected, the 
data will be measured in uncalibrated optical density (uOD) units.

A.4 Step III. Acquire Image
For many white light applications, you can skip this step and save and print images 
directly from Live/Focus mode.

For UV light or faint samples, you can take an automatic exposure based on the 
number of saturated pixels in the image or you can enter a specific exposure time. 

Note: “Exposure” refers to the integration of the image on the camera CCD over a 
period of time. The effect is analogous to exposing photographic film to light 
over a period of time.

Auto Expose

Auto Expose will take an exposure whose time length is determined by the number of 
saturated pixels in the image. This is useful if you are uncertain of the optimal 
exposure length.
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Note: If you know the approximate exposure time you want (± 3 seconds), you can skip 
this step and go directly to Manual Expose.

 Click on the Auto Expose button to cancel Live/Focus mode and begin an automatic 
exposure. The Auto Expose button will appear selected throughout the exposure.

During the auto exposure, the image is continuously integrated on the camera CCD 
until it reaches a certain percentage of saturated pixels. This percentage is set in the 
Options dialog box. (Default = 0.15 percent. See section A.9, Options.)

Fig. A-4.  Auto Expose.

Once an image has reached the specified percent of saturated pixels, it is captured and 
displayed in the video display window, Auto Expose is automatically deactivated, the 
exposure time appears active in the Exposure Time field, and Manual Expose is 
activated.

Note: If you are having difficulty auto-exposing your sample, you can use Manual 
Expose to adjust your exposure time directly. Most applications only require an 
exposure time of a few seconds, which can be quickly adjusted using Manual 
Expose.

Manual Expose

If you know the approximate exposure time you want, you can click on the Manual 
Expose button. Manual Expose is automatically activated after Auto Expose has 
deactivated.

Click on Auto Expose;
button appears depressed

Can see Exposure Time
automatically changing
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Fig. A-5.  Manual Expose.

With Manual Expose activated, you can adjust the exposure time directly by changing 
the number of seconds in the Exposure Time field. Type in a number or use the arrow 
buttons next to the field.

When the specified exposure time is reached, the last captured image will be 
displayed in the Gel Doc EQ image window. The camera continues to integrate the 
image on the CCD, updating the display whenever the specified number of seconds is 
reached.

Once you are satisfied with the quality of the displayed image, click on the Freeze 
button to stop the exposure process. The last full exposure will be displayed in the 
image window.

Fig. A-6.  Freezing the exposure.

Manual Expose active;
button appears selected

Exposure Time field active;
adjust number of seconds

Click on Freeze to stop
the exposure process
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Note: Freeze is automatically activated if you adjust any of the subsequent controls 
(e.g., Video Print, Image Mode, Display controls, etc.).

A.5 Step IV. Optimize Display
The Display controls are useful for quickly adjusting the appearance of your image 
for output to a video printer. Adjusting these controls will automatically freeze the 
video display and allow you to alter the image within the Gel Doc EQ window.

Fig. A-7.  Display controls.

These controls are similar to those in the Transform dialog box.

Note: The Display controls will only change the appearance of the image. They will not 
change the underlying data.

High/Low Sliders

If Auto-scale doesn’t give you the appearance you want, you can use the High and 
Low sliders to redraw the image yourself. In white light mode, dragging the High 
slider handle to the left will make weak signals appear darker. In UV mode, dragging 
the High slider handle to the left will make weak signals appear brighter. Dragging 
the Low slider handle to the right will reduce background noise.

You can also type specific High and Low values in the text boxes next to the sliders. 
Clicking anywhere on the slider bars will move the sliders incrementally.
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Gamma Slider

Some images may be more effectively visualized if their data are mapped to the 
computer screen in a nonlinear fashion. Adjusting the Gamma slider handle changes 
the light and dark contrast nonlinearly.

Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in 
red in the scan window and in the pop-up image window. To view/hide saturated 
pixels in the pop-up image window, use the Image > Transform command.

Invert Display

This checkbox will switch light spots on a dark background to dark spots on a light 
background, and visa versa. This will only affect how the image is displayed on the 
screen, not the actual image data.

Auto-scale

Clicking on Auto-scale will adjust your displayed image automatically. The lightest 
part of the image will be set to the minimum intensity (e.g., white), and the darkest 
will be set to the maximum intensity (e.g., black). You can then “fine tune” the 
display using the High, Low, and Gamma sliders described below.

Reset

Reset will return the image to its original, unmodified appearance.

A.6 Step V. Analysis
The Analysis step of the Gel Doc EQ acquisition window allows you to add 
annotations and analyze the newly acquired image.
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Annotate

Clicking on Annotate will open a separate image window displaying the captured 
image. The default name for the image will include the date, time, and user (if 
known).

The Text Overlay toolbar will also pop up to allow you to annotate your image.

The image will not be saved until you select Save or Save As from the File menu.

Analyze

Clicking on Analyze will open a separate image window displaying the captured 
image. The default name for the image will include the date, time, and user (if 
known). 

You can then analyze the image using the other features in the main application. 

The image will not be saved until you select Save or Save As from the File menu.

A.7 Step VI. Select Output
In Select Output you can select Video Print and Save as your output options. 

Fig. A-8.  Output options.

Video Print

Clicking on Video Print will automatically send the currently displayed frame (either 
live or integrated) to a video printer. You can add information about your image to the 
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bottom of the printout by selecting the appropriate checkboxes in the Options dialog 
box. (See section A.9, Options.)

Save

Clicking on Save will open a separate image window displaying the captured image. 
A Save As dialog box will automatically open displaying the default file name for the 
image, which will include the date, time, and user (if known). You can then change 
the file name and storage directory.

You can also export your image as a TIFF image for viewing with other applications.

A.8 Exposure Status
The Exposure Status bar shows the progress of your exposure. If your exposure time 
is greater than 1 second, the status bar display will give you a graphical representation 
of the remaining time before exposure is complete.

If the exposure time is less than 1 second, the status bar will not refresh itself for each 
exposure; it will remain at 100 percent.

A.9 Options
Click on the Options button to open the Options dialog box. Here you can specify 
certain settings for your Gel Doc EQ system.
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Fig. A-9.  Available options in the Gel Doc EQ acquisition window.

Click on OK to implement any changes you make in this box. Clicking on Defaults 
restores the settings to the factory defaults.

DAC Settings

Note: The default DAC settings are highly recommended and should be changed with 
caution.

These sliders may be used to adjust the minimum and maximum voltage settings of 
your video capture board. The minimum slider defines the pixel value that will appear 
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as white in the image, while the maximum slider defines the pixel value that will 
appear as black. The slider scale is 0–255, with the defaults set to 60 minimum and 
130 maximum.

Imaging Area

These fields are used to specify the size of your imaging area in centimeters, which in 
turns determines the size of the pixels in your image (i.e., resolution). When you 
adjust one imaging area dimension, the other dimension will change to maintain the 
aspect ratio of the camera lens.

Note: Your imaging area settings must be correct if you want to do 1:1 printing. These 
are also important if you are comparing the size of objects (e.g., using the 
Volume Tools) between images.

Auto Exposure Threshold

When you click on Auto Expose, the exposure time is determined by the percentage 
of saturated pixels you want in your image. This field allows you to specify that 
percentage.

Typically, you will want less than 1 percent of the pixels in your image saturated. 
Consequently, the default value for this field is 0.15 percent.

Reminder

When this checkbox is selected, the software will warn you to turn off your 
transilluminator light when you exit the Gel Doc EQ acquisition window or when 
your system is “idle” for more than 5 minutes.

Video Printing Footer Information

The checkboxes in this group allow you to specify the information that will appear at 
the bottom of your video printer printouts.

Save Options

To automatically create a backup copy of any scan you create, select the Make 
Backup Copy checkbox.
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With this checkbox selected, when you save a scan, a backup copy will be placed in 
the same directory as the scanned image. Backup images are identified by "Backup 
of" followed by the original image file name. 

Note: Backup files are read only files. If you attempt to save a backup file, you will be 
promted to give it a new name. This protects the backup file and preserves it from 
any changes.

Simple Acquisition Mode

The Simple Acquisition mode option allows you to reconfigure the Gel Doc EQ 
acquisition window to simple mode. In simple mode, the acquisition window contains 
the same steps as the advanced acquisition window with the exception of Step IV, 
Optimize display, and Step V, Analysis. Manual exposure is also disabled in simple 
mode. 

Fig.A-10. Simple Acquisition Window
A-14



Appendix A. Gel Doc
To change the acquisition window to Simple Acquisition Mode, check the box 
marked Simple Acquisition Mode. The change will take effect the next time you open 
the acquistion window.
A-15



Quantity One User Guide
A-16



Appendix B 
Gel Doc XR

Fig. B-1.  Gel Doc XR.

Before you can begin acquiring images, the Gel Doc XR system must be properly 
installed and connected with the host computer. See the Gel Doc XR hardware 
manual for installation, startup, and operating instructions.
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To use the Gel Doc XR, be sure the system is properly installed. Installation 
instructions can be founds in the Gel Doc XR Hardware Installation Manual.

Make sure that your Gel Doc XR system is powered on. If not, the Gel Doc XR 
acquisition window will not open and an error will be displayed stating the Gel Doc 
XR camera could not be found.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “simulation mode.” 
In this mode, an acquisition window will open and the controls will appear active, but 
instead of capturing real images, the window will create “dummy” images of 
manufactured data.

You do not need to be connected to an imaging device to open a simulated acquisition 
window. This is useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device 
from the File menu. The title of the acquisition window will indicate that it is 
simulated.

B.1 Gel Doc XR Acquisition Window
To acquire images using the Gel Doc XR, go to the File menu and select Gel Doc 
XR.... The acquisition window for the instrument will open, displaying a control 
panel and a video display window. 
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Fig. B-2.  Gel Doc XR acquisition window

The Gel Doc XR display window will open in “live” mode, giving you a live display 
of your sample. If no image is visible, make sure the camera is on, check the cable 
connections, make sure the iris on the camera is not closed, and make sure that the 
protective cap is off the camera lens. Also check to see that the transilluminator is on 
and working.

The control panel has been arranged from top to bottom to guide you through the 
acquisition procedure. There are six basic steps to acquiring an image using the Gel 
Doc XR:

1. Position and focus the gel or other object to be imaged.

2. Select an illumination mode.

3. Acquire the image.
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4. Optimize the display.

5. Analyze the image.

6. Select the output.

B.2 Step I. Position Gel
The Gel Doc XR window will open in “live” mode, giving you a live display of your 
sample.  In this mode, the Live/Focus button will appear selected, and frames will be 
captured and displayed.

You can use live mode to zoom, focus, and adjust the aperture on the camera, while 
positioning the sample within the area.

Note: The Gel Doc XR features a motorized zoom lens that can be controlled directly 
from the acquisition window using the Iris, Zoom, and Focus arrow buttons. 
Click on the Up/Down buttons while viewing your sample in the window to 
adjust the lens.

Fig. B-3.  Camera control buttons in the acquisition window. 

You can also select the Show Alignment Grid checkbox to facilitate positioning.

Note: After positioning your sample, you should check the Imaging Area dimensions 
under Options (see section B.9, Options) to make sure that they conform to the 
size of the area you are focusing on. To determine the size of the area you are 
focusing on, you can place a ruler in the Gel Doc XR cabinet so that it is visible 
in the image.
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B.3 Step II. Select Image Mode
The Image Mode option buttons allow you to set the type and scale of your data.

UV

Select this mode for fluorescent samples. With this mode selected, the data will be 
measured in linear intensity units.

White Light

Select this mode for reflective and transmissive samples. With this mode selected, the 
data will be inverted so that darker areas will be of higher intensity levels.

B.4 Step III. Acquire Image
For many white light applications, you can skip this step and save and print images 
directly from Live/Focus mode.

For UV light or faint samples, you can take an automatic exposure based on the 
number of saturated pixels in the image or you can enter a specific exposure time. 

Note: “Exposure” refers to the integration of the image on the camera CCD over a 
period of time. The effect is analogous to exposing photographic film to light 
over a period of time.

Auto Expose

Auto Expose will take an exposure whose time length is determined by the number of 
saturated pixels in the image. This is useful if you are uncertain of the optimal 
exposure length.

Note: If you know the approximate exposure time you want, you can skip this step and 
go directly to Manual Expose.

Click on the Auto Expose button to cancel Live/Focus mode and begin an automatic 
exposure. The Auto Expose button will appear selected throughout the exposure.
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During the auto exposure, the image is continuously integrated on the camera CCD 
until it reaches a certain percentage of saturated pixels. This percentage is set in the 
Options dialog box. (Default = 0.15 percent. See section B.9, Options.)

Fig. B-4.  Auto Expose.

Once an image has reached the specified percent of saturated pixels, it is captured and 
displayed in the display window, Auto Expose is automatically deactivated, the 
exposure time appears active in the Exposure Time field, and Manual Expose is 
activated.

Note: If you are having difficulty auto-exposing your sample, you can use Manual 
Expose to adjust your exposure time directly. Most applications only require an 
exposure time of a few seconds, which can be quickly adjusted using Manual 
Expose.

Manual Expose

If you know the approximate exposure time you want, you can click on the Manual 
Expose button. Manual Expose is automatically activated after Auto Expose has 
deactivated.

Click on Auto Expose;
button appears depressed

Can see Exposure Time
automatically changing
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Fig. B-5.  Manual Expose.

With Manual Expose activated, use the arrow buttons next to the field to adjust the 
exposure. You can also type in the new exposure time then press ENTER for the 
change to take effect.

When the specified exposure time is reached, the last captured image will be 
displayed in the Gel Doc XR image window. The camera continues to integrate the 
image on the CCD, updating the display whenever the specified number of seconds is 
reached.

Once you are satisfied with the quality of the displayed image, click on the Freeze 
button to stop the exposure process. The last full exposure will be displayed in the 
image window.

Fig. B-6.  Freezing the exposure.

Note: Freeze is automatically activated if you adjust any of the subsequent controls 
(e.g., Print, Image Mode, Display controls, etc.).

Manual Expose active;
button appears selected

Exposure Time field active;
adjust number of seconds

Click on Freeze to stop
the exposure process
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B.5 Step IV. Optimize Display
The Display controls are useful for quickly adjusting the appearance of your image 
for output to a printer. Adjusting these controls will automatically freeze the display 
and allow you to alter the image within the Gel Doc XR window.

Fig. B-7.  Display controls.

These controls are similar to those in the Transform dialog box.

Note: The Display controls will only change the appearance of the image. They will not 
change the underlying data.

High/Low Sliders

If Auto-scale doesn’t give you the appearance you want, you can use the High and 
Low sliders to redraw the image yourself. In white light mode, dragging the High 
slider handle to the left will make weak signals appear darker. In UV mode, dragging 
the High slider handle to the left will make weak signals appear brighter. Dragging 
the Low slider handle to the right will reduce background noise.

You can also type specific High and Low values in the text boxes next to the sliders. 
Clicking anywhere on the slider bars will move the sliders incrementally.
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Gamma Slider

Some images may be more effectively visualized if their data are mapped to the 
computer screen in a nonlinear fashion. Adjusting the Gamma slider handle changes 
the light and dark contrast nonlinearly.

Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in 
red in the scan window and in the pop-up image window. To view/hide saturated 
pixels in the pop-up image window, use the Image > Transform command.

Invert Display

This checkbox will switch light spots on a dark background to dark spots on a light 
background, and visa versa. This will only affect how the image is displayed on the 
screen, not the actual image data.

Auto-scale

Clicking on Auto-scale will adjust your displayed image automatically. The lightest 
part of the image will be set to the minimum intensity (e.g., white), and the darkest 
will be set to the maximum intensity (e.g., black). You can then “fine tune” the 
display using the High, Low, and Gamma sliders described below.

Reset

Reset will return the image to its original, unmodified appearance.

B.6 Step V. Analysis
The Analysis step of the Gel Doc XR acquisition window allows you to add 
annotations and analyze the newly acquired image.
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Annotate

Clicking on Annotate will open a separate image window displaying the captured 
image. The default name for the image will include the date, time, and user (if 
known).

The Text Overlay toolbar will also pop up to allow you to annotate your image.

The image will not be saved until you select Save or Save As from the File menu.

Analyze

Clicking on Analyze will open a separate image window displaying the captured 
image. The default name for the image will include the date, time, and user (if 
known). 

You can then analyze the image using the other features in the main application. 

The image will not be saved until you select Save or Save As from the File menu.

You can export your image as a TIFF image for analysis with other applications.You 
can also export your image as a JPEG image for use in reports and presentations.   

B.7 Step VI. Select Output
In Select Output you can Print and Save as your output options. 

Fig. B-8.  Output options.

Digital or Desktop Printer Connected Video Printer Connected
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Print

If you are printing to a desktop or digital printer, clicking Print sends the currently 
displayed frame (either live or integrated) to the printer.

If you have a video printer connected to your computer, Video Print will be displayed 
in the Select Output window.

You can add information about your image to the bottom of the printout by selecting 
the appropriate checkboxes in the Options dialog box. (See section B.9, Options.)

Save

Clicking on Save will open a separate image window displaying the captured image. 
A Save As dialog box will automatically open displaying the default file name for the 
image, which will include the date, time, and user (if known). You can then change 
the file name and storage directory.

B.8 Exposure Status
The Exposure Status bar shows the progress of your exposure. If your exposure time 
is greater than 1 second, the status bar display will give you a graphical representation 
of the remaining time before exposure is complete.

B.9 Options
Click on the Options button to open the Options dialog box. Here you can specify 
certain settings for your Gel Doc XR system.
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Fig. B-9.  Available options in the Gel Doc XR acquisition window.

Click OK to implement any changes you make in this box. 

Information

This field describes the instrument model and the camera serial number. 

Imaging Area

These fields are used to specify the size of your imaging area in centimeters, which in 
turns determines the size of the pixels in your image (i.e., resolution). When you 
adjust one imaging area dimension, the other dimension will change to maintain the 
aspect ratio of the camera lens.

Note: Your imaging area settings must be correct if you want to do 1:1 printing. These 
are also important if you are comparing the size of objects (e.g., using the 
Volume Tools) between images.
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Save Options

To automatically create a backup copy of any scan you create, select the Make 
Backup Copy check box.

With this check box selected, when you save a scan, a backup copy will be placed in 
the same directory as the scanned image. Backup images are identified by "Backup 
of" followed by the original image file name. 

Note: Backup files are read only files. If you attempt to save a backup file, you will be 
prompted to give it a new name. This protects the backup file and preserves it 
from any changes.

Auto Exposure Threshold

When you click on Auto Expose, the exposure time is determined by the percentage 
of saturated pixels you want in your image. This field allows you to specify that 
percentage.

Typically, you will want less than 1 percent of the pixels in your image saturated. 
Consequently, the default value for this field is 0.15 percent.

Reminder

When this check box is selected, the software will warn you to turn off your 
transilluminator light when you exit the Gel Doc XR acquisition window or when 
your system is “idle” for more than 5 minutes.

Print Footer Information

The check boxes in this group allow you to specify the information that will appear at 
the bottom of your printouts.

Simple Acquisition Mode

The Simple Acquisition mode option allows you to reconfigure the Gel Doc XR 
acquisition window to simple mode. In simple mode, the acquisition window contains 
the same steps as the advanced acquisition window with the exception of Step IV, 
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Optimize display, and Step V, Analysis. Manual exposure is also disabled in simple 
mode. 

Fig.B-10. Simple Acquisition Window

To change the acquisition window to Simple Acquisition Mode, check the box 
marked Simple Acquisition Mode. The change will take effect the next time you open 
the acquistion window.

Reset Reference Dark

The first time you open the Gel Doc XR acquisition window, a reference dark image 
file is generated and saved to your hard drive.  The purpose of this file is to reduce 
dark current noise generated from the CCD.  Dark current noise is typical of all CCDs 
and is a result of the accumulation of charge in the absence of light.

To reset the reference dark image, check the Reset Reference Dark checkbox. The 
next time you open the Gel Doc XR acquisition window, the software will acquire a 
new dark reference image.
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Fig.C-1. ChemiDoc EQ.

Before you can begin acquiring images, the ChemiDoc EQ system must be properly 
installed and connected with the host computer. See the ChemiDoc EQ hardware 
manual for installation, startup, and operating instructions.
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To use the ChemiDoc EQ, you will need to have the Bio-Rad-supplied acquisition 
board installed in your PC or Macintosh. The drivers for this board will be installed 
when you install the main software application.

Make sure that your ChemiDoc EQ camera is turned on. If the camera is not turned 
on, the ChemiDoc EQ acquisition window will open and an image capture error will 
be displayed.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “simulation mode.” 
In this mode, an acquisition window will open and the controls will appear active, but 
instead of capturing real images, the window will create “dummy” images of 
manufactured data.

You do not need to be connected to an imaging device to open a simulated acquisition 
window. This is useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device 
from the File menu. The title of the acquisition window will indicate that it is 
simulated.

C.1 ChemiDoc EQ Acquisition Window
To acquire images using the ChemiDoc EQ, go to the File menu and select ChemiDoc 
EQ.... The acquisition window for the instrument will open, displaying a control 
panel and a video display window. 
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Fig.C-2. ChemiDoc EQ acquisition window

The ChemiDoc EQ video display window will open in “live” mode, giving you a live 
video display of your sample. If no image is visible, make sure the camera is on, 
check the cable connections, make sure the iris on the camera is not closed, and make 
sure that the protective cap is off the camera lens. Also check to see that the 
transilluminator is on and working.

The control panel has been arranged from top to bottom to guide you through the 
acquisition procedure. There are six basic steps to acquiring an image using the 
ChemiDoc EQ:

1. Position and focus the gel or other object to be imaged.

2. Select Mode.

3. Acquire the image.
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4. Optimize the display.

5. Analysis.

6. Select the output.

C.2 Step I. Position Gel
The ChemiDoc EQ window will open in “live” mode, giving you a live video display 
of your sample.  In this mode, the Live/Focus button will appear selected, and frames 
will be captured and displayed at about 10 frames per second, depending on the speed 
of your computer.

You can use live mode to zoom, focus, and adjust the aperture on the camera, while 
positioning the sample within the area.

Note: Newer versions of the ChemiDoc EQ feature a motorized zoom lens that can be 
controlled directly from the acquisition window using the Iris, Zoom, and Focus 
arrow buttons. Click on the Up/Down buttons while viewing your sample in the 
window to adjust the lens. These buttons will not be visible if you are connected 
to older versions of the ChemiDoc EQ without the motorized zoom lens.

Fig.C-3. Live/Focus button and camera control buttons. 

You can also select the Show Alignment Grid checkbox to facilitate positioning.

Note: After positioning your sample, you should check the Imaging Area dimensions 
under Options (see section C.9, Options) to make sure that they conform to the 
size of the area you are focusing on. To determine the size of the area you are 
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focusing on, you can place a ruler in the ChemiDoc EQ cabinet so that it is 
visible in the image.

C.3 Step II. Image Mode
The Image Mode option buttons change the type and scale of the data, as well as the 
behavior of the ChemiDoc EQ when acquiring an image.

UV

Select this mode for fluorescent samples. With this mode selected, the data will be 
measured in linear intensity units.

White Light

Select this mode for reflective and transmissive samples. With this mode selected, the 
data will be measured in uncalibrated optical density (uOD) units.

Chemi

This mode is designed for chemiluminescent samples. With this mode selected, the 
data is measured in linear intensity units; however, the data is inverted, so that 
samples will appear dark on a light background.

Also, Chemi mode changes the behavior of the Auto and Manual Expose functions, as 
described above.

C.4 Step III. Acquire Image
For many white light applications, you can skip this step and save and print images 
directly from Live/Focus mode.

For UV light, chemiluminescent applications, or faint samples, the ChemiDoc EQ 
control panel has several features for creating image exposures. You can take an 
automatic exposure based on the number of saturated pixels in the image, you can 
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enter a specific exposure time, or you can take a series of exposures and select the 
best one.

Note: “Exposure” refers to the integration of the image on the camera CCD over a 
period of time. The effect is analogous to exposing photographic film to light 
over a period of time.

Auto Expose

Use Auto Expose if you want to take a single exposure but are uncertain of the 
optimal exposure time.

Note: If you know the approximate exposure time you want (± 3 seconds), you can skip 
this step and go directly to Manual Expose.

 Click on the Auto Expose button to cancel Live/Focus mode and begin an automatic 
exposure. The Auto Expose button will appear selected throughout the exposure.

During the auto exposure, the image is continuously integrated on the camera CCD 
until it reaches a certain percentage of saturated pixels. This percentage is set in the 
Options dialog box. (Default = 0.15 percent. See section C.9, Options.)

Fig.C-4. Selecting Auto Expose.

Once an image has reached the specified percentage of saturated pixels, it is captured 
and displayed in the video display window, Auto Expose is automatically deactivated, 
and the exposure time appears active in the Exposure Time field.

Click on Auto Expose;
button appears selected

Can see Exposure Time
automatically changing
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At this point, if you are in UV or White image mode, Manual Expose will be 
automatically activated. If you are in Chemi mode, the Freeze button will be 
automatically activated.

Note: If you are having difficulty auto-exposing your sample, you can use Manual 
Expose to adjust your exposure time directly. Most non-chemi applications only 
require an exposure time of a few seconds, which can be quickly adjusted using 
Manual Expose.

Manual Expose

If you know the approximate exposure time you want, you can click on the Manual 
Expose button. In UV or White image mode, Manual Expose is automatically 
activated after Auto Expose is complete.

Fig.C-5. Setting a manual exposure.

With Manual Expose activated, you can adjust the exposure time directly by changing 
the number of seconds in the Exposure Time field. Type in a number or use the arrow 
buttons next to the field.

In UV or White image mode, when the specified exposure time is reached, the last 
captured image will be displayed in the ChemiDoc EQ image window. The camera 
will continue to integrate the image on the CCD, updating the display whenever the 
specified number of seconds is reached.

Manual Expose active;
button appears selected

Exposure Time field active;
adjust number of seconds
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Once you are satisfied with the quality of the displayed image, click on the Freeze 
button to stop the exposure process. The last full exposure will be displayed in the 
image window.

Fig.C-6. Freezing the manual exposure.

In Chemi mode, Manual Expose will expose an image over the specified exposure 
time and then stop automatically.

Note: Freeze is automatically activated if you adjust any of the subsequent controls 
(e.g., Video Print, Image Mode, Display controls, etc.).

Live Acquire

Live Acquire mode allows you to specify an interval over which a series of 
progressively longer exposures are taken. All exposures are then displayed on the 
screen, and you can choose the one with the best image.

Click on the Live Acquire button. A settings dialog box will open in which you can 
specify the total exposure time, starting exposure time, and number of exposures.

Click on Freeze to stop
the exposure process
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Fig.C-7. Live Acquire settings.

Note: You should specify no more than 10 exposures in the Live Acquire Settings 
dialog, to avoid excessive build-up of image background in later exposures. The 
fewer the exposures, the less background will be added to the image. See the 
Release Notes for additional instructions on reducing background in images 
captured using Live Acquire.

Select the Save Images checkbox if you want to automatically save each exposure as 
it is taken. 

Click on OK in the settings dialog to begin taking exposures. If you selected Save 
Images, a Save dialog box will open in which you can specify the base file name and 
location of the exposure files. When you click on Save, the exposures will be taken.

The specified number of exposures will be taken at equal intervals between the 
starting exposure time and total exposure time. When each exposure is complete, an 
image window containing that exposure will open behind the ChemiDoc EQ window. 
When the full exposure time has lapsed, all the image windows will move in front of 
the ChemiDoc EQ window.

Note that the first exposure will have the base file name (the default base file name is 
the computer user name and a time stamp). Each subsequent exposure will have a 
version number (v2, v3, v4, etc.) appended to the base file name. The highest version 
number will be the final exposure. If you did not elect to auto-save the exposures as 
they were created, then each image will be unsaved.
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To stop the Live Acquire, click on the Freeze button or adjust any of the subsequent 
controls (e.g., Video Print, Image Mode, Display controls, etc.).

Note: Exposures captured before freezing will be displayed in image windows. 

Study the different images and select the best exposure(s) to keep. You can then 
proceed to the next step.

C.5 Step IV. Optimize Display
The Display controls are useful for quickly adjusting the appearance of your image 
for output to a video printer. Adjusting these controls will automatically freeze the 
video display and allow you to alter the image within the ChemiDoc EQ window.

Fig.C-8. Display controls.

These controls are similar to those in the Transform dialog box.

Note: The Display controls will only change the appearance of the image. They will not 
change the underlying data.

High/Low Sliders

If Auto-scale doesn’t give you the appearance you want, you can use the High and 
Low sliders to redraw the image yourself. In white light mode and chemi mode, 
dragging the High slider handle to the left will make weak signals appear darker. In 
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UV mode, dragging the High slider handle to the left will make weak signals appear 
brighter. Dragging the Low slider handle to the right will reduce background noise.

You can also type specific High and Low values in the text boxes next to the sliders. 
Clicking anywhere on the slider bars will move the sliders incrementally.

Gamma Slider

Some images may be more effectively visualized if their data are mapped to the 
computer screen in a nonlinear fashion. Adjusting the Gamma slider handle changes 
the light and dark contrast nonlinearly.

Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in 
red in the scan window and in the pop-up image window. To view/hide saturated 
pixels in the pop-up image window, use the Image > Transform command.

Invert Display

This checkbox will switch light spots on a dark background to dark spots on a light 
background, and visa versa. This will only affect how the image is displayed on the 
screen, not the actual image data.

Auto-scale

Clicking on Auto-scale will adjust your displayed image automatically. The lightest 
part of the image will be set to the minimum intensity (e.g., white), and the darkest 
will be set to the maximum intensity (e.g., black). You can then “fine tune” the 
display using the High, Low, and Gamma sliders described below.

Reset

Reset will return the image to its original, unmodified appearance.
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C.6 Step V. Analysis
The Analysis step of the ChemiDoc EQ acquisition window allows you to add 
annotations and analyze the newly acquired image.

Annotate

Clicking on Annotate will open a separate image window displaying the captured 
image. The default name for the image will include the date, time, and user (if 
known).

The Text Overlay toolbar will also pop up to allow you to annotate your image.

The image will not be saved until you select Save or Save As from the File menu.

Analyze

Clicking on Analyze will open a separate image window displaying the captured 
image. The default name for the image will include the date, time, and user (if 
known). 

You can then analyze the image using the other features in the main application. 

The image will not be saved until you select Save or Save As from the File menu.

C.7 Step VI. Select Output
The ChemiDoc EQ window has several output options.

Fig.C-9. Output options.
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Video Print

Clicking on Video Print will automatically send the currently displayed frame (either 
live or integrated) to a video printer. You can add information about your image to the 
bottom of the printout by selecting the appropriate checkboxes in the Options dialog 
box. (See section C.9, Options.)

Save

Clicking on Save will open a separate image window displaying the captured image. 
A Save As dialog box will automatically open displaying the default file name for the 
image, which will include the date, time, and user (if known). You can then change 
the file name and storage directory.

You can also export your image as a TIFF image for viewing with other applications.

C.8 Exposure Status
The Exposure Status bar shows the progress of your exposure. If your exposure time 
is greater than 1 second, the status bar display will give you a graphical representation 
of the remaining time before exposure is complete.

If the exposure time is less than 1 second, the status bar will not refresh itself for each 
exposure; it will remain at 100 percent.

C.9 Options
Click on the Options button to open the Options dialog box. Here you can specify 
certain settings for your ChemiDoc EQ system.
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Fig.C-10. Available options in the ChemiDoc EQ acquisition window.

Click on OK to implement any changes you make in this box. Clicking on Defaults 
restores the settings to the factory defaults.

DAC Settings

Note: The default DAC settings are highly recommended and should be changed with 
caution.
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These sliders may be used to adjust the minimum and maximum voltage settings of 
your video capture board. The minimum slider defines the pixel value that will appear 
as white in the image, while the maximum slider defines the pixel value that will 
appear as black. The slider scale is 0–255, with the defaults set to 60 minimum and 
130 maximum.

Imaging Area

These fields are used to specify the size of your imaging area in centimeters, which in 
turns determines the size of the pixels in your image (i.e., resolution). When you 
adjust one imaging area dimension, the other dimension will change to maintain the 
aspect ratio of the camera lens.

Note: Your imaging area settings must be correct if you want to do 1:1 printing. These 
are also important if you are comparing the size of objects (e.g., using the 
Volume Tools) between images.

Auto Exposure Threshold

When you click on Auto Expose, the exposure time is determined by the percentage 
of saturated pixels you want in your image. This field allows you to specify that 
percentage.

Typically, you will want less than 1 percent of the pixels in your image saturated. 
Consequently, the default value for this field is 0.15 percent.

Reminder

When this checkbox is selected, the software will warn you to turn off your 
transilluminator light when you exit the ChemiDoc EQ acquisition window or when 
your system is “idle” for more than 5 minutes.

Note: If you are performing experiments that are longer than 5 minutes (e.g., 
chemiluminescence), this should be deselected.

Video Printing Footer Information

The checkboxes in this group allow you to specify the information that will appear at 
the bottom of your video printer printouts.
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Save Options

To automatically create a backup copy of any scan you create, select the Make 
Backup Copy checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in 
the same directory as the scanned image. Backup images are identified by "Backup 
of" followed by the original image file name. 

Note: Backup files are read only files. If you attempt to save a backup file, you will be 
promted to give it a new name. This protects the backup file and preserves it from 
any changes.

Simple Acquisition Mode

The Simple Acquisition mode option allows you to reconfigure the ChemiDoc EQ 
acquisition window to simple mode. In simple mode, the acquisition window contains 
the same steps as the advanced acquisition window with the exception of Step IV, 
Optimize display, and Step V, Analysis. Manual exposure is also disabled in simple 
mode. 
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Fig.C-11. Simple Acquisition Window

To change the acquisition window to Simple Acquisition Mode, check the box 
marked Simple Acquisition Mode. The change will take effect the next time you open 
the acquistion window.
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ChemiDoc XRS

Fig.D-1. ChemiDoc XRS.

Before you can begin acquiring images, the ChemiDoc XRS system must be properly 
installed and connected with the host computer. See the ChemiDoc XRS hardware 
manual for installation, startup, and operating instructions.
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To use the ChemiDoc XRS, the instrument must be connected to a fireWire port on 
your computer. If your computer does not have a fireWire connection, you will need 
to install the Bio-Rad supplied fireWire card prior to connecting the instrument. 

Note: It is recommended you install the software before connecting the instrument. 

Make sure that your ChemiDoc XRS camera is turned on. If the camera is not turned 
on, the ChemiDoc XRS acquisition window will not open.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “simulation mode.” 
In this mode, an acquisition window will open and the controls will appear active, but 
instead of capturing real images, the window will create “dummy” images of 
manufactured data.

You do not need to be connected to an imaging device to open a simulated acquisition 
window. This is useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device 
from the File menu. The title of the acquisition window will indicate that it is 
simulated.

D.1 ChemiDoc XRS Acquisition Window
To acquire images using the ChemiDoc XRS, go to the File menu and select 
ChemiDoc XRS.... The acquisition window for the instrument will open, displaying a 
control panel and a video display window. 
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Fig.D-2. ChemiDoc XRS acquisition window

When the ChemiDoc XRS window first opens, no image will be displayed.

The control panel has been arranged from top to bottom to guide you through the 
acquisition procedure. There are three basic steps to acquiring an image using the 
ChemiDoc XRS:

1. Select the application.

2. Position and focus the gel or other object to be imaged.

3. Acquire the image.
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D.2 Step I. Select Application
To set the appropriate parameters for the type of object you are imaging, click on the 
Select button under Select Application. You have the option of selecting a UV, White, 
or Chemiluminescence application. You can also select a custom setting. Once you 
select an application, the name of the application and its settings appear in the Select 
application step.

D.2.a. Custom Applications

The Bio-Rad installed applications have pre-set gain and bin settings. If the settings 
for the available applications do not meet your needs, you have the option of creating 
a custom application, which allows you to set your own binning settings.

To use a custom application, click Select and choose custom. Next, select a custom 
application from the list, or select Create to create a new application. This opens the 
custom dialog.

Fig.4-3. Creating a custom ChemiDoc XRS application.

Enter a name for the application. From the Illumination drop down list, select an 
illumination mode. You can select UV, white or no illumination. Next select Gain and 
Binning settings from the drop down list.

A higher Binning setting (2x2, 3x3) provides optimal sensitivity for low-light 
applications such as chemiluminescence. In this mode, the pixels in the camera are 
“binned” (e.g., four pixels are combined into one) to increase the amount of signal per 
pixel without increasing noise. Note that combining the pixels results in a reduction in 
the resolution of the image.
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Click OK to save and add the new custom application to the custom list. The new 
application is automatically selected as your application.

D.3 Step II. Position Gel
Click the Live/Focus button, and frames will be captured and displayed at about 10 
frames per second, depending on the speed of your computer.

You can use live mode to zoom, focus, and adjust the aperture on the camera, while 
positioning the sample within the area.

Note: ChemiDoc XRS features a motorized zoom lens that can be controlled directly 
from the acquisition window using the Iris, Zoom, and Focus arrow buttons. 
Click on the Up/Down buttons while viewing your sample in the window to 
adjust the lens.

Fig.D-4. Live/Focus button and camera control buttons. 

You can also select the Show Alignment Grid checkbox to facilitate positioning.

Note: After positioning your sample, you should check the Imaging Area dimensions 
under Options (see D.5, Options) to make sure that they conform to the size of 
the area you are focusing on. To determine the size of the area you are focusing 
on, you can place a ruler in the ChemiDoc XRS hood so that it is visible in the 
image.
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D.4 Step III. Acquire Image
The ChemiDoc XRS control panel has several features for creating image exposures. 
You can take an automatic exposure based on the number of saturated pixels in the 
image, you can enter a specific exposure time, or you can take a series of exposures 
and select the best one.

Note: “Exposure” refers to the integration of the image on the camera CCD over a 
period of time. The effect is analogous to exposing photographic film to light 
over a period of time.

Auto Expose

Use Auto Expose if you want to take a single exposure but are uncertain of the 
optimal exposure time.

Note: If you know the approximate exposure time you want (± 3 seconds), you can skip 
this step and go directly to Manual Expose.

 Click on the Auto Expose button to cancel Live/Focus mode and begin an automatic 
exposure. The Auto Expose button will appear selected throughout the exposure.

During the auto exposure, the image is continuously integrated on the camera CCD 
until it reaches a certain percentage of saturated pixels. This percentage is set in the 
Options dialog box. (Default = 0.75 percent. See D.5, Options.)

Fig.D-5. Selecting Auto Expose.

Click on Auto Expose;
button appears selected

Can see Exposure Time
automatically changing
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Once an image has reached the specified percentage of saturated pixels, it is captured 
and displayed in the video display window, Auto Expose is automatically deactivated, 
and the exposure time appears active in the Exposure Time field.

Note: If you are having difficulty auto-exposing your sample, you can use Manual 
Expose to adjust your exposure time directly. Most non-chemiluminescent 
applications only require an exposure time of a few seconds, which can be 
quickly adjusted using Manual Expose.

Manual Expose

If you know the approximate exposure time you want, you can click on the Manual 
Expose button. Manual Expose is automatically activated after Auto Expose is 
complete.

Fig.D-6. Setting a manual exposure.

With Manual Expose activated, you can adjust the exposure time directly by changing 
the number of seconds in the Exposure Time field. Type in a number or use the arrow 
buttons next to the field.

When the specified exposure time is reached, the last captured image will be 
displayed in the ChemiDoc XRS image window. 

Manual Expose active;
button appears selected

Exposure Time field active;
adjust number of seconds
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Fig.D-7. Freezing the manual exposure.

Live Acquire

Live Acquire mode allows you to specify an interval over which a series of 
progressively longer exposures are taken. All exposures are then displayed on the 
screen, and you can choose the one with the best image.

Click on the Live Acquire button. A settings dialog box will open in which you can 
specify the total exposure time, starting exposure time, and number of exposures.

Fig.D-8. Live Acquire settings.

Note: You should specify no more than 10 exposures in the Live Acquire Settings 
dialog, to avoid excessive build-up of image background in later exposures. The 

Click on Freeze to stop
the exposure process
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fewer the exposures, the less background will be added to the image. See the 
Release Notes for additional instructions on reducing background in images 
captured using Live Acquire.

Select the Save Images checkbox if you want to automatically save each exposure as 
it is taken. 

Click on OK in the settings dialog to begin taking exposures. If you selected Save 
Images, a Save dialog box will open in which you can specify the base file name and 
location of the exposure files. When you click on Save, the exposures will be taken.

The specified number of exposures will be taken at equal intervals between the 
starting exposure time and total exposure time. When each exposure is complete, an 
image window containing that exposure will open in front of the ChemiDoc XRS 
window. 

Note that the first exposure will have the base file name (the default base file name is 
the computer user name and a time stamp). Each subsequent exposure will have a 
version number (v2, v3, v4, etc.) appended to the base file name. The highest version 
number will be the final exposure. If you did not elect to auto-save the exposures as 
they were created, then each image will be unsaved.

To stop the Live Acquire, click on the Freeze button.

Note: Exposures captured before freezing will be displayed in image windows. 

Study the different images and select the best exposure(s) to keep.

D.4.a. Exposure Status

The Exposure Status bar shows the progress of your exposure. If your exposure time 
is greater than 1 second, the status bar display will give you a graphical representation 
of the remaining time before exposure is complete.

Illumination Flat Fielding

For UV or white light transilluminatoin applications, you should use the appropriate 
reference plate to ensure a uniform intensity in the image. This will compensate for 
normal variations in image pixel intensity that occur with a transilluminating light 
source.
D-9



Quantity One User Guide
To enable this feature, select the Flat Fielding checkbox.

UV Illumination Flat Fielding: When you first select the Flat fielding checkbox, and 
then acquire an image using the UV transilluminator, you will be prompted to remove 
your sample and place the fluorescent reference plate on the ChemiDoc XRS sample 
stage and turn on the UV transilluminator (see the ChemiDoc XRS User Manual). 

Fig.D-9. Illumination flat fielding reminder 

A reference image of the plate will be acquired and saved on your computer hard 
drive. The reference image will be applied to the sample image to generate a flat field 
corrected exposure.

White Light Illumination Flat Fielding: When you first select the checkbox, and then 
acquire an image using the white light conversion screen or the white light 
transilluminator, you will be prompted to remove your sample, turn on the white light 
source, and collect an exposure of the white light screen/transilluminator (see the 
ChemiDoc XRS User Manual). A reference image of the screen/transilluminator will 
be acquired and saved on your computer hard drive. The reference image will be 
applied to the sample image to generate a flat field corrected exposure.

For subsequent UV or white light trans exposures, you will be prompted to either use 
the appropriate saved flat field image or acquire a new one.
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Fig.D-10. Using the saved reference image.

Note: Flat fielding is unavailable for White EPI illumination and chemiluminescence 
applications.

D.5 Options
Click on the Options button to open the Options dialog box. Here you can specify 
certain settings for your ChemiDoc XRS system.
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Fig.D-11. Available options in the ChemiDoc XRS acquisition window.

Click on OK to implement any changes you make in this box.

D.5.a. Imaging Area

These fields are used to specify the size of your imaging area in centimeters, which in 
turn determines the size of the pixels in your image (i.e., resolution). When you adjust 
one imaging area dimension, the other dimension will change to maintain the aspect 
ratio of the camera lens.

Note: Your imaging area settings must be correct if you want to do 1:1 printing. These 
are also important if you are comparing the size of objects (e.g., using the 
Volume Tools) between images.

D.5.b. Reminder

Show Light Warning - When this checkbox is selected, the software will warn you 
to turn off your transilluminator light when you exit the ChemiDoc XRS acquisition 
window or when your system is “idle” for more than 5 minutes.
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Note: If you are performing experiments that are longer than 5 minutes (e.g., 
chemiluminescence), this should be deselected.

Show Filter Warning - When this checkbox is selected, the software will warn you 
to move the filter slider either to chemi or the UV/White position. 

D.5.c. Dark Subtraction

At the time of installation a reference dark image file was generated and saved to your 
hard drive.  The purpose of this file is to reduce dark current noise generated from the 
CCD.  Dark current noise is typical of all CCDs and is a result of the accumulation of 
charge in the absence of light 

The default time of the reference dark image is ten minutes.  The default reference file 
is optimized for ChemiDoc XRS applications.  If you select to change the reference 
dark image, ensure that the time of the reference dark image is of equal or greater 
duration than your typical sample image.  When the sample image time is longer than 
the reference dark image time the ability to detect very faint samples may be 
compromised.  

To reset the reference dark image time, select options in the ChemiDoc XRS 
acquisition window.  Select Reset Referenced.

Fig.D-12. Reset Reference Dark pop-up box

Enter the desired time in seconds.  Select OK.  You will be prompted to close and re-
open the acquisition window.  Place the lens cap on the camera and close the door of 
the hood (See ChemiDoc XRS instruction manual).  Select OK at the prompt and new 
reference dark images of the entered time interval will be taken for each of the 
possible combinations of camera gain and bin settings.  These will be retained as the 
reference dark images until the time is reset again.
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D.5.d. Save Options

To automatically create a backup copy of any scan you create, select the Make 
Backup Copy checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in 
the same directory as the scanned image. Backup images are identified by "Backup 
of" followed by the original image file name. 

Note: Backup files are read only files. If you attempt to save a backup file, you will be 
promted to give it a new name. This protects the backup file and preserves it from 
any changes.

D.5.e. Auto-scale Transform

Auto-scale Transform after Acquisition allows the user the option of having the image 
automatically perform the Auto-Scale transform function upon completion of image 
acquisition. This eliminates the need to transform when the acquisition time was too 
short or the iris not opened enough.

To enable the auto-scale transform function, check the box labeled, Auto-Scale 
Transform after Acquisition in the Options dialog.

D.5.f. Auto Exposure Threshold

When you click on Auto Expose, the exposure time is determined by the percentage 
of saturated pixels you want in your image. This field allows you to specify that 
percentage.

Typically, you will want less than 1 percent of the pixels in your image saturated. 
Consequently, the default value for this field is 0.75 percent.
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D.6 Other Features

Fig.D-13. Other ChemiDoc XRS acquisition window features.

Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in 
red in the scan window and in the pop-up image window. To view/hide saturated 
pixels in the pop-up image window, use the Image > Transform command.

File Size of Images

Image File Size shows the size of the image file you are about to create. This size is 
determined by the bin setting used for the selected application.

If you do not have enough computer memory for the specified file size, an error 
message will appear when you attempt to acquire an image. (Macintosh users can 
increase the application memory partition. See your Macintosh computer 
documentation for guidance.)
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GS-800 Imaging Densitometer

Fig.E-1. GS-800 Imaging Densitometer

Before you can begin scanning images with the GS-800 Imaging Densitometer®, your 
instrument must be properly installed and connected with the host computer. See the 
hardware manual for installation, startup, and operating instructions.

PC Only: A Note About SCSI Cards

The GS-800 is connected to your computer by a Small Computer System Interface 
(SCSI) cable. To use the GS-800, you must have a SCSI card installed in your PC. If 
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you have a PC with a Windows 98 or Windows ME operating system, you may also 
need to load the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “simulation mode.” 
In this mode, an acquisition window will open and the controls will appear active, but 
instead of capturing real images, the window will create “dummy” images of 
manufactured data.

You do not need to be connected to an imaging device to open a simulated acquisition 
window. This is useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the Ctrl key and select the name of the device 
from the File menu. The title of the GS-800 acquisition window will indicate that it is 
simulated.

Note: There is no simulated calibration for densitometers.

E.1 GS-800 Acquisition Window
To begin acquiring images, go to the File menu and select GS-800. The acquisition 
window for the densitometer will open, displaying a control panel and a scanning 
window. 
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Fig. E-2. GS-800 acquisition window

The scanning window is marked by grid lines that divide the area into square 
centimeters. These are numbered 1-40 top to bottom and 1-30 left to right if the light 
source is reflective, and 1-40 top to bottom and 1-29 left to right if the light source is 
transmissive.

To hide the gridlines, select the Hide Grid checkbox under Options.

Below the main scanning window is the calibration strip window. Every time the 
densitometer calibrates, an image of the calibration strip will appear in this window.
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The control panel has been arranged from top to bottom to guide you through the 
acquisition procedure. There are five basic steps to scanning an image using the GS-
800:

1. Select the application.

2. Select the scan area.

3. Select the resolution of the scan.

4. Calibrate the instrument. (This is automatic, after you enter the step tablet values 
before you first scan after installation.)

5. Acquire the image.

E.2 Step I. Select Application
To set the parameters for your particular scan, you can:

1. Select from a list of possible applications, or

2. Choose your own filter and light source settings.

Selecting from the List of Applications

When you select from the list of applications, the software automatically sets the 
appropriate filter(s) and other parameters for that particular application.

To select from the list of applications, click on the Select button under Step I. Select 
Application.
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Fig. E-3. Example of the application tree in the GS-800 dialog box.

The applications are listed in a tree that expands from left to right. First you select the 
category of your application, then you select your particular application.

To exit the tree without selecting, press the Esc key.

Fig. E-4. Applications available in the GS-800 acquisition window.

X-ray film

Photograph

Gel

Blot

Gray file

Blue film

Linear

Positive (dark bands, light background)

Negative (light bands, dark background)

Coomassie Blue

Silver stain

Copper stain
Zinc stain

Stain all

Coomassie stain

Colloidal gold stain

Amido black stain

AP-Substrate (BCIP/NBT)

HRP-Substrate (4CN)

HRP-Substrate (DAB)
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Choosing Your Own Settings

If you know the filter and light source settings you want, or want to experiment with 
different settings, you can choose them yourself.

Fig. E-5. GS-800 Custom Application controls.

Next to Filter, click on either the Red, Green, Blue, or White checkbox, or a 
combination of two of the first three (Red-Green, Green-Blue, Red-Blue).

Fig. E-6. Examples of filter colors and applications.

Next to Light, select the appropriate light source.

• Select Reflective for scanning opaque mediums such as dried gels on filter paper, 
arrays, or photographs. The scanning dimensions in this mode are 30 cm x 40 
cm.

• Select Transmissive for scanning transparent mediums such as films, gels, or 
slides. The scanning dimensions in this mode are 29 cm x 40 cm.

Filter Color Wavelength Application Examples

Red 595–750 nm Coomassie G-250, BCIP/NBT, Fast Green 
FCF, Methylene Blue

Green 520–570 nm Coomassie R-250, Basic Fuchsin

Blue 400–530 nm Crocein Scarlet

White 400–750 nm Silver Stains, Copper Stains, Film
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E.3 Step II. Select Scan Area

Preview Scan

Before selecting the particular area to scan, you can preview the entire scanning area 
to determine the exact position of your sample.

Click on Preview Scan. A quick, low-resolution scan of the entire scanning area will 
appear in the scanning window. Your sample should be visible within a portion of this 
scan.

Selecting an Area

Using the preview scan as a guide, select your scan area by dragging your mouse 
within the scanning window. The border of the scan area you are selecting will be 
marked by a frame.

Note: The scan area you select must be at least 1 cm wide.

When you release the mouse button, the border changes to a dashed blue line, 
indicating a selected area.

• To reposition the scanning area box you have created, position your cursor inside 
the box and drag. The entire box will move.

• To resize the box, position your cursor on a box side and drag. The side you have 
selected will move.

• To redo the box entirely, position your cursor outside the box and drag. The old 
box will disappear and a new box will be created.

You can also select the scanning area by entering coordinates in the appropriate fields 
(Top, Bottom, Left, Right). As you enter a coordinate, the position of the scanning 
area box will change accordingly.

When selecting, be sure to include the entire area of interest, and be generous with 
borders. You can always crop the image later.
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E.4 Step III. Select Resolution
To select from a list of possible scanning resolutions, click on the Select button under 
Step III. Select Resolution. This will open the Select Scan Resolution dialog box.

Fig. E-7. Select Scan Resolution dialog box.

Available resolutions are listed from highest to lowest in terms of the dimensions of 
the resulting pixels (in microns). Smaller pixels equal higher resolution. Each 
resolution is listed with its typical use.

In general, the size of your pixels should be one-tenth the height of your smallest 
object.

Specifying Your Own Resolution

If you select Oversample in the Options dialog box, you can specify your own 
resolution within the range of 32–169 micrometers. With Oversample selected, enter 
values directly in the fields next to X resolution and Y resolution in the main 
acquisition window.
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Fig. E-8. Entering a custom resolution (with Oversample selected).

Image File Size

The size of the scan file for the selected resolution is listed next to Image File Size. If 
you do not have enough computer memory for the specified file size, an error 
message will appear when you attempt to scan. If this happens, select a lower 
resolution or decrease the size of the area to be scanned. (Macintosh users can also 
increase the application memory partition. See your Macintosh computer 
documentation for guidance.)

E.5 Calibration
The GS-800 automatically calibrates the densities of scanned images to ensure 
accuracy and reproducibility of results. The GS-800 has built-in step tablets for both 
transmissive and reflective scanning.

• The transmissive step tablet calibrates transmissive scans from 0 to 3.0 O.D.

• The reflective step tablet targets reflective scans from 0 to 2.0 O.D.

The first time you use the GS-800, you must select some settings to ensure accurate 
calibration. Click on the Options button in the main acquisition window. This will 
open the Densitometer Options dialog box.
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Fig. E-9. Densitometer Options dialog box.

Note that calibration is always on for the GS-800.

E.5.a Step Tablet Values

The built-in transmissive and reflective step tablets on your densitometer have 
specific density values. Before scanning for the first time, you must enter the values 
for your transmissive step tablet into the software. You can use the default values in 
the software for the reflective step tablet.

Transmissive Step Tablet

Before you scan in transmissive mode for the first time, you must specify the values 
for your transmissive step tablet.

First, make sure that the Transmissive checkbox is selected in the main acquisition 
window, then click on the Options button. In the Densitometer Options dialog, click 
on the Edit Step Tablet button. The Step Tablet Values for GS-800 Transmissive 
dialog box will open.
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Fig. E-10. Step Tablet dialog box.

Attached to the outside of your GS-800, you will find a copy of the manufacturer’s 
printout of the diffuse density values for each segment of the transmissive step tablet, 
as well as a serial number for the tablet. These exact density values must be entered 
into the software to associate a correct density value with each step on the step tablet.

Note: Scanning in transmissive mode with incorrect step tablet values can cause 
significant errors in the reported densities of your scans.

First, type the serial number for the tablet into the Tablet Serial Number field.

The Quantity Offset field does not apply in the GS-800 in transmissive mode. This 
value should remain at zero.

Next, enter the step tablet values into the appropriate fields under the Diffuse column. 
After the step tablet is scanned, the software will associate each density value with its 
corresponding segment on the step tablet. The density values do not need to be 
reentered each time you calibrate.

When you are finished entering the transmissive step tablet values, click on OK.
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Reflective Step Tablet

For the reflective step tablet, it is recommended that you use the default target values 
in the software. Although you can edit these values based on your own measurements 
and testing, the default values have been preset based on careful testing and review.

To view or edit the default reflective values, make sure that the Reflective checkbox 
is selected in the main acquisition window, then click on the Options button. In the 
Densitometer Options dialog, click on the Edit Step Tablet button. The Step Tablet 
Values for GS-800 Reflective dialog box will open.

When you are finished viewing/editing the reflective step tablet values, click on OK.

Diffuse Versus Specular O.D.

In the step tablet form, you enter O.D. as diffuse density, and then the software 
automatically calculates the specular density.

Specular density is a measure of the light that passes directly through a medium. 
Diffuse density includes light that is scattered as it passes through the medium. Step 
tablet values are given in diffuse density, but are measured by the scanner in specular 
density, and therefore must be converted according to the specular/diffuse O.D. ratio. 
This conversion does not affect quantitation.

Fig. E-11. Specular and diffuse density

Diffuse density values are converted to specular optical density units according to the 
following formula:

Specular Light (passes directly through medium)

Diffuse Light (is scattered by medium)

Medium (gel, film, etc.)

Specular OD 1.4 Diffuse OD⋅=
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E.5.b Other Calibration Settings

After you have entered the step tablet values, you can immediately calibrate by 
clicking on the Calibrate Now button (in the Densitometer Options dialog box).

You can also specify how often you want the GS-800 to automatically recalibrate. 
Either click on the Calibrate Before Every Scan checkbox or specify a period 
between automatic recalibrations (in minutes) in the Recalibration Interval field.

Note: The scanner will automatically recalibrate each time you change your filter or 
your reflective/transmissive setting. (If you select a different application with the 
same filter and light settings, it will not auto recalibrate.)

To print out a calibration report each time the densitometer calibrates, click on the 
Calibration Report checkbox.

E.6 Acquire the Image
Note: Before scanning in transmissive mode, make sure the white balance region of the 

scanning area is not covered or obstructed in any way.

To begin to scan, click on the Acquire button. The scanned image will begin to 
appear in the scanning window, line by line.

To interrupt a scan, click on the Stop button. A message will ask you to confirm the 
interrupt, and then you will be asked if you want to keep the partial scan. This feature 
is useful if you overestimated the size of the area you selected.

After the scan is complete, a window will open displaying the scan image, at which 
point you can analyze and save it.

Note: The image will open with a default file name that includes the date, time, and (if 
applicable) user name. However, unless you have selected Auto Save After 
Scan, the file will not be saved until you perform a Save or Save As operation.
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E.7 Other Options

Oversample

This feature allows you to scan at the maximum resolution of the scanner and then use 
spatial averaging to create an image with lower resolution. This can result in better 
images at lower resolution—however, it takes longer to scan.

To turn on oversampling, click on the Options button in the acquisition window and 
select the Oversample checkbox in the options dialog.

With oversampling on, you can specify your own resolution within the range of the 
densitometer by entering values directly in the fields next to X resolution and Y 
resolution in the main acquisition window.

Auto Save After Scan

To automatically save any scan you create, select the Auto Save After Scan 
checkbox.

With this checkbox selected, when you click on Acquire, a Save As dialog box will 
open asking you to specify a file name and location for the image you are about to 
create. The scan will begin when you click on the Save button.

Make Backup Copy

If you have selected Auto Save After Scan, you can also automatically create a 
backup copy of any scan you create.

Click on the Make Backup Copy checkbox. With this checkbox selected, when you 
save a scan, a backup copy will be placed in the same directory as the scanned image. 
Backup images are identified by "Backup of" followed by the original image file 
name. 

Note: Backup files are read only files. If you attempt to save a backup file, you will be 
promted to give it a new name. This protects the backup file and preserves it from 
any changes.
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Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in 
red in the scan window and in the pop-up image window. To view/hide saturated 
pixels in the pop-up image window, use the Transform command on the main toolbar 
or Image menu.

Hide Grid

To hide the gridlines in the scanning area window, click on the Hide Grid checkbox.
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Personal Molecular Imager FX

Fig.F-1. Personal Molecular Imager FX

Before you can begin acquiring images using the Personal Molecular Imager® FX, 
the instrument must be properly installed and connected with the host computer. See 
the Personal FX hardware manual for installation, startup, and operating instructions.

Note: The Personal FX should be turned on and the initialization sequence completed 
before the host computer is turned on (except in the case of certain Power 
Macintosh configurations). See the hardware manual for more details.
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PC Only: A Note About SCSI Cards

The Personal FX is connected to your computer by a Small Computer System 
Interface (SCSI) cable. To use the Personal FX, you must have a SCSI card installed 
in your PC. If you have a PC with a Windows 98 or Windows ME operating system, 
you may also need to load the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “simulation mode.” 
In this mode, an acquisition window will open and the controls will appear active, but 
instead of capturing real images, the window will create “dummy” images of 
manufactured data.

You do not need to be connected to an imaging device to open a simulated acquisition 
window. This is useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device 
from the File menu. The title of the acquisition window will indicate that it is 
simulated.

F.1 Personal FX Acquisition Window
To acquire images using the Personal FX, go to the File menu and select Personal 
FX.... The acquisition window for the imager will open, displaying a control panel 
and the scanning area window.
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Fig.F-2. Personal FX acquisition window

The default scanning window is marked by grid lines that divide the area into 
quadrants. There is also an outer box and inner box marked by thicker lines. The 
quadrants are numbered 1–16 left to right and lettered A–U top to bottom.

If you prefer a scanning window measured in centimeters, deselect the Quadrant 
Mode checkbox in the control panel by clicking on it. To hide the gridlines, click on 
the Hide Grid checkbox under Options.

The control panel has been arranged from top to bottom to guide you through the 
acquisition procedure. There are three basic steps to scanning an image using the 
Personal FX:

1. Select the scan area
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2. Select the resolution

3. Acquire the image

F.2 Step I. Select Scan Area
To select a scan area, drag your mouse within the scanning window. (In the scanning 
window, your cursor appearance will change to a cross.) The border of the scan area 
you are selecting is marked by a frame.

Fig.F-3. Selecting a scan area.

If you are in quadrant mode, note that the frame “locks” onto the next quadrant as you 
drag. When you release the mouse button, the border changes to a dashed blue line, 
indicating a selected area.

• To reposition the scanning box you have selected, position your cursor inside the 
box and drag. The entire box will move.

• To resize the box, position your cursor on a box side and drag. The side you have 
selected will move.

• To redo the box entirely, position your cursor outside the box and drag. The old 
box will disappear and a new box will be created.

Drag cursor to
define scan

area
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You can also select the scanning area by entering coordinates in the appropriate fields 
(Top, Bottom, Left, Right). After you enter a coordinate, the position of the scanning 
area box will change accordingly.

When selecting, be sure to include the entire area of interest, and be generous with 
borders. You can always crop the image later.

F.3 Step II. Select Resolution
The Personal FX acquisition window allows you to scan at 50, 100, 200, or 800 
micrometers. These resolutions are listed as option buttons in the control panel.

Fig.F-4. Resolution option buttons.

The resolution you select should be based on the size of the objects (e.g., bands, 
spots) you are interested in. For example:

• 50 micrometer resolution should be reserved for images requiring the highest 
level of detail, e.g., high density in situ samples, 1,536-well microplates, high 
density arrays, samples with very closely spaced bands. Files scanned at 50 
micrometers can be very large. 

• 100 micrometer resolution should be used for typical gels and arrays.

• 200 micrometer resolution is useful for gels with large bands and dot blots.

• 800 micrometer resolution should be reserved for very large objects, such as CAT 
assays.
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File Size of Images

Image File Size (below Select Resolution) shows the size of the scan file you are 
about to create. If you do not have enough computer memory for the specified file 
size, an error message will appear when you attempt to scan. If this happens, select a 
lower resolution or decrease the size of the area to be scanned. (Macintosh users can 
also increase the application memory partition. See your Macintosh computer 
documentation for guidance.)

F.4 Acquire the Image
Once you have selected your scan area and resolution, you ready to acquire an image.

Click on the Acquire button. There may be a short delay while the image laser warms 
up; then the scanned image will begin to appear in the scanning window, line by line.

To interrupt a scan, click on the Stop button. A message will ask you to confirm the 
interrupt, and then you will be asked if you want to keep the partial scan. This feature 
is useful if you overestimated the size of the area you selected.

Note: If the image you are scanning has more than 10 saturated pixels, you will receive 
a warning message.

Saving the Image

After the scan is complete, a message will appear asking you if you want to keep the 
scan. If you select Yes, a separate window will pop up containing the new image.

You can then save and analyze the image using the standard menu and toolbar 
functions.
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F.5 Options

Auto Save After Scan

To automatically save any scan you create, click on the Auto Save After Scan 
checkbox.

Note: In PDQuest, this option is preselected and cannot be turned off. All images must 
be automatically saved when acquired.

With this checkbox selected, when you click on Acquire, a Save As dialog box will 
open asking you to specify a file name and location for the image you are about to 
create. The scan will begin when you click on the Save button.

Make Backup Copy

You can automatically create a backup copy of any scan you create. To do so, first 
select Auto Save After Scan (see above), then select the Make Backup Copy 
checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in 
the same directory as the scanned image. Backup images are identified by "Backup 
of" followed by the original image file name. 

Note: Backup files are read only files. If you attempt to save a backup file, you will be 
promted to give it a new name. This protects the backup file and preserves it from 
any changes.

Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in 
red in the scan window and in the pop-up image window. To view/hide saturated 
pixels in the pop-up image window, use the Image > Transform command.

Hide Grid

To hide the gridlines in the scanning area window, click on the Hide Grid checkbox.
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Warn on Saturated Pixels

The Warn on Saturated Pixels option is checked by default. Uncheck this box to 
disable this warning.
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Molecular Imager FX 
Family (FX Pro, FX Pro 
Plus and Molecular FX)

Fig. G-1. Molecular Imager FX

Before you can begin acquiring images using any of the Molecular Imager FX family 
of products, the particular instrument must be properly installed and connected with 
the host computer. See the corresponding FX hardware manual for installation, 
startup, and operating instructions.
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Note: The FX should be turned on and the initialization sequence completed before the 
host computer is turned on (except in the case of certain Power Macintosh 
configurations). See the hardware manual for more details.

PC Only: A Note About SCSI Cards

The FX is connected to your computer by a Small Computer System Interface (SCSI) 
cable. To use the FX, you must have a SCSI card installed in your PC. If you have a 
PC with a Windows 98 or Windows ME operating system, you may also need to load 
the SCSI and WinASPI drivers that came with the card.

Simulation Mode

Any of the imaging device acquisition windows can be opened in “simulation mode.” 
In this mode, an acquisition window will open and the controls will appear active, but 
instead of capturing real images, the window will create “dummy” images of 
manufactured data.

You do not need to be connected to an imaging device to open a simulated acquisition 
window. This is useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device 
from the File menu. The title of the acquisition window will indicate that it is 
simulated.

G.1 FX Acquisition Window
To acquire images using the FX, go to the File menu and select FX.... The acquisition 
window for the imager will open, displaying the control panel for the imager and the 
scanning area window.
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Fig. G-2. FX acquisition window

The default scanning window is marked by grid lines that divide the area into 
quadrants. There is also an outer box and inner box marked by thicker lines. The 
quadrants are numbered 1–16 left to right and lettered A–U top to bottom.

If you prefer a scanning window measured in centimeters, deselect the Quadrant 
Mode checkbox in the control panel by clicking on it. To hide the gridlines, click on 
the Hide Grid checkbox under Options.

The control panel has been arranged from top to bottom to guide you through the 
acquisition procedure. There are four basic steps to scanning an image using the FX:

1. Select the application(s).

2. Select the scan area.
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3. Select the resolution.

4. Acquire the image.

G.2 Step I. Select Application
In Step 1, you select the appropriate filters and other scanning parameters for the type 
of gel, blot, plate, or other object that you are imaging. Each set of parameters you 
select is called an “application.”

The FX now supports multi-channel sequential scanning. This allows you to 
automatically scan the same object using up to four different applications (e.g., to 
detect different types of stains on the same gel).

First you select a channel, then you select the application under that channel.

G.2.a Selecting a Channel

The four channels are accessed using the tabs under Step 1. Channel 1 is always 
enabled—that is, the FX will always scan using the application settings selected 
under Channel 1 first.

To enable any of the remaining channels, click on a channel tab, then select the 
Enable Channel checkbox and select the application for that channel as described in 
the following section.
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Fig. G-3. Enabling Channel 2.

Enabled channels have a green check mark on their tabs.

You do not need to enable Channels 2–4 in sequence. For example, you can set up 
your four most common applications using the different channels, but only enable 
Channel 4 for a particular gel. Channel 1 would be scanned first, Channel 4 second.

Enabled channels are scanned sequentially. The separate scans are displayed and 
saved as separate images. The total scanning time depends on the number and type of 
enabled applications.

If you have selected Auto Save After Scan, the image created using Channel 1 will 
have the base file name, and images created using subsequent channels will have the 
base file name plus a version number. (v. 2, v. 3, v. 4). Note that the image version 
number does not necessarily correspond to the channel number. For example, if you 
scanned an image using only Channels 1 and 4, the image created using Channel 4 
will be saved as version 2 (v. 2).

G.2.b Selecting an Application

To select an application (i.e., the appropriate filter and other parameters for the type of 
object you are imaging), click on the Select button under a channel tab.

Select the checkbox
to enable the channel 

Click on the Select
button to select the
application 

Click on the tab to 
select the channel 
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Fig. G-4. Example of an application tree: Ethidium Bromide gel.

Standard Applications

The standard applications and associated settings are listed in a tree that expands from 
left to right. When you select a standard application, the software automatically 
selects the appropriate filter(s) in the FX for that particular application. Some 
applications are inactive in the FX Pro and FX Pro Plus systems.

Standard FX Applications

Category Application

Radioisotopes
CS- or BI-Screen (Bio-Rad)1

K-Screen (Kodak)2

Fuji-Screen2

Chemiluminescence Chemi-Screen (Bio-Rad)1

Chemifluorescence
ECL-Plus
Attophos

DNA Stain Gel
Ethidium Bromide
Sybr Green I & II

Sybr Gold
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1Not supported in the FX Pro and FX Pro Plus systems. 
2Not supported in the FX Pro systems.

First select your general application, next select the particular stain or medium you 
are using, and finally (if appropriate) select the intensity of your samples.

Note: Some applications require an external laser. If you choose one of these without 
having an external laser attached, you will receive a warning.

To exit the tree without selecting, press the ESC key.

Your selection and settings will be displayed below the Select button.

Protein Stain Gel

Sypro Orange
Sypro Red
Nile Red

Sypro Ruby

Fluorophores

Alexa 488
Alexa 532
Alexa 546

FITC
FAM
CY3
HEX
R6G

Texas Red

Microtiter Plate

DNA (Sybr Green I)
Protein (Nano Orange)

ssDNA (Oligreen)
DNA (Picogreen)

B-Gal (FDG)
GUS (FDG)

Densitometry

Coomassie Blue Gel/Blot
Copper Stain Gel/Blot
Silver Stain Gel/Blot

X-Ray Film (Grey Type)

Standard FX Applications
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Sample Intensity

Many FX applications require that you select a sample intensity (High, Medium, or 
Low) from the application tree. This is simply a rough estimate of how much sample 
is visible in your gel or other object.

If you are unsure of the level of intensity of your sample, you can always select a 
level, capture an image, then adjust the level and capture another image.

For example, if you select Low Sample Intensity and the resulting image has too 
many saturated pixels, you will receive a warning message. Simply change the setting 
to Medium Sample Intensity and rescan. If you select High Sample Intensity and the 
resulting image is too faint, select Medium or Low and rescan.

Custom Applications

If your application is not listed, if you want to use user-installed filters, or if you want 
to use an external laser, you can create and save your own custom application.

From the application tree, select Custom, then Create. This will open a dialog box in 
which you can name your application and select your settings.

Fig. G-5. Creating a custom application.
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To select a filter (including user-defined) or filter combination, click on the buttons 
for Filters A, B, and C, and make your choice from each pop-up list.

Note: Filter wheel C is not available in the FX Pro or the FX Pro Plus systems.

Note: The user-defined filters (User1, User2, etc.) cannot be renamed in the pop-up list, 
so be sure to remember which filter you insert into each position in the FX (i.e. 
690 nm filter, 605 nm BPfilter).

To use an external laser, click on the Laser button and select it from the pop-up list 
(i.e. 488 nm or 635 nm laser). Otherwise, use the default internal laser (532/1064nm).

Note: The dual laser (532/1064 nm) is not available in the FX Pro or the FX Pro Plus 
systems.

Click on the PMT Voltage button to select a standard voltage for your custom 
application or create a custom PMT voltage.

To select a custom voltage, click on the Custom option. In the dialog box, adjust the 
slider to select a PMT voltage as a percentage of the maximum.

Fig. G-6. Selecting a custom PMT voltage.

Note: For voltages above 80% of maximum, you will receive a warning message that 
the high voltage could damage the PMT. 

If you select Choose Later from the list of PMT voltages, the choices of sample 
intensity will be displayed when you select your custom application.
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Finally, enter a name for your application in the Name field and click on OK to 
implement your changes.

After you have created an application, you can select it from the application tree by 
selecting Custom and the name you created. You can delete the application by 
selecting Custom, Delete, and the name of the application.

Fig. G-7. Selecting a custom application.

You can edit a custom application by selecting Custom, Edit, and the name of 
the application. You can also use this feature to create a new custom 
application from an existing one.

Fig. G-8. Application selection and settings.
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Once you select an application, the application name and settings appear 
below the Select button.

G.3 Step II. Select Scan Area
To select a scan area, drag your mouse within the scanning window. (In the scanning 
window, your cursor appearance will change to a cross.) The border of the scan area 
you are selecting is marked by a frame.

Fig. G-9. Selecting a scan area.

If you are in quadrant mode, note that the frame “locks” onto the next quadrant as you 
drag. When you release the mouse button, the border changes to a dashed blue line, 
indicating a selected area.

• To reposition the scanning box you have selected, position your cursor inside the 
box and drag. The entire box will move.

• To resize the box, position your cursor on a box side and drag. The side you have 
selected will move.

• To redo the box entirely, position your cursor outside the box and drag. The old 
box will disappear and a new box will be created.

Drag cursor to
define scan

area
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You can also select the scanning area by entering coordinates in the appropriate fields 
(Top, Bottom, Left, Right). After you enter a coordinate, the position of the scanning 
area box will change accordingly.

When selecting, be sure to include the entire area of interest, and be generous with 
borders. You can always crop the image later.

G.4 Step III. Select Resolution
The FX acquisition window allows you to scan at 50, 100, 200, or 800 micrometers. 
These resolutions are listed as option buttons in the control panel.

Fig. G-10. Resolution option buttons.

The resolution you select should be based on the size of the objects (e.g., bands, 
spots) you are interested in. For example:

• 50 micrometer resolution should be reserved for images requiring the highest 
level of detail, e.g., high density in situ samples, 1,536-well microplates, high 
density arrays, samples with very closely spaced bands. Files scanned at 50 
micrometers can be very large. 

• 100 micrometer resolution is useful for typical gels and arrays.

• 200 micrometer resolution is useful for gels with large bands and dot blots.

• 800 micrometer resolution should be reserved for very large objects, such as CAT 
assays.
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File Size of Images

Image File Size (below Select Resolution) shows the size of the scan file you are 
about to create. If you do not have enough computer memory for the specified file 
size, an error message will appear when you attempt to scan. If this happens, select a 
lower resolution or decrease the size of the area to be scanned. (Macintosh users can 
also increase the application memory partition. See your Macintosh computer 
documentation for guidance.)

G.5 Acquire the Image
Once you have selected your application, scan area, and resolution, you are ready to 
acquire an image.

Click on the Acquire button. There may be a short delay while the image laser warms 
up; then the scanned image will begin to appear in the scanning window, line by line.

To interrupt a scan, click on the Stop button. A message will ask you to confirm the 
interrupt, and then you will be asked if you want to keep the partial scan. This feature 
is useful if you overestimated the size of the area you selected.

Note: If the image you are scanning has more than 10 saturated pixels, you will receive 
a warning message. If this happens, you can go back and select a higher sample 
intensity in the application tree.

Saving the Image

After the scan is complete, a message will appear asking you if you want to keep the 
scan. If you select Yes, a separate window will pop up containing the new image.

You can then save and analyze the image using the standard menu and toolbar 
functions.
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G.6 Options

Auto Save After Scan

To automatically save any scan you create, click on the Auto Save After Scan 
checkbox.

With this checkbox selected, when you click on Acquire, a Save As dialog box will 
open asking you to specify a file name and location for the image you are about to 
create. The scan will begin when you click on the Save button.

If you are scanning using multiple channels, the image created using Channel 1 will 
be saved using the base file name, and images created using subsequent channels will 
have the base file name plus a version number. (v. 2, v. 3, v. 4). Note that the image 
version number does not necessarily correspond to the channel number. For example, 
if you scanned an image using only Channels 1 and 4, the image created using 
Channel 4 will still be saved as version 2 (v. 2).

Make Backup Copy

You can automatically create a backup copy of any scan you create. To do so, first 
select Auto Save After Scan (see above), then select the Make Backup Copy 
checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in 
the same directory as the scanned image. Backup images are identified by "Backup 
of" followed by the original image file name. 

Note: Backup files are read only files. If you attempt to save a backup file, you will be 
promted to give it a new name. This protects the backup file and preserves it from 
any changes.

Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in 
red in the scan window and in the pop-up image window. To view/hide saturated 
pixels in the pop-up image window, use the Image > Transform command.
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Hide Grid

To hide the gridlines in the scanning area window, click on the Hide Grid checkbox.

Warn on Saturated Pixels

The Warn on Saturated Pixels option is checked by default. Uncheck this box to 
disable this warning.
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PharosFX Family 
(PharosFX and PharosFX 
Plus)

Fig. H-1. PharosFX

Before you can begin acquiring images using any of the PharosFX family of products, 
the particular instrument must be properly installed and connected with the host 
computer. See the corresponding PharosFX hardware manual for installation, startup, 
and operating instructions.
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Simulation Mode

Any of the imaging device acquisition windows can be opened in “simulation mode.” 
In this mode, an acquisition window will open and the controls will appear active, but 
instead of capturing real images, the window will create simulated grayscale images.

You do not need to be connected to an imaging device to open a simulated acquisition 
window. This is useful for demonstration purposes or practice scans.

To enter simulation mode, hold down the CTRL key and select the name of the device 
from the File menu. The title of the acquisition window will indicate that it is 
simulated.

H.1 PharosFX Acquisition Window
To acquire images using the PharosFX, go to the File menu and select PharosFX. The 
acquisition window for the imager will open, displaying the control panel for the 
imager and the scanning area window.
H-2



Appendix H. FX
Fig. H-2. PharosFX acquisition window

The default scanning window is marked by grid lines that divide the area into 
quadrants. There is also an outer box and inner box marked by thicker lines. The 
quadrants are numbered 1–16 left to right and lettered A–U top to bottom.

If you prefer a scanning window measured in centimeters, deselect the Quadrant 
Mode checkbox in the control panel by clicking on it. To hide the gridlines, click on 
the Hide Grid checkbox under Options.

The control panel has been arranged from top to bottom to guide you through the 
acquisition procedure. There are four basic steps to scanning an image using the 
PharosFX:

1. Select the application(s).

2. Select the scan area.
H-3



Quantity One User Guide
3. Select the resolution.

4. Acquire the image.

H.2 Step I. Select Application
In Step 1, you select the appropriate filters and other scanning parameters for the type 
of gel, blot, plate, or other object that you are imaging. Each set of parameters you 
select is called an “application.”

The PharosFX supports multi-channel sequential scanning. This allows you to 
automatically scan the same object using up to four different applications (e.g., to 
detect different types of stains on the same gel).

First you select a channel, then you select the application under that channel.

H.2.a Selecting a Channel

The four channels are accessed using the tabs under Step 1. Channel 1 is always 
enabled—that is, the PharosFX will always scan using the application settings 
selected under Channel 1 first.

To enable any of the remaining channels, click on a channel tab, then select the 
Enable Channel checkbox and select the application for that channel as described in 
the following section.
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Fig. H-3. Enabling Channel 2.

Enabled channels have a green check mark on their tabs.

You do not need to enable Channels 2–4 in sequence. For example, you can set up 
your four most common applications using the different channels, but only enable 
Channel 4 for a particular gel. Channel 1 would be scanned first, Channel 4 second.

Enabled channels are scanned sequentially. The separate scans are displayed and 
saved as separate images. The total scanning time depends on the number and type of 
enabled applications.

If you have selected Auto Save After Scan, the image created using Channel 1 will 
have the base file name, and images created using subsequent channels will have the 
base file name plus a version number. (v. 2, v. 3, v. 4). Note that the image version 
number does not necessarily correspond to the channel number. For example, if you 
scanned an image using only Channels 1 and 4, the image created using Channel 4 
will be saved as version 2 (v. 2).

H.2.b Selecting an Application

To select an application (i.e., the appropriate filter and other parameters for the type 
of object you are imaging), click on the Select button under a channel tab.

Select the checkbox
to enable the channel 

Click on the Select
button to select the
application 

Click on the tab to 
select the channel 
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Fig. H-4. Example of an application tree: Ethidium Bromide gel.

Standard Applications

The standard applications and associated settings are listed in a tree that expands from 
left to right. When you select a standard application, the software automatically 
selects the appropriate filter(s) and laser in the PharosFX for that particular 
application. 

Standard PharosFX Applications

Category Application

Radioisotopes
Fuji-Screen1

K-Screen (Kodak)1

Chemifluorescence
Attophos
ECL-Plus

Nucleic acid Stains
Ethidium Bromide

Sybr Gold
Sybr Green I & II
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1Supported in the PharosFX Plus systems only.

First, select your general application, and then select the particular stain or medium 
you are using. Finally, select the intensity of your samples.

Protein Stain

Deep Purple
Flamingo
Nile Red

Sypro Orange
Sypro Red
Sypro Ruby

Fluorophores

Alexa 488
Alexa 555
Alexa 647

CY2
CY3
CY5
FAM
FITC
HEX
R6G

TAMRA
Texas Red

Microtiter Plate

B-Gal (FDG)
DNA (Picogreen)

DNA (Sybr Green I)
GUS (FDG)

Protein (Nano Orange)
ssDNA (Oligreen)

Colorimetric

Coomassie Blue Gel/Blot
Copper Stain Gel/Blot
Silver Stain Gel/Blot

X-Ray Film (Grey Type)

Multiplex

Diamond
DIGE-CY2
DIGE-CY3
DIGE-CY5
Emerald

Sypro Ruby

Standard PharosFX Applications
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Note: Some applications require an external laser. If you choose one of these without 
having an external laser attached, you will receive a warning.

To exit the tree without selecting, press the ESC key.

Your selection and settings will be displayed below the Select button.

Sample Intensity

All PharosFX applications require that you select a sample intensity (High, Medium, 
or Low) from the application tree. This is simply a rough estimate of how much 
sample is visible in your gel or other object.

Note: If you are using the PharosFX Plus, and select Radioisotopes, you do not need to 
select a sample intensity.

If you are unsure of the level of intensity of your sample, you can always select a 
level, capture an image, then adjust the level and capture another image.

For example, if you select Low Sample Intensity and the resulting image has too 
many saturated pixels, you will receive a warning message. Simply change the setting 
to Medium Sample Intensity and rescan. If you select High Sample Intensity and the 
resulting image is too faint, select Medium or Low and rescan.

Custom Applications

If your application is not listed, or you want to use instrument settings other than the 
preset options, you can create and save your own custom application.

From the application tree, select Custom, then Create. This will open a dialog box in 
which you can name your application and select your settings.
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Fig. H-5. Creating a custom application.

To select a filter (including user-defined) or filter combination, click on the buttons 
for Filters A and B, and make your choice from each pop-up list.

Click on the PMT Voltage button to select a standard voltage for your custom 
application or create a custom PMT voltage.

To select a custom voltage, click on the Custom option. In the dialog box, adjust the 
slider to select a PMT voltage as a percentage of the maximum.
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Fig. H-6. Selecting a custom PMT voltage.

Note: For voltages above 80% of maximum, you will receive a warning message that 
the high voltage could damage the PMT. 

If you select Choose Later from the list of PMT voltages, the choices of sample 
intensity will be displayed when you select your custom application.

Finally, enter a name for your application in the Name field and click on OK to 
implement your changes.

After you have created an application, you can select it from the application tree by 
selecting Custom and the name you created. You can delete the application by 
selecting Custom, Delete, and the name of the application.
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Fig. H-7. Selecting a custom application.

You can edit a custom application by selecting Custom, Edit, and the name of 
the application. You can also use this feature to create a new custom 
application from an existing one.

Fig. H-8. Application selection and settings.

Once you select an application, the application name and settings appear 
below the Select button.
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H.3 Step II. Select Scan Area
To select a scan area, drag your mouse within the scanning window. (In the scanning 
window, your cursor appearance will change to a cross.) The border of the scan area 
you are selecting is marked by a frame.

Fig. H-9. Selecting a scan area.

If you are in quadrant mode, note that the frame “locks” onto the next quadrant as you 
drag. When you release the mouse button, the border changes to a dashed blue line, 
indicating a selected area.

• To reposition the scanning box you have selected, position your cursor inside the 
box and drag. The entire box will move.

• To resize the box, position your cursor on a box side and drag. The side you have 
selected will move.

• To redo the box entirely, position your cursor outside the box and drag. The old 
box will disappear and a new box will be created.

You can also select the scanning area by entering coordinates in the appropriate fields 
(Top, Bottom, Left, Right). 

Drag cursor to
define scan

area
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Fig.8-10. Select scan area

After you enter a coordinate, the position of the scanning area box will change 
accordingly.

When selecting, be sure to include the entire area of interest, and be generous with 
borders. You can always crop the image later.

H.4 Step III. Select Resolution
The PharosFX acquisition window allows you to scan at 50, 100, 200, or 800 
micrometers. These resolutions are listed as option buttons in the control panel.

Fig. H-11. Resolution option buttons.

The resolution you select should be based on the size of the objects (e.g., bands, 
spots) you are interested in. For example:

• 50 micrometer resolution should be reserved for images requiring the highest 
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level of detail, e.g., high density in situ samples, 1,536-well microplates, high 
density arrays, samples with very closely spaced features, such as bands on a 1D 
gel. Files scanned at 50 micrometers can be very large ( > 100 MB). 

• 100 micrometer resolution is useful for typical gels and arrays.

• 200 micrometer resolution is useful for gels with large bands and dot blots.

• 800 micrometer resolution should be reserved for very large objects, such as 
CAT assays.

File Size of Images

Image File Size (below Select Resolution) shows the size of the scan file you are 
about to create. If you do not have enough computer memory for the specified file 
size, an error message will appear when you attempt to scan. If this happens, select a 
lower resolution or decrease the size of the area to be scanned.

H.5 Acquire the Image
Once you have selected your application, scan area, and resolution, you are ready to 
acquire an image.

Click on the Acquire button. There may be a short delay while the image laser warms 
up; then the scanned image will begin to appear in the scanning window, line by line.

To interrupt a scan, click on the Stop button. A message will ask you to confirm the 
interrupt, and then you will be asked if you want to keep the partial scan. This feature 
is useful if you overestimated the size of the area you selected.

Note: If Warn on Saturated Pixels is checked, and the image you are scanning has more 
than 10 saturated pixels, you will receive a warning message. If this happens, you 
can go back and select a higher sample intensity in the application tree.

Saving the Image

After the scan is complete, a message will appear asking you if you want to keep the 
scan. If you select Yes, a separate window will pop up containing the new image.
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You can then save and analyze the image using the standard menu and toolbar 
functions.

H.6 Options

Auto Save After Scan

To automatically save any scan you create, click on the Auto Save After Scan 
checkbox.

With this checkbox selected, when you click on Acquire, a Save As dialog box will 
open asking you to specify a file name and location for the image you are about to 
create. The scan will begin when you click on the Save button.

If you are scanning using multiple channels, the image created using Channel 1 will 
be saved using the base file name, and images created using subsequent channels will 
have the base file name plus a version number. (v. 2, v. 3, v. 4). Note that the image 
version number does not necessarily correspond to the channel number. For example, 
if you scanned an image using only Channels 1 and 4, the image created using 
Channel 4 will still be saved as version 2 (v. 2).

Make Backup Copy

You can automatically create a backup copy of any scan you create. To do so, first 
select Auto Save After Scan (see above), then select the Make Backup Copy 
checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in 
the same directory as the scanned image. Backup images are identified by "Backup 
of" followed by the original image file name. 

Note: Backup files are read only files. If you attempt to save a backup file, you will be 
prompted to give it a new name. This protects the backup file and preserves it 
from any changes.
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Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in 
red in the scan window and in the pop-up image window. To view/hide saturated 
pixels in the pop-up image window, use the Image > Transform command.

Hide Grid

To hide the gridlines in the scanning area window, click on the Hide Grid checkbox.

Warn on Saturated Pixels

The Warn on Saturated Pixels option is checked by default. Uncheck this box to 
disable this warning.

Filters

The PharosFX family of imagers allows you to reposition filters. Click Filters to open 
the PharosFX Filter Placement dialog box. 

Fig.8-12. PharosFX Filter Placement
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Use the drop down boxes to change the filters in each position in Filter wheel A and 
Filter Wheel B. Note that Position 1 in Filter wheel A and Positions 1 and 4 in Filter 
wheel B cannot be changed.

To create a custom filter, click Custom in the filter type list. Enter a name for the 
filter, then click OK. The name of the custom filter will appear in the chosen filter 
position.

Fig.8-13. Creating a custom filter.

When you have finished selecting the filters, click OK. Any applications that cannot 
use the new filter configuration will be unavailable in Step I - Select Application. If 
any selected applications are no longer usable, the channel reverts to the default 
application selection.

Note: Depending on the filter types you select, some, or all, existing custom 
applications may become unavailable.
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VersaDoc

Fig.I-1. VersaDoc.

Before you can acquire images using the VersaDoc or VersaDoc MP Imaging System, 
you need to install the Roper Scientific interface adapter and its associated device 
drivers in your  computer. The driver installation procedures for Windows operating 
systems inlcude pre-installation and use of the Windows Hardware Wizards. 

Note: Important! Please read and follow the driver installation procedures contained in 
the README documents before you install the VersaDoc camera interface 
adapter.  You can find the README documents in the VersaDoc Drivers folders 
on The Discovery Series (TDS) CD. 
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The CD also contains Roper Scientific camera interface driver installation 
instructions for Macintosh computers. 

 See the VersaDoc hardware manual for further installation, startup, and operating 
instructions for the VersaDoc Imaging System.

The VersaDoc Imaging System contains white and UV flourescent bulbs, whereas the 
VersaDoc MP contains blue and white LEDs and optional red and green LEDs.  

I.1 VersaDoc Acquisition Window
To acquire images using the VersaDoc,  go to the File menu and select VersaDoc.... 
The acquisition window for the instrument will open, The acquisition window opens, 
displaying a control panel and an image display window.

Fig.I-2. VersaDoc acquisition window.

When the VersaDoc window first opens, no image will be displayed.
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The control panel has been arranged from top to bottom to guide you through the 
acquisition procedure. There are four basic steps to acquiring an image using the 
VersaDoc:

1. Select the application.

2. Position and focus the object to be imaged.

3. Set the exposure time.

4. Acquire the image.

I.2 Step I. Select Application
In Step 1, you select the appropriate filters and other imaging parameters for the type 
of gel, blot, plate, or other object that you are imaging. Each set of parameters you 
select is called an application.

The VersaDoc supports multichannel sequential imaging. This allows you to 
automatically image the same object using up to four different applications (e.g., to 
detect different types of stains on the same gel).

First you select a channel, then you select the application under that channel.

I.2.a. Selecting a Channel

Note: Illumination Flat Fielding will be disabled if you use multiple channels.

The four channels are accessed using the tabs under Step 1. Channel 1 is always 
enabled—that is, the VersaDoc will always capture an image using the application 
settings selected under Channel 1 first.

To enable any of the remaining channels, click on a channel tab, then select the 
Enable Channel checkbox and select the application for that channel as described 
below.

Enabled channels have a green check mark on their tabs.

Note: If you use the Optimize Exposure feature, only the application under the selected 
channel tab will be imaged; other channels, even if enabled, will be ignored.
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You do not need to enable Channels 2–4 in sequence. For example, you can set up 
your four most common applications using the different channels, but only enable 
Channel 4 for a particular gel. Channel 1 would be scanned first, Channel 4 second.

Enabled channels are imaged sequentially. The separate scans are displayed and saved 
as separate images. The total imaging time depends on the number and type of 
enabled applications.

If you have selected Auto Save After Scan, the image created using Channel 1 will 
have the base file name, and images created using subsequent channels will have the 
base file name plus a version number. (v. 2, v. 3, v. 4). Note that the image version 
number does not necessarily correspond to the channel number. For example, if you 
captured an image using only Channels 1 and 4, the image created using Channel 4 
will be saved as version 2 (v. 2).

I.2.b. Selecting an Application

To select an application (i.e., the appropriate filter and illumination source for the type 
of object you are imaging), click on the Select button under a channel tab.

Standard Applications

The standard applications and associated settings are listed in a tree that expands from 
left to right. When you select an application, the software automatically sets the 
appropriate filter in the VersaDoc for that particular application. The VersaDoc has 
four application groups, and the VersaDoc MP has six application groups. 

First select your general application, then select the particular stain or medium you 
are using. When you select the stain or medium, the software automatically sets the 
appropriate filter (520LP, 530DF60, 610LP, clear, or none), light type (UV, white, or 
none), and light source (Trans, Epi, or neither) in the VersaDoc for that particular 
application.
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Fig.I-3. The application tree in the VersaDoc acquisition window.

Note: If you select an application that requires trans white illumination, you will need 
to place the white light conversion screen on the sample stage area.

To exit the tree without selecting, press the Esc key or click outside the dialog box.

Your selection will be displayed below the Select button.

Custom Applications

If your application is not listed, if you want to use a user-installed filter, or if you want 
to set the gain and bin settings manually, you can create and save your own custom 
applications.

From the application tree, select Custom, then Create. This will open a dialog box in 
which you can name your application and select your settings.
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Fig.I-4. Creating a new custom application.

Enter a name for your application in the Name field.

Next, click on the buttons next to the Filter, Illumination, Gain and Binning fields to 
change these settings.

Note: Note that if you select trans white illumination, you will need to place the white 
light conversion screen on the sample stage.

A higher Binning setting (2x2, 3x3) provides optimal sensitivity for low-light 
applications such as chemiluminescence. In this mode, the pixels in the camera are 
“binned” (e.g., four pixels are combined into one) to increase the amount of signal per 
pixel without increasing noise. Note that combining the pixels results in a reduction in 
the resolution of the image.

Selecting a higher Gain (4x) provides higher sensitivity without reduced resolution; 
however, noise will also increase. This is useful for faint signals (bright spots will 
saturate). Selecting a lower gain (0.5x) is useful for brighter images that tend to 
saturate. A gain setting of 1x provides the greatest dynamic range.

Click OK to implement your changes.

After you have created an application, you can select it from the application tree by 
selecting Custom and the name you created.
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You can edit a custom application by selecting Custom, Edit, and the name of the 
application. You can also use this feature to create a new custom application from an 
existing one.

You can delete a custom application by selecting Custom, Delete, and the name of the 
application.

I.3 Step II. Position/Focus
Before positioning and focusing the image, select the application that you will be 
using under Step I. 

Note that the optimal position and focus will be different for a filtered image versus 
an unfiltered one. (All standard applications except Chemiluminescence use a filter.)

Position

After you have selected your application, you are ready to center your gel or other 
object within the camera frame. To do so, click on the Position button. The VersaDoc 
will begin capturing a “live” image and updating it every second.

With the Position button selected, study the image in the acquisition window while 
you position your object in the center of the sample stage. If you have a zoom lens on 
the camera, you can adjust the magnification while you position. (See the VersaDoc 
User Manual for details on positioning.)

While you are positioning, you can select the Show Alignment Grid checkbox to 
display a target grid overlay on the image.

When you click on Position, the light inside the camera box automatically switches 
on. To turn the light off while positioning, deselect the Light On checkbox.

When you are finished positioning, click on the Stop button.

Focus

Note: Before focusing, you should adjust the f-stop on the camera to the lowest setting 
(i.e., the maximum aperture). This reduces the depth of field, allowing you to 
more accurately focus the camera. Then, after focusing, increase the f-stop to the 
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desired setting. See Table 1, “Recommended Exposure Times and Lenses,” on 
page 9.

After you have positioned your sample, click on the Focus button and look at the 
image in the acquisition window while adjusting the focus on the camera lens. While 
focusing, the camera will limit its focus to a small portion of the sample (this will not 
affect any zoom lens adjustments you may have made.) (See the VersaDoc User 
Manual for details on focusing.)

When you click on Focus, the light inside the camera box automatically switches on. 
To turn the light off while positioning, deselect the Light On checkbox.

When you are finished focusing, click on the Stop button.

I.4 Step III. Set Exposure Time
The “exposure time” is the period of time an image is integrated on the CCD. The 
effect is analogous to exposing photographic film to light.

Setting an Exposure Time

Different applications have different optimal exposure times. If you are imaging using 
multiple channels, you can select a different exposure time for each channel. First 
select the channel using the tabs, then select the appropriate exposure time for that 
channel.

See Table 1, “Recommended Exposure Times and Lenses,” on page 9.

You can enter an exposure time (in seconds) directly in the field, or use the Arrow 
buttons to adjust the exposure time in 10 percent increments.

Fig.I-5. Selecting an exposure time.
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The following table provides recommended exposure times for various applications

Table 1: Recommended Exposure Times and Lenses

Sample
Recommended 

Exposure Lens & Filter Accessories Used

Fluorescent Stain Gel 3–30 sec. Zoom/IR None

Fluorescence End-
Label Gel

30 sec.–5 min. Zoom/IR None

Fluorescent Blot 0.5–5 sec. Zoom/IR Sample/Chemi 
Tray (if sample is 
small)

Chemifluorescent 
Blot 

0.5–5 sec. Zoom/IR None

Colorimetric Gel 0.1–1 sec. Zoom/IR White light con-
version screen

Colorimetric Blot 0.1–1 sec. Zoom/IR Sample/Chemi 
Tray (if sample is 
small)

X-ray film 0.1–1 sec. Zoom/IR White light con-
version screen

Weak 

Chemiluminescence1
5–10 min. 50 mm Sample/Chemi 

Tray 
(if sample is 
small)

Strong 

Chemiluminescence1
10 sec.–2 min. 50 mm Sample/Chemi 

Tray 
(if sample is 
small)

1For chemi applications, the 50mm lens is recommended. Always remove the 660 fil-
ter.
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Note: For most applications, you can select an exposure time, capture an image, study 
it, and then adjust the exposure time accordingly. Repeat this procedure as many 
times as necessary to obtain a good image. For chemiluminescent samples, which 
degrade over time and emit low levels of light, select a high exposure time 
initially or use the Optimize Exposure command described on page 12.

Preview

For shorter exposures, you can use Preview to test different exposure times. Click on 
the Preview button to create a preview exposure and display it in the acquisition 
window.

Note: The camera on the VersaDoc must be at the correct operating temperature before 
capturing images. The temperature adjustment can take several minutes after the 
camera is turned on, depending on your VersaDoc model and the ambient room 
temperature. See your hardware manual for details.

A preview scan takes only half as long to create as a real scan, because the preview 
scan does not capture a “dark” image. The progress of the exposure will be displayed 
in the Exposure Status bar at the bottom of the dialog box.

You cannot save preview scans.

If you want to stop a preview scan that is in progress, click on the Stop button.

I.5 Acquire the Image
You can acquire a single exposure for each channel based on the time selected in Step 
III (Set Exposure Time), or take a series of exposures for a particular channel over a 
specified interval (Optimize Exposure).

Illumination Flat Fielding

For applications using the UV or white light transillumination, you should use the 
appropriate reference plate to ensure a uniform intensity in the image. This will 
compensate for normal variations in image pixel intensity that occur with a 
transilluminating light source.
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To enable this feature, select the Flat Fielding checkbox.

Note: Flat fielding is only available in single channel, single exposure mode. If you are 
using multiple channels, or take multiple exposures using the Optimize Exposure 
feature described below, Flat Fielding will be disabled.

UV Illumination Flat Fielding: When you first select the Flat fielding checkbox, and 
then acquire an image using the UV transilluminator, you will be prompted to remove 
your sample and place the fluorescent reference plate on the VersaDoc sample stage 
(see the VersaDoc User Manual). A reference image of the plate will be acquired and 
saved on your computer hard drive. The reference image will be applied to the sample 
image to generate a Flat Field corrected image.

White Illumination Flat Fielding: When you first select the checkbox, and then 
acquire an image using the white light conversion screen, you will be prompted to 
remove your sample and collect an exposure of the conversion screen. A reference 
image of the screen will be acquired and saved on your computer hard drive. The 
reference image will be applied to the sample image to generate a Flat Field corrected 
image.

For subsequent UV or white light trans exposures, you will be prompted to either use 
the appropriate saved Flat Fielding image or acquire a new one. Any changes in light 
source, filter, or lens setting will require the acquisition of a new Flat Fielding 
reference image.

Acquire

Click on the Acquire button to capture a single image for each enabled channel. An 
exposure will be taken for each enabled channel based on the time selected for that 
channel in Step III.

The progress of each exposure will be displayed in the Exposure Status bar at the 
bottom of the acquisition window.
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Fig.I-6. Exposure Status bar when acquiring an image.

Depending on which dark subtraction type you have selected under Options (see 
section I.6, Options), a dark image may be acquired immediately following image 
acquisition.

If you want to stop an acquisition that is in progress, click on the Stop button. The 
current acquisition will be terminated. If multiple channels are selected, you must 
click on the Stop button once per channel to stop all acquisitions.

After an image has been acquired, a separate window will pop up containing the new 
image. You can then analyze the image using the analysis functions.

Optimize Exposure

Optimize Exposure allows you to specify an interval over which a series of 
progressively longer exposures are taken. All exposures are then displayed on the 
screen, and you can choose the one that provides the best image.

Note: Multiple exposures will be taken for only the selected multichannel tab. Other 
channels, even if enabled, will not be used. Illumination Flat Fielding will be 
disabled if you are using Optimize Exposure.

Click on the Optimize Exposure button. A settings dialog box will open in which you 
can specify the total exposure time, starting exposure time, and number of exposures. 
(The specified number of exposures will be taken at regular intervals between the 
starting exposure time and the total exposure time.)
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Fig.I-7. Optimize Exposure dialog.

Note: You should specify no more than 10 exposures in the Optimize Exposure dialog, 
to avoid excessive build up of image background in later exposures. The fewer 
the exposures, the less background will be added to the image. See the Release 
Notes for additional instructions on reducing background in images captured 
using Optimize Exposure.

Select the Save Images checkbox if you want to automatically save each exposure as 
it is taken. 

Click on OK in the settings dialog to begin taking exposures. If you selected Save 
Images, a Save dialog box will open in which you can specify the base file name and 
location of the exposure files. When you click on Save, the exposures will be taken.

The specified number of exposures will be taken at equal intervals between the 
starting exposure time and total exposure time. The exposure status bar will show the 
progress of each exposure.

Depending on which dark subtraction type you have selected under Options, a dark 
image may be acquired immediately following each exposure.

When each exposure is complete, an image window containing that exposure will 
open in front of the VersaDoc window. Subsequent exposures are tiled in front of the 
VersaDoc window.

Note that the first exposure will have the base file name; the default base file name is 
the computer user name and a time stamp. Each subsequent exposure will have a 
version number (v2, v3, v4, etc.) appended to the base file name. (If you are using the 
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default base file name, the time stamp may change in the course of the series of 
exposures; in this case, the base file name will change and the version numbering will 
reset for subsequent exposures.)

The highest version number will be the final exposure. If you did not elect to auto-
save the exposures as they were created, then each image will be unsaved.

To stop the image acquisitions, click on the Stop button.

Note: Exposures captured before stopping will be displayed in image windows. 

Study the different images and select the best exposure(s) to keep.

I.6 Options
Click on the Options button to open the Options dialog box.

Fig.I-8. Options dialog box.

I.6.a. Dark Subtraction Type

All CCD cameras accumulate electrons that produce a signal that is indistinguishable 
from light. This “dark current” adds to the noise in your images, particularly for long 
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exposures. In most cases, you will want to subtract this dark current from your 
images.

The settings for subtracting the dark current are in the Options dialog box. Click on 
the Options button in the acquisition window to open this dialog.

Normal

The Normal option button selects the default dark subtraction type. In this mode, after 
you acquire an image, a “dark” image of the same exposure length will be taken, and 
this will be subtracted from your image.

The progress of the dark exposure will be displayed in the Exposure Status bar 
following the regular image exposure.

In Normal mode, a dark image is only acquired the first time you perform a scan with 
particular application and exposure settings. If you perform subsequent scans with the 
same settings, no dark exposure will be taken.

Reference

If you do not want to perform a dark exposure with each acquisition, you can take a 
“reference” dark exposure that will be saved and subtracted from all subsequent 
acquisitions. Click on the Referenced button to activate this feature.

The first time you acquire an image after selecting this option, the VersaDoc will take 
a dark exposure that will be saved and used to subtract the dark current from all 
subsequent acquisitions.

Note: The VersaDoc 1000 will take a 60-second reference dark exposure; the VersaDoc 
3000 and 5000 will take a 180-second reference dark exposure.

For image exposures that are longer or shorter than the reference dark, the reference 
dark will be scaled accordingly and then subtracted. It is recommended that the 
reference dark exposure time be equal to or greater than the sample exposure time. 
You can change the default reference dark exposure time using the Reset Reference 
button (see below).

If you deselect the Referenced button and then reselect it, the old reference dark 
exposure will still be available.
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Separate reference dark exposures will be taken for images that have different levels 
of binning or gain. Once you have created a reference dark for each level of binning 
or gain, the appropriate reference dark will be used according to the settings of your 
selected application.

Reset Reference

If you would like a reference dark with an exposure time that more closely matches 
that of your typical scans, click on the Reset Reference button.

A pop-up box will prompt you to enter a new dark exposure time in seconds.

Fig.I-9. Reset Reference Dark pop-up box.

Click on OK to implement your change. The new reference dark will be created when 
you acquire your next image.

Because of the high sensitivity of the CCD, fluctuations in background radiation and/
or temperature in the room can affect the level of dark count. If you feel that radiation/
temperature conditions have changed in the room since your last reference dark was 
created, use the Reset Reference button to delete your old reference and create a new 
one under current conditions.

None

If you do not want to perform dark subtraction, select None. No dark exposure will be 
acquired or subtracted.
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I.6.b. Save

Auto Save After Scan

To automatically save any image you acquire using the Acquire button, click on the 
Auto Save After Scan checkbox in the Options dialog box.

With this checkbox selected, when you click on Acquire, a Save As dialog box will 
open asking you to specify a file name and location for the image you are about to 
create. The scan will begin when you click on the Save button.

Make Backup Copy

You can automatically create a backup copy of any scan you create. To do so, first 
select Auto Save After Scan, then select the Make Backup Copy checkbox.

With this checkbox selected, when you save a scan, a backup copy will be placed in 
the same directory as the scanned image. Backup images are identified by "Backup 
of" followed by the original image file name. 

Note: Backup files are read only files. If you attempt to save a backup file, you will be 
promted to give it a new name. This protects the backup file and preserves it from 
any changes.

I.6.c. Imaging Area Size

The imaging area is the area of the sample (in centimeters) that is captured by the 
camera and displayed in the scan window. To specify the size of this area, enter a 
dimension in the appropriate field under Imaging Area in the Options dialog box. 
Click on the Options button in the acquisition window to open this dialog.

When you change one imaging area dimension, the other will change to maintain the 
aspect ratio of the camera lens.

The imaging area will change depending on your zoom factor. For example, if you 
have zoomed in on a area that is 4.5 x 3.5 cm, then you would enter 4.5 for the width 
(3.5 for the height would be calculated automatically).
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Note: Your imaging area settings must be correct if you want to do 1:1 printing. They 
must also be correct if you want to compare the quantities of objects (e.g., using 
the Volume Tools) in different images.

The imaging area dimensions also determine the size of the pixels in your image (i.e., 
resolution). A smaller imaging area will result in a higher resolution.

I.6.d. Auto-scale Transform

Auto-scale Transform after Acquisition allows the user the option of having the image 
automatically perform the Auto-Scale transform function upon completion of image 
acquisition. This eliminates the need to transform an image or re-scan an image when 
the acquisition time was too short or the iris not opened enough.

To enable the auto-scale transform function, check the box labeled, Auto-Scale 
Transform after Acquisition in the Options dialog.

I.7 Other Features

Fig.I-10. Other VersaDoc acquisition window features.

Highlight Saturated Pixels

When this box is checked, any saturated pixels in the image will appear highlighted in 
red in the scan window and in the pop-up image window. To view/hide saturated 
pixels in the pop-up image window, use the Transform command.
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File Size of Images

Image File Size shows the size of the image file you are about to create. This size is 
determined by the resolution of the camera and any binning you perform when 
capturing the image.

If you do not have enough computer memory for the specified file size, an error 
message will appear when you attempt to acquire an image.

Macintosh users can increase the application memory partition. See your Macintosh 
computer documentation for guidance.
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Other Features

The following features are available in Quantity One, but have more utility in its more 
powerful companion application, Diversity Database. You can examine your gel 
images in Quantity One and then database them using Diversity Database.

J.1 Categories and Attributes
User-defined <category> buttons are available in the Standards dialog box, Matched 
Band Set dialog box, and Gel Layout dialog box. They allow you to categorize the 
characteristics of your particular gel or any related gel to which you might apply the 
same set of standards.

To define a new category, click on one of the <category> buttons. A dialog will pop 
up in which you can select from a list of categories or create a new one.

Fig.J-1. Category pop-up box.

To create a new category, click on the Edit button. This will open another pop-up box 
in which you can enter the name of your new category.
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Fig.J-2. Edit Category dialog box.

Type the name of the new category (e.g., “Color”) next to the Category prompt and 
list attributes of that category in the Attribute fields (e.g., “Red,” “Green,” “Blue,” 
etc.). The form will automatically sort your attributes alphabetically within the 
Attribute fields. Categories and attributes can be defined for any characteristics of 
your gel that would be useful to sort by. Typical categories might be “Enzyme,” 
“Primer,” “Probe,” “Type,” “Who,” etc.

Once you’ve created a category and attributes, you can use them in the dialog box. 
Once again, click on a <category> button.

Select the category to be applied from the available categories on the list (or select 
<none>). Click on the Attribute button to specify an attribute. Click OK to apply your 
selection to the Standards box.

J.2 Gel Layout
In Diversity Database, you can use the Gel Layout dialog box to compare samples 
across multiple gel images. In Quantity One, you can use it to enter general 
information about your image.
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To open the Gel Layout form, select Gel Layout from the Edit menu.

 

Fig.J-3. Gel Layout dialog box.

The following information about your gel can be specified at the top of the Gel 
Layout form:

• Category and attribute information (see above) for the whole gel.

• A brief description of the gel.

• Gel run date.

• Number of lanes.

• Lane width.
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• Lane-based background subtraction and disk size.

Each lane in your gel has its own line on the Gel Layout form. The following 
information can be specified for a lane.

• Band set type (standard or experimental).

• Lane number.

• Band set name.

• Sample name.

• Category/attributes information (see above) for individual lanes.

The pop-up buttons on the left side of the form offer a number of choices pertaining to 
the individual lanes on your gel. Clicking on one will open the Lane Choices list.

Lane Report will open a customizable lane report form that can be printed or 
exported.

Assign Band Set allows you to select the specific band set that is to be applied to that 
lane.

Unassign Band Set allows you to remove the band set that is currently applied to that 
lane.

View Band Set displays the band set form for the band set that is currently applied to 
that lane.
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21 CFR Part 11

K.1 Introduction
Effective August 20, 1997 the United States Food and Drug Administration (FDA) 
released Part 11 “Electronic Records; Electronic Signatures” of title 21 of the Code of 
Federal Regulations. This rule states the conditions under which the FDA considers 
electronic signatures and electronic records to be trustworthy, reliable, and equivalent 
to traditional handwritten signatures. In this manner it defines the conditions under 
which an organization must operate to meet its record keeping and record submission 
requirements when using electronic signatures and records rather than handwritten 
records and signatures.

K.1.a. CFR and The Discovery Series

The purchase of a separate license allows the use of the 21 CFR Part 11 System 
Security features of Quantity One. Quantity One utilizes these security features in 
concert with the operating system to assist the laboratory, research institution, etc. in 
becoming CFR compliant. These features include audit trail, electronic signature, and 
secure user login.

Note: Bio-Rad makes no claim that Quantity One is CFR compliant in and of itself, nor 
does it guarantee compliance for the user. The organization must establish 
policies and standard operating procedures that work in conjunction with the 
tools provided by Bio-Rad to ensure compliance with 21 CFR Part 11.

 Audit Trail

Section 11.10 (e) of 21 CFR Part 11 requires the use of “secure, computer-generated, 
time-stamped audit trails to independently record the date and time” of activities 
within the system. In System Security mode, Quantity One automatically records any 
events that affect data and analysis in the Audit Report. For instance, such things as 
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cropping and band detection are recorded in the Audit Report, while transform will 
not because it does not affect the data.

Although there are software controls to detect modification of data, protection of the 
data from deletion must happen at the level of the operating system.  As a result, data 
must be stored only on an NTFS partition. Access to directories where data is stored 
should be granted only to those who need to access that data. Ideally, access for a 
single user will prevent the possibility of two users accessing the same file. Also, a 
regular backup procedure should be in place.

Electronic Signature

Section 11.3 (b) (7) of 21 CFR Part 11 defines an electronic signature as “a computer 
data compilation of any symbol or series of symbols executed, adopted, or authorized 
by an individual to be the legally binding equivalent of the individual's handwritten 
signature.” Quantity One allows the user to “sign” images thereby locking the files 
against future changes. If a user changes a “signed” file, and attempts to save the file, 
the file automatically receives a new version number, and the signed tag is removed 
from the window title. 

Secure User Login

Section 11.3 (b)(4) defines a closed system as “an environment in which system 
access is controlled by the persons who are responsible for the content of electronic 
records that are on the system.” Quantity One utilizes the Microsoft Windows 2000 
and XP Professional security model as the secure user login. 

K.2 Using The Discovery Series in CFR 
Mode

Access Levels

Before CFR mode can be utilized, the system must be correctly configured by the 
network administrator. There are four levels of access to Quantity One in CFR Mode:
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Guest - A user with guest access has the ability to open and view files, but a guest 
cannot change data, nor can a guest save a file.

Tech - The tech level user has the ability to acquire images, transform images, crop, 
flip, rotate, use the text and line tools, perform basic analysis, print, and export. The 
tech level user also has the ability to save and sign files. 

User - At this level, all functions are available to the user. However, the user cannot 
change the CFR settings.

Administrator - The administrator level has all the capabilities of the full user as well 
as the ability to make changes to the CFR settings.

CFR Image Files

For files to be opened in CFR mode, the files must have been created on a CFR 
system, either through acquisition or importing a TIFF file. Any files created on a 
non-CFR system cannot be opened. To open a file created on a non-CFR system, open 
the file on a non-CFR system and export it to TIFF. You can then import it in CFR 
mode. To ensure accuracy, remember to select the analysis option as your export 
mode when you export your non-CFR images.

Note: Due to operating system limitations, it is possible to have image files open in two 
or more locations over a network simultaneously. To safeguard your image files 
keep them in a protected folder or on your local machine.

K.2.a Setting Security Preferences

Setting the Security preferences for CFR mode requires the user have administrator 
privileges. To locate the Security Preferences, select Preferences from the Edit menu 
and click the Security tab. 
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Fig. K-1. Security Preferences

The following options are available on the Security tab of the Preferences dialog box:

Enable 21 CFR Part 11 mode - If this box is unchecked, all other options are inactive. 
To activate the other options and CFR mode check this box.

Program times out if inactive - When this box is checked, you must enter your 
password to resume using Quantity One. The minutes field indicates the amount of 
time that must elapse before the application times out. 

Require login on startup - If this box is checked, you must enter your password when 
when Quantity One starts. This password is the same password as the one used for 
logging on to Windows. This is an added security measure to prevent unauthorized 
users from starting Quantity One on a machine where they are not logged in.

Automatically create backup for new images - This option, when selected, creates a 
backup file when you save a newly acquired or imported image. Locate the backup 
file in the same folder as the original. The backup file is identified by “backup of” 
preceding the filename of the original.

Enable Secure Mode - This option is not associated with CFR. For further 
information on Secure Mode, See Section 2.5, Preferences.
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K.2.b Secure User Login

Quantity One utilizes the Windows security model.  When you open Quantity One, 
Quantity One determines the user name by the ID of the user currently logged on to 
that system. If you have Require Login on startup checked on the Security tab of the 
Preferences dialog box, then you must enter your Windows password to start Quantity 
One.

To view the current user information, select Show User Information from the CFR 
menu. The message displays the username, full name, and group membership for the 
currently logged in user.

Note: Although Windows XP allows you to switch users without logging off, you must 
first close Quantity One before switching users. Windows 2000 does not allow 
the ability to switch users.

K.2.c Audit Report

The Audit Report included with CFR mode tracks all changes to actual data of images 
as well as any events associated with analysis. 
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Fig. K-2. Audit Report

Each entry in the Audit report contains the date and time of the event as well as the 
name of the user who performed the event. The Audit Report also contains a 
description of the event with details, the file name, and the version of Quantity One 
used when the event occurred. The comment column allows you to enter comments 
about particular events. To enter a comment, click the cell under the comments 
heading for the event to which you want to add the comment. This opens the 
comment editor dialog box. Enter your comment and click Done.
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Fig. K-3. Comment Editor

Audit Report Options

The Audit Report Options dialog box allows you to customize the Audit Report view. 
Click the Options button to open the Audit Report Options Dialog box.
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Fig. K-4. Audit Report Options

The left hand column of the Audit Report dialog box lists the category filters. If a box 
is checked, all events of that type display in the Audit Report. To hide a category in 
the report viewer, clear the check box next to the corresponding category.

The right hand column lists the columns the report viewer displays. To hide a column, 
clear the check box next to the corresponding column name.

Note: These options only affect what is displayed in the report viewer, not what is 
recorded. As previously stated, all changes to image data and events associated 
with analysis are recorded. 

If the Expand Details in Display option is checked, then the all details for each event 
are displayed in the viewer. Otherwise, only the first row of each event is displayed. 
Similarly, the Expand comments in Display functions the same way. 

The AutoZoom on Detail Image Coordinates option is a convenient way to pinpoint 
the location an event took place in the image. If the box is checked, click the 
coordinates in the report viewer and the image will automatically zoom to the location 
of the event. Note that this tool is only available when a specific location has been 
recorded in the report.
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Printing and Exporting the Audit Report

The Audit Report Viewer allows you to print or export the report for use in a 
spreadsheet application. 

To print the report, click either the Print Current Page button or the Print button. Print 
Current Page is only available in print preview mode and allows you to print the 
currently viewed page. The print all pages button opens the Pint dialog box where you 
can either print all pages or specify a print range. Click Page Setup to change the print 
settings. 

To export the report click the Export button. This opens the Export Options dialog 
box where you can determine the delimiter (tab or comma) and the export destination 
(save as a file or copy to the clipboard).

K.2.d Electronic Signature

As was previously stated, Section 11.3 (b) (7) of 21 CFR Part 11 defines an electronic 
signature as “a computer data compilation of any symbol or series of symbols 
executed, adopted, or authorized by an individual to be the legally binding equivalent 
of the individual's handwritten signature.” Quantity One allows the user to “sign” an 
image thereby locking the file against future changes. If a user changes a “signed” 
file, and attempts to save the file, the file automatically receives a new version 
number, and the signed tag is removed from the window title. 

To “sign” a file in Quantity One, with the file open select Sign from the CFR menu. A 
modified version of the Comments dialog box opens. Enter any comments you may 
have, and click Sign. This opens the Login User dialog box, which requires you to 
enter your user name and password for signature validation.
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Fig. K-5. Electronic Signature dialog box

Once you have “signed” your file, the image window title bar indicates the file has 
been signed, and the event is recorded in the Audit report.

Fig. K-6. A signed Image

If your policies require signature verification by more than one person, such as a lead 
researcher, a signed file can be signed again without changing the file version 
provided the file has not been modified between signatures. 
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The Discovery Series™ Software 
Software License Agreement

READ THIS!  THIS IS A LEGAL AGREEMENT BETWEEN YOU, THE CUSTOMER, 
AND BIO-RAD LABORATORIES, INC. ("BIO-RAD") CONCERNING THE ENCLOSED 
COMPUTER PROGRAM ("THE PROGRAM"). YOU SHOULD REVIEW THE 
FOLLOWING TERMS AND CONDITIONS OF THIS AGREEMENT CAREFULLY 
BEFORE OPENING THIS PACKAGE.  BY OPENING THIS PACKAGE YOU INDICATE 
YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS.  IF YOU DO NOT AGREE 
WITH ANY OF THEM, YOU SHOULD PROMPTLY RETURN THE PACKAGE 
UNOPENED, YOUR MONEY WILL BE REFUNDED.

LICENSE

Pursuant to the license granted to you by this Agreement, you may (a) use the Program on a 
single computer; (b) copy the Program into any computer readable or printed form for back-up 
or modification purposes in support of your use of the Program on the single computer (certain 
programs, however, may include mechanisms to limit or inhibit copying; they are marked 
"copy protected"); (c) modify the Program and/or merge it into another program for your use on 
the single computer, and (d) transfer the Program and license to another party if the other party 
agrees to accept the terms and conditions of this Agreement.

Any portion of the Program merged into another program shall continue to be subject to the 
terms and conditions of this Agreement.  If you must transfer the Program, you must at the 
same time either transfer all copies whether in printed or computer readable form to the same 
part or destroy any copies not transferred, including without limitations all modifications and 
portions of the Program contained or merged into other programs.  You must also reproduce 
and include the copyright notice on any copy, modification or portion merged into another 
program.

YOU MAY NOT USE, COPY, MODIFY OR TRANSFER THE PROGRAM OR ANY COPY, 
MODIFICATION, OR MERGED PORTION, IN WHOLE OR IN PART, EXCEPT AS 
EXPRESSLY PROVIDED FOR IN THIS AGREEMENT.  If you transfer possession or any 
copy modification, or merged portion of the Program to another party, your license is 
automatically terminated.

TERM

The license is effective until terminated.  You may terminate it at any other time by destroying 
the Program together with all copies, modifications and merged portions in any form.  It shall 
also terminate upon conditions set forth elsewhere in this Agreement or if you fail to comply 
with any term or condition of this Agreement.  Upon such termination, you must destroy the 
Program together with all copies, modifications, and merged portions in any form.



LIMITED WARRANTY AND REMEDIES

BIO-RAD warrants the media on which the Program is furnished to be free from defects in 
materials and workmanship under normal use for a period of ninety (90) days from the date of 
delivery to you as evidenced by a copy of your receipt.  This warranty is limited to you and is 
not transferable.

During the 90 day warranty period, BIO-RAD shall (a) replace any media item not meeting the 
foregoing warranty and which is returned to BIO-RAD or an authorized BIO-RAD dealer 
("Authorized Dealer") with a copy of your receipt; or (b) if BIO-RAD of the Authorized Dealer 
is unable to deliver a replacement media item which is free of defects in materials or 
workmanship, you may terminate this Agreement by returning the Program, and you money 
shall be refunded.

The following warranty does not extent to any media item which has been damaged as a result 
of accident, misuse, abuse, or as a result of service or modification by anyone other than BIO-
RAD or an Authorized Dealer.

EXCEPT AS EXPRESSLY SET FORTH ABOVE, THE PROGRAM IS PROVIDED "AS IS" 
AND NO OTHER WARRANTIES EITHER EXPRESSED OR IMPLIED, ARE MADE WITH 
RESPECT TO THIS PROGRAM, INCLUDING, WITHOUT LIMITATION THE IMPLIED 
WARRANTIES OF MECHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
BIO-RAD WITHOUT LIMITATIONS EXPRESSLY DISCLAIMS ALL WARRANTIES NOT 
STATED HEREIN. YOU ASSUME THE ENTIRE RISK AS TO THE QUALITY AND 
PERFORMANCE OF THE PROGRAM SHOULD THE PROGRAM PROVE DEFECTIVE. 
YOU AND NOT BIO-RAD OR AN AUTHORIZED DEALER ASSUME THE ENTIRE 
COST OF NECESSARY SERVICING REPAIR OR CORRECTION.  SOME STATES DO 
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE 
EXCLUSION MAY NOT APPLY TO YOU.  THIS WARRANTY GIVES YOU SPECIFIC 
LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY FROM 
STATE TO STATE.

BIO-RAD DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE 
PROGRAM WILL MEET YOUR REQUIREMENTS OR THAT THE OPERATION OF THE 
PROGRAM WILL BE UNINTERRUPTED OR ERROR-FREE.  YOU ASSUME 
RESPONSIBILITY FOR THE SELECTION OF THE PROGRAM TO ACHIEVE YOUR 
INTENDED RESULTS, AND FOR THE INSTALLATION, USE AND RESULTS 
OBTAINED FROM THE PROGRAM.

YOUR SOLE REMEDIES AND BIO-RAD'S ENTIRE LIABILITY ARE SET FORTH 
ABOVE, IN NO EVENT WILL BIO-RAD BE LIABLE TO YOU OR ANY OTHER 
PERSON FOR ANY DAMAGES, INCLUDING WITHOUT LIMITATION ANY 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, EXPENSES, LOST PROFITS, LOST 
SAVINGS OR OTHER DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE 



SUCH PROGRAM EVEN IF BIO-RAD OR AN AUTHORIZED DEALER HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY 
OTHER PARTY.

SOME STATES DO NOT ALLOW THE LIMITATION OR EXCLUSION OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES FOR CONSUMER PRODUCTS, SO THE ABOVE 
LIMITATIONS OR EXCLUSIONS MAY NOT APPLY TO YOU.

GENERAL

You may not sublicense, assign, or transfer the license or the Program except as expressly 
provided in this Agreement.  Any attempt to otherwise sublicense, assign or transfer any of the 
rights, duties or obligations hereunder is null and void and not merely voidable.

If you have any questions concerning this Agreement, including warranty service, you should 
contact BIO-RAD LABORATORIES, INC., 1000 Alfred Nobel Drive, Hercules, CA 94547.

This Agreement shall be governed by the laws of the state of California as applicable to 
contracts between residents of California which are entered into and performed entirely within 
California.

YOU HAVE ACKNOWLEDGED THAT YOU HAVE READ THIS AGREEMENT, 
UNDERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. 
YOU FURTHER AGREE THAT IT IS THE COMPLETE AND EXCLUSIVE  STATEMENT 
OF THE AGREEMENT BETWEEN US WHICH SUPERCEDES ANY PROPOSAL OR 
PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS 
BETWEEN US RELATING TO THE SUBJECT MATTER OF THIS AGREEMENT.
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